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Overview
Welcome to the Generative Sheetmetal Design User's Guide. This guide is intended for users who need to 
become quickly familiar with the Generative Sheetmetal Design Version 5 product. 

This overview provides the following information:

●     Generative Sheetmetal Design in a Nutshell

●     Before Reading this Guide

●     Getting the Most Out of this Guide

●     Accessing Sample Documents

●     Conventions Used in this Guide

Generative Sheetmetal Design in a Nutshell
The Generative Sheetmetal Design workbench is a new generation product offering an intuitive and flexible user 
interface. It provides an associative feature-based modeling, making it possible to design sheet metal parts in 
concurrent engineering between the unfolded or folded part representation.

Generative Sheetmetal Design offers the following main functions:

●     Associative and dedicated sheet metal feature-based modeling

●     Concurrent engineering between the unfolded or folded part representation

●     Access to company-defined standards tables

●     Dedicated drawing capability including unfolded view and specific settings.

All sheet metal specifications can be re-used by the Knowledge Advisor workbench to capture corporate 
knowledge and increase the quality of designs.

Natively integrated, Generative Sheetmetal Design offers the same ease of use and user interface consistency 
as all V5 applications.

As a scalable product, Generative Sheetmetal Design can be used in cooperation with other current or future 
companion products in CATIA V5 such as Assembly Design and Generative Drafting. The widest application 
portfolio in the industry is also accessible through interoperability with CATIA Solutions Version 4 to enable 
support of the full product development process from initial concept to product in operation.

The Generative Sheetmetal Design User's Guide has been designed to show you how to design sheet metal 
parts of varying levels of complexity.

Before Reading this Guide



Before reading this guide, you should be familiar with basic Version 5 concepts such as document windows, 
standard and view toolbars. Therefore, we recommend that you read the Infrastructure User's Guide that 
describes generic capabilities common to all Version 5 products. It also describes the general layout of V5 
and the interoperability between workbenches.

You may also like to read the following complementary product guides, for which the appropriate license is 
required: 

●     Part Design User's Guide: explains how to design precise 3D mechanical parts.

●     Assembly Design User's Guide: explains how to design assemblies.

●     Generative Drafting User's Guide: explains how to generate drawings from 3D parts and assembly 
definitions.

 

Getting the Most Out of this Guide
To get the most out of this guide, we suggest that you start reading and performing the step-by-step 
Getting Started tutorial.

Once you have finished, you should move on to the next sections, which explain how to handle more 
detailed capabilities of the product.

The Workbench Description section, which describes the Generative Sheetmetal Design workbench, and the 
Customizing section, which explains how to customize the Generative Sheetmetal Design workbench, will 
also certainly prove useful. 

 

Accessing Sample Documents
To perform the scenarios, you will be using sample documents contained in the 
online\cfysm_C2\samples\SheetMetal folder. For more information about this, refer to Accessing Sample 
Documents in the Infrastructure User's Guide.

 

 

file:///E|/www/lgkr16/Doc/online/basug_C2/basugbt0208.htm
file:///E|/www/lgkr16/Doc/online/basug_C2/basugbt0208.htm


Conventions
Certain conventions are used in CATIA, ENOVIA & DELMIA documentation to help you recognize and understand 
important concepts and specifications. 

Graphic Conventions

The three categories of graphic conventions used are as follows:

●     Graphic conventions structuring the tasks

●     Graphic conventions indicating the configuration required

●     Graphic conventions used in the table of contents

Graphic Conventions Structuring the Tasks

Graphic conventions structuring the tasks are denoted as follows:

This icon... Identifies...

estimated time to accomplish a task

a target of a task

the prerequisites

the start of the scenario

a tip

a warning

information

basic concepts

methodology

reference information

information regarding settings, customization, etc.

the end of a task



functionalities that are new or enhanced with this release

allows you to switch back to the full-window viewing mode

Graphic Conventions Indicating the Configuration Required 

Graphic conventions indicating the configuration required are denoted as follows:

This icon... Indicates functions that are... 

specific to the P1 configuration

specific to the P2 configuration

specific to the P3 configuration

Graphic Conventions Used in the Table of Contents

Graphic conventions used in the table of contents are denoted as follows:

This icon... Gives access to...

Site Map

Split View Mode

What's New?

Overview

Getting Started

Basic Tasks

User Tasks or Advanced Tasks

Interoperability

Workbench Description

Customizing

Administration Tasks

Reference



Methodology

Frequently Asked Questions

Glossary

Index

Text Conventions

The following text conventions are used:

●     The titles of CATIA, ENOVIA and DELMIA documents appear in this manner throughout the text.

●     File -> New identifies the commands to be used.

●     Enhancements are identified by a blue-colored background on the text.

How to Use the Mouse

The use of the mouse differs according to the type of action you need to perform.

Use this
mouse button... Whenever you read...

 
●     Select (menus, commands, geometry in graphics area, ...)

●     Click (icons, dialog box buttons, tabs, selection of a location in the document window, 
...)

●     Double-click

●     Shift-click

●     Ctrl-click

●     Check (check boxes)

●     Drag

●     Drag and drop (icons onto objects, objects onto objects)

●     Drag

●     Move

●     Right-click (to select contextual menu)



What's New?
Flanged hole: new parameter set 

You can now set the flat pattern diameter for all types of flanged hole definitions (Major Diameter, Minor 
Diameter, Two Diameters, Punch&Die Diameter).
You can also set all flanged hole parameters in a standard table.

 

 
 

  



Getting Started

Before getting into the detailed instructions for using Generative Sheetmetal Design , the following tutorial 
provides a step-by-step scenario demonstrating how to use key functionalities.

The main tasks proposed in this section are: 

Entering the Workbench
Defining the Sheet Metal Parameters

Creating the First Wall
Creating the Side Walls

Creating a Cutout
Creating Bends

Extracting Drawings from the Sheet Metal Part 

 

 
All together, these tasks should take about 15 minutes to complete.

 

Before discovering this tutorial, you should be familiar with the basic commands common to all 
workbenches, which are described in the Infrastructure User's Guide.



Entering the Workbench

The Generative Sheetmetal Design functions are available when you are in the Part environment. Several 
functions are integrated from the Part Design workbench.

This task shows how to enter the workbench.

 

Choose the Mechanical Design -> Generative Sheetmetal Design item from the Start menu.

The Generative Sheetmetal toolbar is displayed and ready to use.



You may add the Generative Sheetmetal Design workbench to your Favorites, using the Tools -> 
Customize item. For more information, refer to the Infrastructure User's Guide.

 If you wish to use the whole screen space for the geometry, remove the specification tree clicking off the 
View -> Specifications menu item or pressing F3.



Defining the Sheet Metal Parameters

This task shows you how to configure the Generative Sheetmetal parameters.

1.  Click the Sheet Metal Parameters icon .

The Sheet Metal Parameters dialog box is displayed. 

2.  Enter 1mm in the Thickness field.

3.  Enter 5mm in the Default Bend Radius field.

4.  Select the Bend Extremities tab.



5.  Select Tangent in the Bend Extremities combo list.

An alternative is to select the bend type in the graphical combo list.

6.  Click OK to validate the parameters and close the dialog box.

The Sheet Metal Parameters feature is added in the specification tree.

The other two tabs are not used in this scenario.

 



Creating the First Wall

This task shows how to create the first wall of the Generative Sheetmetal Part.

1.  Click the Sketcher icon  then select the xy plane.

2.  Select the Profile icon .

3.  Sketch the profile as shown below:

4.  Click the Exit workbench icon  to return to the 3D world.

The sketch remains selected.



5.  Click the Wall icon .

The Wall Definition dialog box opens.

By default, the Material Side is set to the top.

6.  Click OK.

The Wall.1 feature is added in the specification tree

The first wall of the Generative Sheetmetal Part is known as the reference wall.



Creating the Side Walls

This task shows you how to add other walls to the sheet metal part.

1.  Click the Wall on Edge icon .

The Wall On Edge Definition dialog box opens.

2.  Select the left edge.

3.  Enter 50mm in the Value field.

The application previews the wall.

By default, the material side is such that it ensures a continuity with the reference profile. If needed, 

invert it using the Invert Material Side button, or clicking the arrow.



4.  Click the Reverse Position button to Invert the sketch profile.

5.  Click OK.

The wall is created and the Wall On Edge.1 feature is displayed in the specification tree:

6.  Select the right edge.

7.  Click the Wall on Edge icon  again.

The Wall On Edge Definition dialog box opens with the parameters previously selected.

8.   Invert the sketch profile and click OK to validate.

9.  Click the Wall on Edge icon  again.

The Wall Definition dialog box opens with the 

parameters previously selected.

10.  Select the front edge.

11.  Enter 30mm in the Value field and 10mm in the 

First Limit and Second Limit tabs, then invert 

the sketch profile.

12.  Press OK to validate.



The final part looks like this: 



Creating a Cutout

In this task, you will learn how to: 
●     open a sketch on an existing face

●     define a profile in order to create a cutout.

1.  Select Wall On Edge.2 from the 

geometry area to define the 

working plane.

2.  Click the Sketcher icon .

3.  Click the Elongated Hole icon  to create the profile.

To access the oblong profile, click 

the black triangle on the 

Rectangle icon.

It displays a secondary toolbar.

4.  Click to create the first point and 

drag the cursor.

5.  Click to create the second point.

The first semi-axis of the profile is 

created.

6.  Drag the cursor and click to create 

the third point.

The second semi-axis is created 



and the oblong profile is displayed.

7.  Click the Exit workbench icon  to return to the 3D world.

8.  Select the Cutout icon .

The Cutout Definition dialog 
box is displayed and a cutout is 
previewed with default 
parameters. 

9.  Set the Type to Up to last option to define the limit of your cutout.

This means that the application will limit the cutout onto the last possible face, that is the 
opposite wall.

10.  Click OK.

This is your cutout:



Creating Bends

In this task, you will learn how to create bends between walls.

 
1.  Select the Bend icon . The Bend Definition dialog box is displayed.

 

 
2.  Select Wall.1 as Support 1 and Wall.2 as Support 2 in the specification tree or in the geometry area. 

 

 

 

3.  Click OK. The bend is created.

4.  Repeat steps 1 to 3, this time selecting Wall.1 as Support 1 and Wall.3 as Support 2. The second bend is created.



The bend features are displayed in the specification tree: 
Cylindrical Bend.1 and Cylindrical Bend.2.

 

The sheet metal part looks like this:

 



Extracting Drawings
from the Generative Sheet Metal Part

This task shows how to create the Generative Sheetmetal part views in the Generative Drafting 

workbench.

The Generative Sheetmetal part is displayed.

1.  Click  or select File -> New...

2.  Select the Drawing type and click OK.

The Generative Drafting  workbench is launched. The New Drawing dialog box opens.

3.  Click OK.

For more information about this workbench, refer to Generative Drafting User's Guide. 



4.  The drawing sheet appears.

5.  Tile the windows horizontally using the Window -> Tile Horizontally menu item.

6.  Select the Unfolded View icon  in the Projections toolbar from Generative Drafting Workbench.

This icon is added to the Projections toolbar provided the Generative Sheetmetal workbench is present.

7.  Choose the xy plane in the Generative Sheetmetal specification tree. The unfolded view is 

previewed. 

8.  Click in the drawing to validate and generate the view, with the bend axes and bend limits (when 

applicable).



 

 



User Tasks
The tasks you can perform in the Generative Sheetmetal Design workbench are described in the following 
chapters and tasks.

Managing the Default Parameters
Recognizing Walls From an Existing Part

Creating Walls
Creating Bends on Walls

Creating Extrusions
Creating Swept Walls
Aggregating Bodies
Creating a Hopper

Unfolding
Checking Overlapping

Creating a Hole
Creating a Circular Cutout

Creating a Cutout
Stamping
Patterning
Mirroring

Creating a Local Corner Relief
Creating Corners

Creating Chamfers
Mapping Elements

Interoperability with Wireframe
Interoperability with Knowledge Expert

Integration With Part Design
Integration With Weld Design

Integration with Generative Drafting
Designing in Context

Managing PowerCopies
Browsing the Sheet Metal Catalog
Looking For Sheet Metal Features

Saving As DXF



Managing the Default Parameters

This section explains and illustrates how to use or modify various kinds of features.

Using Generative Sheetmetal Design assumes that you are in a CATPart document.

Edit the parameters: select the Parameters tab, the wall thickness and bend radius values.

Modify the bend extremities : select the Bend Extremities tab and choose a predefined bend type. 

Define the bend allowance: select the Bend Allowance tab and define the allowance value (K factor).

 



Editing the Sheet and Tool Parameters

This section explains how to change the different sheet metal parameters needed to create your first feature.

1.  Click the Sheet Metal Parameters icon .

The Sheet Metal Parameters dialog box is displayed.

 

2.  Change the Thickness if needed.

3.  Change the Default Bend Radius if needed.

The Default Bend Radius corresponds to the internal radius and is linked by default to the creation of the bends.

Convention dictates that the inner angle between the two elements is used to define the bend.
It can vary from 0deg to 180deg exclusive. This angle is constant and the bend axis is rectilinear.

4.  Click OK to validate the Sheet Metal Parameters.

 
The Standard field displays the Standard to use with the part, if implemented. The name of this standard file is defined in a 
Design Table.
Parameters can be defined in a Design Table. To do so, press the Sheet Standards Files... button to access the company-

defined standards, if need be.

All parameters hereafter, or only some of them, can be defined in this Design Table:



  
Sheet Metal Parameters Column associated in the Design Table Definition

Standard in Sheet Metal Parameters SheetMetalStandard sheet reference name

Thickness Thickness sheet thickness

Default Bend Radius DefaultBendRadius default bend radius

K Factor KFactor neutral fiber position

Radius Table RadiusTable path to the file with all available radii
In all cases, the Thickness parameter must be defined in the Design Table in order for the other parameters to be taken 
into account.

Whenever both Radius Table and Default Bend Radius are defined in the Design Table, only the Radius Table will be taken 
into account for the bend creation.

  
Standard Names For Holes Column associated in the Design Table Definition

Clearance Hole ClearanceHoleStd path to the Clearance Hole Standard file

Index Hole IndexHoleStd path to the Index Hole Standard file

Manufacturing Hole ManufacturingHoleStd path to the Manufacturing Hole Standard file

Fastener Hole FastenerHoleStd path to the Fastener Hole Standard file
  

Standard Names For Stamps Column associated in the Design Table Definition

Flanged Hole ExtrudedHoleStd path to the Flanged Hole Standard file

Bead BeadStd path to the Bead Standard file

Circular Stamp CircularStampStd path to the Circular Stamp Standard file

Surface Stamp SurfaceStampStd path to the Surface Stamp Standard file

Flanged CutOut FlangedCutoutStd path to the Flanged CutOut Standard file

Curve Stamp CurveStampStd path to the Curve Stamp Standard file
When a parameter refers to a path, another sub-Design Table will be associated to the corresponding feature.

 
Example for a bend allowance table

 A bend table is associated to the default bend radius. Each bend radius is linked by a formula to the default bend radius.

If a bend table is defined, the bend allowance (for a given angle) is taken into account when the bend is created. 
Otherwise, the default K factor is used.

You should know that bend tables are used only for:

●     the default bend radius; in the case of a non-standard bend, the K factor is used by default. In this case, you will need 
to modify manually the local K factor if you want the required allowance to be taken into account.

●     the Bend and Bend from Flat features; other features use the K factor for flat length computation.

Main Sheet Metal Parameters Design Table:
 SheetMetalStandard Thickness (mm) DefaultBendRadius (mm) BendTable

AG 3412 2 3 BendTableT2R3

AG 3824 4 5 BendTableT4R5
 Bend Table for Thickness 2 and Default Bend Radius:

According to the open angle, the bend deduction will be read in the Deduction column or interpolated if necessary.
 OpenAngle(deg) Deduction(mm)

20 -0.3

30 -0.531

40 -0.762
 

Example for a hole standard file



Main Sheet Metal Parameters Design Table:
 

 SheetMetalStandard Thickness (mm) DefaultBendRadius (mm) KFactor [...]

AG 3412 2 4 0.36 [...]

ST 5123 3 5 0.27 [...]
 [table continued below]
  

[...] ClearanceHoleStd FastenerHoleStd IndexHoleStd ManufacturingHoleStd

[...] HoleForAero.xls HoleForAero.xls HoleForAero.xls HoleForAero.xls

[...] HoleForAero.xls HoleForAero.xls HoleForAero.xls HoleForAero.xls
  
 Hole Standard:

Whenever a hole is created, a design table will associate its radius with a standard name.
 StandardName     Diameter (in)

M1 0.39

M2 0.65

M3 0.89

M4 0.25

M5 0.56
 

Example for a stamp standard file
Main Sheet Metal Parameters Design Table:
 

 SheetMetalStandard SurfaceStampStd CurveStampStd CircularStampStd BeadStd [...]

AG 3412 SurfaceStampAG3412.xls CurstampAG3412.xls CircularStampAG3412.xls BeadAG3412.xls [...]

ST 5123 SurfaceStamp5123.xls CurveStampST5123.xls CircularStampST5123.xls BeadST5123.xls [...]
[table continued below]
 
[...] BridgeStd FlangedCutoutStd ExtrudedHoleStd StiffeningRibStd

[...] BridgeAG3412.xls FlangedCutoutAG3412.xls ExtrudedHoleAG3412.xls StiffeningRibAG3412.xls

[...] BridgeST5123.xls FlangedCutoutST5123.xls ExtrudedHoleST5123.xls Stiffening RibST5123.xls

 
Whenever a stamp is created, a design table will associate its dimension with a standard name.

 Surface Stamp:
 
StandardName Height (mm) Angle (deg) Radius1 (mm) Radius2 (mm)

S1 6 80 2 2

S2 8 75 1 1
   

 Curve Stamp:
 
StandardName Height (mm) Length (mm) Angle (deg) Radius2 (mm) Radius1 (mm)

C1 4 6 75 1 1

C2 5 7 80 1 1
   

 Circular Stamp:
 
StandardName Diameter (mm) Height (mm) Angle (deg) Radius1 (mm) Radius2 (mm)

C1 10 6 80 2 2

C2 20 5 80 1 1
   



 Bead:
 
StandardName SectionRadius (mm) EndRadius (mm) Height (mm) Radius1 (mm)

Bead04 4 6 4 2

Bead09 9 10 5 3
   

 Bridge:
 
StandardName Angle (deg) PositioningAngle (deg) Length (mm) Radius1 (mm) [...]

B1 80 5 10 2 [...]

B2 75 4 12 1 [...]
 [table continued below]
  

[...] Radius2 (mm) Height (mm) Width (mm)

[...] 2 6 5

[...] 1 8 6
  
 Flanged Cutout:

 
StandardName Height (mm) Angle (deg) Radius1 (mm)

F1 6 80 2

F2 8 75 1
   
Flanged Hole:
StandardName Minor Diameter (mm) Height (mm) Diameter (mm) DefinitionType HeightType

2DiamNoRadInner 15 6 20 TwoDiameters Inner

MajDiamRadOuter 10 7 25 MajorDiameter Outer

MinDiamRadOuter 10 7 25 MinorDiameter Outer

P&DNoRadInner 15 6 15 PunchAndDieDiameters Inner
 [table continued below]
  
 [...] ConeOption RadiusActivity FlatPatternMode FlatDiameter (mm) Angle (deg) KFactor Radius1 (mm)

[...] TRUE FALSE FlatDiameter 5   2

[...] TRUE TRUE FlatDiameter 5 80  2

[...] FALSE TRUE KFactor 5 90 0.3 3

[...] TRUE FALSE KFactor 5  0.3 2
   

 Stiffening Rib:
 
StandardName Angle (deg) Radius2 (mm) Length (mm) Radius1 (mm)

S1 80 2 30 2

S2 75 1 35 2
  
 Louver:

 
StandardName Radius1 (mm) Radius2 (mm) Height (mm) Angle2 (deg) Angle1 (deg)

Std1 2 2 6 90 10

Std2 5 3 6 70 20
  



Modifying the Bend Extremities

This section is only available with the SheetMetal Design products.

This section explains how to change the bend extremities, i.e. how to change axial relimitations for a 
straight bend.

1.  Click the Sheet Metal Parameters icon .

The Sheet Metal Parameters dialog box is displayed.

2.  Click the Bend Extremities tab to access parameters defining bend extremities.

 

 

3.  Choose a bend extremity, either from the drop-down list or using the graphical button underneath.

●     Minimum with no relief (default option): the bend corresponds to the common area of 
the supporting walls along the bend axis, and shows no relief.

●     Square relief: the bend corresponds to the common area of the supporting walls along the 
bend axis, and a square relief is added to the bend extremity. The L1 and L2 parameters 
can be modified if needed. 

●     Round relief: the bend corresponds to the common area of the supporting walls along the 
bend axis, and a round relief is added to the bend extremity. The L1 and L2 parameters can 
be modified if needed.

●     Linear: the unfolded bend is split by two planes going through the corresponding limit 
points (obtained by projection of the bend axis onto the edges of the supporting walls).

●     Tangent: the edges of the bend are tangent to the edges of the supporting walls.



●     Maximum: the bend is calculated between the furthest opposite edges of the supporting 
walls.

●     Closed: the bend corresponds to the intersection between the bends of two supporting 
walls. The closed bend extremity lies on the surface of the encountered bend.

4.  Click OK to validate.

 



Computing the Bend Allowance

This section explains the calculations related to folding/unfolding operations.

1.  Click the SheetMetal Parameters icon 

.

The Sheet Metal Parameters dialog box is 

displayed.

The third tab concerns the bend allowance.

 
●     Bend Allowance

 The bend allowance corresponds to the unfolded bend width.

 
 

bend < 90deg bend > 90deg 

 L is the total unfolded length
A and B the dimensioning lengths as defined on the above figure. They are similar to the DIN 
definition.



 
●     K Factor

 Physically, the neutral fiber represents the limit between the material compressed area inside the bend 
and the extended area outside the bend. Ideally, it is represented by an arc located inside the thickness 
and centered on the bend axis. 

The K factor defines the neutral fiber position:

W = α * (R + k * T)

where:

W is the bend allowance
R the inner bend radius
T the sheet metal thickness
α the inner bend angle in radians.

If β is the opening bend angle in degrees:

α = π * (180 - β) / 180

When you define the sheet metal parameters, a literal feature defines the default K Factor and a formula 
is applied to implement the DIN standard. This standard is defined for thin steel parts. Therefore the K 
Factor value ranges between 0 and 0.5.

The DIN definition for the K factor slightly differs. 

W = α * (R + k' * T/2)
Therefore k' = 2 * k and ranges from 0 to 1.

 This formula can be deactivated or modified by right-clicking in the K factor field and choosing an option 
from the contextual menu. It can be re-activated by clicking the Apply DIN button. Moreover, the limit 
values can also be modified.

 When a bend is created, its own K Factor literal is created. 
Two cases may then occur:

a.  If the Sheet Metal K Factor has an activated formula using the default bend radius as input 
parameter, the same formula is activated on the bend K Factor replacing the default bend radius 
by the local bend radius as input.

b.  In all other cases, a formula "equal to the Sheet Metal K Factor" is activated on the local bend K 
Factor.
This formula can also be deactivated or modified.

 
●     Bend Deduction



 When the bend is unfolded, the sheet metal deformation is thus represented by the bend deduction V, 
defined by the formula:

L = A + B + V
(refer to the previous definitions). 

Therefore the bend deduction is related to the K factor using the following formula:

V = α * (R + k * T) - 2 * (R + T) * tan ( min(π/2,α) / 2)

 This formula is used by default. However, it is possible to define bend tables on the sheet metal 
parameters. These tables define samples: thickness, bend radius, open angle, and bend deduction. In 
this case, the bend deduction is located in the appropriate bend table, matching thickness, bend radius, 
and open angle. If no accurate open angle is found, an interpolation will be performed. 

 When updating the bend, the bend deduction is first computed using the previously defined rules. Then 
the bend allowance is deduced using the following formula:

W = V + 2 * (R + T) * tan ( min(π/2,α) / 2)

When the bend deduction is read in the bend table, the K factor is not used.



Recognizing Walls From an Existing Part
This task illustrates how to recognize an existing part as a sheet metal part, i.e. recognize as sheet metal features the thin part 
shapes of a part created using the Part Design workbench or of a CATIA Version 4 Solid, for example. You can also use this 
functionality to recognize parts created using the SheetMetal Design workbench as Generative Sheetmetal Design parts.

Currently, walls and bends can be recognized. Hems are recognized as walls.

Before recognizing your part, we advice you to copy-paste as result it in a new part. 

Open the NEWRecognize01.CATPart document.

This document contains a part created in the Part Design workbench:

1.  Click the Recognize icon . The Recognize Definition dialog box is displayed. 

 

Note that the With Wall recognition option is already selected, and grayed out. This is because at least walls will be 

recognized, regardless of the other options you may choose. 
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2.  Select a reference face. It will be the reference face for unfolding and for the definition of the sheet metal parameters 

(i.e. all default parameters will be based on this face).

 

3.  For the purpose of this scenario, select Full recognition to specify that you want as many features (walls, bends) as 

possible to be recognized. Doing this automatically selects the With Bend recognition option.

You can also manually select the faces to be recognized as walls, after having activated the corresponding field. Then, 

select the With Bend recognition option, activate the associated field and manually select the faces to be recognized 

as bends.

4.  Click OK to validate. 

The walls are generated from the Part Design geometry. The Recognize.1 feature is added to the tree view. 

At the same time, the sheet metal parameters are created, deduced from the Part geometry.

 

5.  Select the Sheet Metal Parameters icon  to display the sheet metal parameters. 

 



On the Parameters tab:

❍     the Thickness is equal to 20mm,

❍     the Default Bend Radius value amounts to twice that of the thickness.

On the Bend Extremities tab:

❍     the bend extremities are set to Minimum with no relief.

You can modify a few of these parameters. The Thickness parameter cannot be modified because it is based, like the 

bend extremities and radius, on the initial solid geometry. However, you can modify other parameters (default bend 

radius and bend extremities) in order for them to be taken into account for sheet metal features other than the 

"recognized" ones.

The bend allowance, being used to unfold the part, and the bend corner relief affect all features, and therefore can be 

edited even for "recognized" features.

You can also define the sheet metal parameters prior to recognizing the part. In this case, you need to make sure 
that the Thickness parameter value corresponds to the part thickness.

6.  When all parameters have been redefined as needed, click OK in the Sheet Metal Parameters dialog box.

The solid is now a Generative Sheetmetal Design part. You can now deal with it as with any other Generative 

Sheetmetal Design part, adding Generative Sheetmetal Design features to complete the design, or unfolding it.

In certain cases, there may be an ambiguity as regards the faces from which the walls are to be generated.

 For example, if the initial part is a box such as shown below, you will need to select two opposite inner faces, and outer faces 
on the other two sides of the box, in order to avoid overlapping when recognizing the walls. 

 Faces to select Recognition result



 

 In case faces are overlapping, you will need to select the sides of each face. If you select only one face, the overlapping faces 
will be recognized as a unique pad and not two independent walls.

Face selected to be recognized as a wall Result of recognition when unfolding

 To avoid this, select first the inner side, then the outer side of the overlapping faces so that they are recognized as independent 
walls.





Creating Walls
This section explains and illustrates different methods to create walls.

Create a wall from a sketch: use the sketcher to define the profile, and set the material side.

Create a wall tangent to another one: select a profile coincident with an existing wall, and select the wall 
to which it should be tangent.

Create a wall from an edge: select a wall edge, set the height, limits, angle, then the material sides.



Creating Walls from a Sketch

This task shows how to create a wall from a sketch.

You must be in the Sheet Metal Workbench, with a .CATPart document open, and you must have defined 

the sheet metal parameters. 

Set the sketcher grid to H = 100mm and V = 100mm, using the Tools -> Options, Mechanical 

Design -> Sketcher, Sketcher tab.

1.  Click the Sketcher icon  then select the xy plane.

2.  Select the Profile icon .

3.  Sketch the profile as shown below:

4.  Click the Exit workbench icon  to return to the 3D world.



5.  Click the Wall icon .

The Wall Definition dialog box opens.

By default, the Material Side is set to the top.

6.  Click OK.

The Wall.1 feature is added in the specification tree.

The first wall of the Generative Sheetmetal Design Part is known as the Reference wall.

●     Click the Sketcher icon  from the Wall Definition dialog box, if you wish to directly edit the 

selected sketch. When exiting the sketcher, you then go back to the wall creation step, without having 

to reactivate the Wall icon.



This is also very useful if you have selected 
an edge from a wall and clicked the Wall 

icon . 

In this case, the sketcher is automatically 
activated displaying a square sketch 
constrained to the plane perpendicular to 
the support of the selected edge.

You can then directly draw a sketch, then 
exit the sketcher and return to the wall 
creation step. 

    

●     You can directly create a wall with a hole, by selecting a sketch with an inner profile (the profiles must 
not intersect):



  
Sketch with inner profile Resulting wall

Note however, that the emptied area is part of the wall and is not a separate cutout that can be 
edited.



Creating Tangent Walls

This task shows how to create a wall tangent to a planar part of another wall or of a flange. This capability 

will then allow this tangent wall to be seen when unfolding the part, even though there is no bend linking 

it to its tangent support, provided this support can also be unfolded.

Open the NEWTangentWall1.CATPart document.

1.  Select a face of an existing wall and click the Sketcher icon .

Here we selected the flange's planar face.

2.  Select the Profile icon  and sketch the profile as shown below.

3.  Using the Constraint Defined in Dialog box icon, set coincidence constraints between the edges 

where the support and sketch are to coincide.

4.  Click the Exit workbench icon  to return to the 3D world.

5.  Make sure the sketch is still active, then click the Wall icon . The Wall Definition dialog box is 

displayed.
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Note the arrow which indicates the orientation of the wall to be created.

 
6.  Make sure the Tangent to field is active, then select the wall to which the new wall has to be 

tangent. Here, you need to select the planar face of the flange.

Note that the orientation automatically changes to conform to the material orientation already 

defined on the support wall.

 



7.  Click OK.

The wall is created and a Wall.xxx feature is added in the specification tree.

 

8.  Click the Unfold icon .

The tangent wall is unfolded as a wall linked by a bend to another wall, would be.



If you want to create the wall on a wall that cannot be unfolded, the system issues a warning and 

prevents you from creating the tangent wall.

 



Creating Walls From An Edge
This task shows how to create walls from edges of an existing wall. This function is used to create a box in an 
easy and quick way from an existing reference wall.

At least one wall must already exist.

Open the NEWWall1.CATPart document from the samples directory.

1.  Click the Wall on Edge icon  and 

select an edge of an existing wall.  

The Wall On Edge Definition dialog 

box is displayed together with a 

preview of the wall. 

2.  Define the type of wall to be created 

by specifying the Reference, that is:

●     the Height of the wall: that is the 
orthogonal projection from the top of the 
wall on edge to the reference wall.

Select the  icon to define the height 
of the wall from the bottom of the 

reference wall or the  icon to define 
the height of the wall from the top of the 
reference wall.

●     the Length of the wall: that is the 
absolute value of the wall on edge 
without bend.
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3.  You can now relimit the wall by 

selecting planes for the First and 

Second Limit:

●     type:

❍     Undefined reference

❍     Up To Plane

●     Offset

●     Plane 

As a consequence, the generated wall is not 
necessarily rectangular.  

   
 

4.  Define the angle of the wall: by default it is perpendicular to the plane containing the edge. You may 

modify it according to your needs. it is updated dynamically on the screen.

This preview gives information about: 

●     the Sketch Profile: by default, if you pick an edge on the top of the reference wall, the direction of the wall is 

upwards, if you pick an edge on the bottom of the reference wall the direction of the wall is downwards. 

Preview with top edge selected Preview with bottom edge selected

You can invert the sketch's 

position, and therefore the wall's,  

using the Reverse Position 

button. 

Preview with bottom edge selected and sketch profile inverted



●     the material side: by default the material side is proposed so as to keep a continuity with the reference 
profile. 

 

However, you can change it by clicking the red arrow or the Invert Material Side button: in such a 
case, there is no continuity between the material side and the reference profile anymore.

 

5.  Check the Clearance option to offset 

the wall on edge from the selected 

edge. 

The entered value is the radius of 

the bend on this edge. 



Wall on edge with clearance Wall on edge without clearance
    

Note that the reference wall remains unchanged when changing the bend radius value. It is the Wall on Edge's 
length that is affected.

6.  You can also choose to create the wall with or without a bend by checking the With Bend option.

●     If there is no wall from which a limit can be computed, the reference element is the edge of the reference 
wall.

●     A wall on edge is defined by the selected 
edge (reference edge). When the 
reference edge is modified, by adding any 
feature that shortens the edge (a bend to 
an adjacent wall on edge or a cutout for 
example) the wall on edge based on this 
reference edge is recomputed.
To avoid this you may:  

❍     create the bend manually on the wall 
modifying the edge used as the 
reference to  create the other wall

❍     reorder the creation of walls to 
postpone the creation of the 
modifying feature

 
●     Both limits are computed with the same reference icon.

●     The bend is not previewed, even if the option With Bend is checked. However it will be created.

●     The selected options are modal and will be proposed to create the next wall.

●     Walls on edge being contextual features, if you break the profiles continuity by inverting the material side of 
a wall, you may have to manually re-specify all features based upon the modified one, even if they are not 
directly connected to the modified wall, in order to update the part afterwards.

This is the case when creating a 
wall on edge from another wall on 
edge, for example:



●     If you invert the material side of the 
reference wall on which the first wall on 
edge has been created, both walls on 
edge are relocated (as if you were flipping 
the geometry):

●     If you invert the material side of the first 
wall on edge (and not the material side of 
the reference wall), the second wall on 
edge is relocated. Indeed, its specification 
being relative to the first wall on edge, 
when its input data (i.e. the edge selected 
on the first wall on edge) is modified, the 
second wall on edge is rebuilt at a new 
location. 

7.  Click OK in the Wall On Edge Definition dialog box.

A WallOnEdge.xxx element is created in the specification tree.

●     A WallOnEdge.x element can be edited: double-click it in the graphic area or in the specification tree to 
display its creation dialog box and modify the parameters described above, including the edge from which it 
is created. However, the sketch of a wall on edge cannot be edited directly.

●     You can cut or copy and paste a wall on edge. 

●     If you cut and paste a wall on edge with children elements, these children elements are lost. This may result 
in update errors.

●     You cannot undo an Isolate action after having modified the wall.

●     Isolating a wall on edge erases all updating data.

   
 

Creating a Wall On Edge on a 
Flange or a Stamp

 

Open the NEWWall3.CATPart document.
Let's take an example with a user flange. 

 

1.  Click the Wall on Edge icon  and select the edge of the user flange.
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2.  Click to create the wall on edge.

 

 
3.  Click OK in the Wall on Edge Definition dialog box to create the wall on edge on the user flange. 

 



Creating Bends on Walls
 

This section explains and illustrates different methods to create bends on walls. Bends can only be created 
between walls and not between any other Sheet Metal features, such as stamps for example.

Manually create bends from wall: select the two walls, set the bend radius value, the bend extremities, 
and specify the use of corner relief
Create conical bends: select the two walls, set the right and left bend radius values as well as the bend 
extremities.
Create flat bends: select a sketch, set the creation mode and limiting option, set the radius and angle 
in relation to the selected sketch.

Create local fold and unfold of bends: select the two faces and the fold angle.



Creating Bends from Walls
This task explains two ways to create bends between walls in the Sheet Metal part.
These bends can be created on non-connex walls, and with a constant radius value.

Open the NEWBendExtremities01.CATPart document.

1.  Select the Bend icon . The Bend Definition dialog box is displayed.

 

Note that the Radius field is grayed out because it is driven by a formula when editing the sheetmetal parameters: at 

that time, you cannot modify the value.

2.  Select Support 1 and Support 2 in the specification tree or in the geometry area. The two supports must be 

connected by the edge of their internal faces. 

The Bend Definition dialog box is updated, and arrows are displayed, indicating the walls 

orientation. When relevant (which is not the case in our example), you can click the 

arrows to invert the orientation.

The left and right endpoints for the bend are identified using text.

3.  Right-click the Radius field and select Formula -> Deactivate from the contextual menu to change the value.

You can set the Radius value to 0. 

 
4.  Enter 4mm for the radius and click Preview. The bend is previewed, along with its orientation symbolized by 

arrows. 
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5.  Click the More>> button to display additional options: 

You can define:  
●     the left and right extremity settings (see also extremities definition settings)

●     and the bend allowance settings.

 
6.  Click the Left Extremity tab, and choose the Mini with round relief bend extremity type.

7.  Then, deactivate the L1  and L2 length formulas (as previously explained in step 3), and set them to 6mm and 

3mm respectively.



 

 
8.  Click the Right Extremity tab, and choose the Curved shape type.

 

9.  Click Preview to visualize the left and right extremities.

      

10.  Click OK in the Bend Definition dialog box.

The bend (identified as Cylindrical Bend) is created with the specified extremity types and 

is added to the specification tree. 



 
●     The extremities and the corner relief defined with the current dialog box will apply locally and prevail over any other 

global definition.

●     Be careful when creating bends with square or round relief. Depending on the geometry configuration, this can lead 
to removing more matter than you would expect. Indeed, a corner relief being computed on the whole intersection of 
the elements involved (bends or bend/wall), in the following configuration, the matter is removed till the end of the 
wall.

Bend with no relief Bend with square relief
In this case, it is best to replace the bend corner relieves with cutouts (identified in red in the figure below) 
that will act as corner relieves removing matter to the part.

 You can create bends with closed extremities on walls.



 

 If you want to create a close bend, be aware that: 
●     a closed bend cannot be built with a null radius. If you try to, a warning is issued and the bend creation fails;

●     a closed bend cannot be built if there is no intersection with another bend, for instance if a bend is created on an 
inverted wall. A warning is issued and a maximum extremity is built instead;

 

 
●     the bends' supporting walls are not trimmed.



 

 
●     In case the intersection between the bends of the supporting walls is too short, a tangency extrapolation is 

computed.

 

 
Creating a Bend on a Flange or a Stamp
Let's take an example with a surface stamp. 

Open the NEWBendExtremities02.CATPart document. 

1.  Select the Bend icon . The Bend Definition dialog box is displayed. 

2.  Select the surface stamp's face as Support 1. 

3.  Select Wall.3 in the specification tree as Support 2. 
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4.  Click OK in the Bend Definition dialog box to create the bend on the surface stamp. 

 

To deselect a wall, simply click on another wall available in the part. 

The stamp must be open, contain a planar face, and have a radius higher than 0. 

 You can intersect a closed bend with a flange.



 

 You will note that, unlike bends on walls, the filleted part of the flange is relimited by the supporting wall.



Creating Conical Bends
This task explains how to create conical bends between two walls in a Sheet Metal part.

Conical bends are different from the standard bend in that they allow different radius values at each end of 
the bend.

Open the NEWBendExtremities01.CATPart document.

1.  Select the Conical Bend icon . The Bend Definition dialog box appears.

 

 
2.  Select Support 1 and Support 2 in the specification tree or in the geometry area. The two supports 

must be connected by the edge of their internal faces.

The Bend Definition dialog box is updated, and arrows are displayed, indicating 

the walls orientation. When relevant (which is not the case in our example), 

you can click the arrows to invert the orientation. 

The left and right endpoints for the bend are identified using text.
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3.  Enter the radius values for each end of the conical bend. For example, enter 5mm as the left radius 

and 20mm as the right radius.

●     By default, Right Radius amounts to twice Left Radius.

●     Note that the radius is computed based on the left and right endpoints for the bend. 
This radius, once computed, will be larger than the specified value. 

●     When the size of each support differs, the bend may exceed the top of the cone. In 
such a case, computing the radius value is impossible. 

 
The Angle field is locked. If you then click the Preview button, it is updated, indicating 

the angle value between the two walls between which the bend is computed. 

 



4.  Click More... to display additional options.

 



5.  Optionally, on the Left Extremity and Right Extremity tabs, click the graphical button to choose the 

bend extremities:

●     Mini with no relief (default option): the bend corresponds to the common area of 

the supporting walls along the bend axis, and shows no relief.

●     Mini with square relief: the bend corresponds to the common area of the 

supporting walls along the bend axis, and a square relief is added to the bend 

extremity. The L1 and L2 parameters can be modified if needed. 

●     Mini with round relief: the bend corresponds to the common area of the supporting 

walls along the bend axis, and a round relief is added to the bend extremity. The L1 

and L2 parameters can be modified if needed.

●     Linear shape: the unfolded bend is split by two planes going through the 

corresponding limit points (obtained by projection of the bend axis onto the edges of 

the supporting walls).

●     Curve shaped: the edges of the bend are tangent to the edges of the supporting 

walls.

●     Maximum bend: the bend is calculated between the furthest opposite edges of the 

supporting walls.

●     Closed: the bend corresponds to the intersection between the bends of two 

supporting walls. The closed bend extremity lies on the surface of the encountered 

bend.

6.  Optionally, on the Bend Allowance tab, define the K factor (which performs calculations related to 

folding/unfolding operations). Refer to Computing the Bend Allowance for complete information.

7.  Click OK. The conical bend is created. 



For more information on closed bends, refer to Creating Bends from Walls.



Creating Bends From a Line

This task explains how to generate bends based on a line (also called bends from flat).

Open the NEWFlatBend1.CATPart document.

1.  Click the Bend From Flat icon .

The Bend From Flat Definition dialog box opens.

 

2.  Select a profile (Sketch.3 here) containing one or several lines.

This sketch must contain lines only.
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Selected lines appear in the Lines drop down list.

 

If necessary, you can create the profile in the Sketcher workbench using the sketcher icon .

The line(s) must not intersect an area where a 3D feature (such as a longitudinal chamfer, or a stamp 
created from punch and die) lies.
 

3.  You can choose the line extrapolation option:

 Axis 

 BTL (Bent Tangent Line): line corresponding to the limits of the bend's fillet

 IML (Inner Mold Line): line created by intersecting the internal surfaces of the bend (before filleting) 

and the wall

 OML (Outer Mold Line): line created by intersecting the bend support and a plane perpendicular to 



the wall and normal to the OML.

The Radius and the KFactor values are the one defined when editing the sheetmetal parameters:
Right-click the Radius or the KFactor field and select Formula -> Deactivate from the contextual menu 
to change the value.

You can set the Radius value to 0.

 Once you chose the lines, the fixed point is automatically set on the face where the profile is lying.
It represents the part of the wall that will not move when the bend is created.

 

 
4.  Select another fixed point as shown below.

 



Should you need to create the fixed point, right-click the Fixed Point field and select Create Point in the 
contextual menu.

 

 
5.  If needed, set the angle value for each line, using the Lines drop down list.

In our scenario, we selected 90 degrees for Line.1

You can invert the bending direction by clicking the blue arrow.

6.  Click OK to create the bend.



 



Creating Local Fold and Unfold 
This task explains how to fold or unfold bends in the Sheet Metal part.
 

Local Fold and Unfold applies to cylindrical faces such as flange, bend and surfaces recognized as bend. 

In our example, we chose local fold and unfold of bends.

Open the NEWFoldUnfoldBends.CATPart document.

Unfold
 

1.  Select the Unfolding icon . 

The Unfolding Definition dialog box is displayed.

 

 
2.  Select Wall.1 as reference face on the geometry.

Angle type is disabled and set to Natural.

Angle is at 90 degrees.
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3.  Select Cylindrical Bend.1 and Cylindrical Bend.2 on the geometry.

 

 
4.  Click on Preview to visualize the unfolding of the bends you selected.



 

 
5.  Click on OK to unfold the bends.

The Unfolding.1 feature is created in the specification tree.

The following options are available in the Unfolding Definition dialog box:

●     Reference face: fixed part of the body

●     Unfold Faces: bend(s) to unfold

●     Angle: disabled, corresponds to the angle of the selected face to fold that is 90 degrees by 
default

●     Angle type: disabled, set to natural by default

 

Fold
 

1.  Select the Folding icon . The Folding Definition dialog box is displayed.



 

 
2.  Select Wall.3 as reference face on the geometry.

 

 
3.  Select Cylindrical Bend.1 on the geometry.

A red arrow is displayed indicating the direction of the angle.

 

 
4.  In the Folding Definition dialog box, select Defined as angle type and 45 degrees as angle.

5.  Click on Preview to visualize the folding of the bend you selected.



 

 
6.  Click on OK to fold the selected bend.

The Folding.1 feature is created in the specification tree.

The following options are available in the Folding Definition dialog box:

●     Reference face: fixed part of the body

●     Fold faces: bend(s) to fold

●     Angle: corresponds to the angle of the selected face to unfold

●     Angle type
❍     Natural: when selected, the angle is set to the initial bend value by default (90 degrees 

in our example) and is disabled

❍     Defined: allows you to choose the bend angle with the up and down arrows

❍     Spring back: the angle of the bend is based on the natural angle with additional 
degrees.

 

 Bend folded with a Spring back angle at 90 degrees.



 

 Bend folded with a natural angle at 90 degrees.
To fold or unfold a part with a bending cycle, each element of the cylindrical bend has to be selected 
individually.

 



●     Multiselection is possible but since unfold faces must be in the same domain you must fold/unfold the 

parts one after the other. You cannot create folded faces with null radius.

●     The fold/unfold feature is only available in folded view, as the flattened view is not modified.

You cannot fold/unfold bends:
●     if faces to fold are not in the same domain,

●     if faces to unfold have a null radius,

●     if cylindrical faces are generated from stamps or rolled walls.

  
In hybrid context, even though a wall is created with one or several features, none are aggregated under 
the wall in the specification tree. 

Specification tree's behavior in pre-hybrid context.

 

Specification tree's behavior in hybrid context.

Yet, if you open a part created in a previous release, the specification tree will be displayed accordingly to 
the previous behavior.
Fore more information about Hybrid Design, refer to the Hybrid Design section.
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Creating Extrusions
 

This section explains and illustrates how to create various kinds of extrusions.

Extrude: choose the extrusion type, specify the length and choose additional options.

Create Rolled Walls: select a circular sketch, specify the rolled wall type and choose additional options.



Extruding

This task explains how to create a wall by extrusion.
You can extrude sketches composed of lines, circles, projection of lines, and projection of circles.

You must have defined the Sheet Metal parameters.
A model is available in the NEWExtrude1.CATPart from the samples directory.

1.  Click the Extrusion icon .

2.  Select a sketch.

The Extrusion Definition dialog box is displayed. 

Several types of extrusion are available:  
●     Dimension : the requested input data are a sketch and a dimension,

●     Up to plane or Up to surface: a plane or a surface are input as limit to the extrusion. These 
functions are used to create walls that are not rectangular.

3.  Edit the Length1 and Length2 to set both extremities, for option Dimension.

By default, the Length1 value is positive.
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The sketch you selected appears in the Selection field

You can now edit it by clicking the Sketcher icon  if you wish to modify it.

4.  Define the options as needed:

●     Check the option Mirrored extent to extent the material on both sides of the sketch. In that case, 
only Length1 can be edited. 

 

This option is only available if the type is set to Dimension.

●     Check Symmetrical thickness to create thickness inside and outside the sketch.



●     Push Invert Material Side to invert the direction of the creation of the material.

 

5.  Click OK.

The walls corresponding to the selected sketch are created according to the specified options, 

and added to the specification tree.

●     When the extrusion is the first Sheet Metal feature of the Part, the reference wall is the first wall 
created based on the first segment of the sketch.

●     For option Up to Surface, while the wall end that is limited by the surface has the shape of the 
surface, its thickness does not fit the surface. It is a "rectangular" polygon defined by the first edge 
that comes into contact with the surface.



 

●     Such an extrusion can also be performed on a sketch 
made of lines and arcs of circle, provided there are no 
tangency discontinuities between the different 
elements. 
However, in this case: 

❍     the Up to plane or Up to surface capabilities are 
not available, 

❍     you cannot isolate such an extrusion,

❍     if the element of the extruded sketch connected to 
the part is an arc of circle, the extrusion will not 
display in the unfolded view. To avoid this, prefer 
to create a User Defined Flange or remove the arc 
of circle of the extruded sketch and create a bend 
to connect the extrusion to the part.

●     Extrusion walls can be edited.

The sketch may not be closed, and must contain at least a line.



Creating Rolled Walls

This task shows how to create rolled walls (such as pipes, open pipes with flange, etc.).

You must have defined the Sheet Metal parameters, and have a sketch available, in the form of an circular 
arc.
The part is available in the Rolledwall1.CATPart from the samples directory.

1.  Click the Rolled Walls icon .

2.  Select the circular sketch.

 

3.  Make sure the type is set to Dimension.

4.  Length 1 and Length 2 indicate the location of Limit 1 and Limit 2.

file:///E|/www/lgkr16/Doc/online/cfysm_C2/samples/SheetMetal/Rolledwall1.CATPart


5.  Define the options as needed.

●     Check the option Mirrored extent to extend the material on both sides of the sketch. In that case, 
only Length1 can be edited.

●     Check Symmetrical thickness to create thickness inside and outside the sketch.



 

●     Click Invert Material Side to invert the direction of the creation of the material.

 

6.  Click OK in the dialog box to create the rolled wall.

 

 Unfold Reference

 Two symmetrical faces are generated so that the rolled wall can be unfolded.

To do so, click the Fold/Unfold icon .
 You can unfold the rolled wall from the start point, middle point or end point of the rolled wall. 

To select the unfold references:



 1.  Double-click the Rolled Wall.1 in the specification tree to open the Rolled Wall Definition dialog 

box.

2.  In the Unfold Reference section, select the point of reference from which you want to unfold the 

rolled wall.

 

 
3.  Click OK to apply your parameters.

 
●     Start point

 

 
●     End point



 

 
●     Middle point

 



The rolled wall is a particular extrusion, indeed the input sketch is either a circular arc or a closed circle.

The sketch may be open. In that case, you can define where the opening should be.
The opening angle must be at least 0.5 degree.

The sketch may be closed. In that case, you have no control on the opening location.

The only operations you can combine with a rolled wall in a Sheet Metal model are flanges and cutouts. 

No other elements (standard wall, bend,...) are allowed.

 



Creating Swept Walls
 

This section explains and illustrates how to create and use various kinds of swept walls, i.e. walls based on a 
given profile that is swept along a spine.

Create a flange: select a spine, and set the radius, length, and angle values.

Create a hem: select a spine, and set the radius, and  length values.

Create a tear drop: select a spine, and set the radius, and  length values.

Create a swept flange: select a spine, and a user-defined profile

Selecting the Spine
Whatever the type of the swept wall you wish to create, you first need to select one or more contiguous edges 
to make up the spine along which the contour, either pre- or user-defined, is to be swept. You can:

●     manually select one, or more, edge(s)

Selection without propagation Resulting flange without propagation
    

●     select  one edge and click the Tangency Propagation button: all contiguous and tangent edges are 
selected. In this case, would you need to remove one edge, you need to manually select it. Remember that 
only extremity edges can be removed without breaking the continuity between edges.



Selection with propagation Resulting flange with propagation



Creating a Flange 

This task explains how to generate a flange from a spine and a profile.

For the Generative Sheetmetal Design workbench, open the NEWSweptWall01.CATPart document.

For the Aerospace SheetMetal Design workbench, open the Aero_SweptWall01.CATPart document.

1.  Select the Flange icon  in the Swept Walls sub-toolbar.

 

 The Flange Definition dialog box is displayed. 

 
Note that the image in the right-hand pane of the dialog box is updated as you choose your parameters and options, 

and provides a graphical explanation about the current selection.

 

By default, the icon which is pre-selected next to the Angle field corresponds to an acute angle  for the Generative 

Sheetmetal Design workbench, and to an obtuse angle  for the Aerospace SheetMetal Design workbench.

2.  Select the edge as shown in red.

file:///E|/www/lgkr16/Doc/online/cfysm_C2/samples/NEWSweptWall01.CATPart
file:///E|/www/lgkr16/Doc/online/cfysm_C2/samples/Aero_SweptWall01.CATPart


 

 The Spine field is updated with the selected edge.

●     You can use the Remove All button to remove the selected edge(s).

●     You can use the Propagate button to select all tangentially contiguous edges forming the spine.

The drop-down list offers two choices: 

●     Basic: the flange is created along the whole support.

●     Relimited: the flange is created within limits you define on the support (points, for example). 

3.  Leave Basic selected. 

Selecting Relimited updates the dialog with two new fields (Limit 1 and Limit 2) to let you specify the flange limits. You can 
then select as the limits two points, two planar faces, a point and a planar face, or a point and a vertex, as shown below, for 
example. Note that right-clicking in the Limit 1 and Limit 2 fields lets you create the limits (points, plane) or choose the X, Y 
or Z plane on-the-fly.

 



 

 
4.  Choose the flange parameters:

●     Enter 15mm in the Length field. Use the icons  next to the field to specify the type of 

length. Note that the length is always computed using the lowest external point of the flange.

●     Enter 45deg in the Angle field. Use the icons next to the field to specify whether the angle is acute  or 

obtuse .

●     Enter 2mm in the Radius field.

 
5.  Check the Trim Support option to trim the selected edge.

●     The Trim Support option only works in the case of a planar support.

●     You cannot select Relimited and Trim Support at once. Indeed, lateral cuts in the sheet metal part are currently not 
supported when the support is trimmed (i.e. the flange must be created from one edge of the sheet metal part to the 
other). 

 
6.  Click the Reverse Direction button to reverse the direction of the flange.

7.  Click the Invert Material Side button to invert the material side. (This option is only available when the Trim Support 

option is checked, otherwise it is deactivated.)

8.  Click the More button to display the Bend Allowance tab allowing you to locally redefine the bend allowance settings. 

You may need to deactivate the formula using the contextual menu on the field and choosing Formula -> Deactivate 

before editing the value.



 

In this case, the new K Factor value overrides the value set in the Sheet Metal Parameters.

A preview of the flange to be created is displayed in the geometry area.

 

9.  When you are satisfied with the result, click OK to create the flange. The flange is created and the feature is added to 

the specification tree.
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Creating a Hem

This task explains how to generate a hem from a spine and a profile.

Open the NEWSweptWall02.CATPart document from the samples directory.

1.  Select the Hem icon  in the Swept 

Walls sub-toolbar.

The Hem Definition dialog box opens.

 
Note that the image in the right-hand pane of the dialog box is updated as you choose your parameters and 

options, and provides a graphical explanation about the current selection.

2.  Select the edge as shown.

 The Spine field is updated with the selected edge.
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●     You can use the Remove All button to remove the selected edge(s).

●     You can use the Propagate button to select all tangentially contiguous edges forming the spine.

The drop-down list offers two choices: 

●     Basic: the hem is created along the whole support.

●     Relimited: the hem is created within limits you define on the support (points, for example). 

3.  Leave Basic selected. 

Selecting Relimited updates the dialog with two new fields (Limit 1 and Limit 2) to let you specify the hem limits. You 
can then select as the limits two points, two planar faces, a point and a planar face, or a point and a vertex, for 
example. Note that right-clicking in the Limit 1 and Limit 2 fields lets you create the limits (points, plane) or choose the 
X, Y or Z plane on-the-fly.

 

4.  Enter 3mm in the Length field, and 2mm in the Radius field.

5.  Check the Trim Support option to trim the selected edge.

●     The Trim Support option only works in the case of a planar support.

●     You cannot select Relimited and Trim Support at once. Indeed, lateral cuts in the sheet metal part are currently not 
supported when the support is trimmed (i.e. the hem must be created from one edge of the sheet metal part to the 
other). 

6.  Click the Reverse Direction button to reverse the direction of the hem.

7.  Click the More button to display the Bend Allowance tab allowing you to locally redefine the bend allowance 

settings. 

You may need to deactivate the formula using the contextual menu on the field and choosing Formula -> 

Deactivate before editing the value.



In this case, the new K Factor value overrides the value set in the Sheet Metal Parameters.

A preview of the hem to be created is displayed in the geometry area.

 

8.  When you are satisfied with the result, click OK to create the hem. The hem is created and the feature is added to 

the specification tree.
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Creating a Tear Drop

This task explains how to generate a tear drop from a spine and a profile.

If not, open the NEWSweptWall03.CATPart document from the samples directory.

1.  Select the Tear Drop icon  in the 

Swept Walls sub-toolbar.

The Tear Drop Definition dialog box 
opens.

 
Note that the image in the right-hand pane of the dialog box is updated as you choose your parameters and 

options, and provides a graphical explanation about the current selection.

2.  Select the edge as shown in red.

 The Spine field is updated with the selected edge.
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●     You can use the Remove All button to remove the selected edge(s).

●     You can use the Propagate button to select all tangentially contiguous edges forming the spine.

The drop-down list offers two choices: 

●     Basic: the tear drop is created along the whole support.

●     Relimited: the tear drop is created within limits you define on the support (points, for example). 

3.  Leave Basic selected. 

Selecting Relimited updates the dialog with two new fields (Limit 1 and Limit 2) to let you specify the tear drop limits. 
You can then select as the limits two points, two planar faces, a point and a planar face, or a point and a vertex, for 
example. Note that right-clicking in the Limit 1 and Limit 2 fields lets you create the limits (points, plane) or choose the 
X, Y or Z plane on-the-fly.

 

 
4.  Enter 8mm in the Length field, and 3mm in the Radius field.

5.  Check the Trim Support option to trim the selected edge.

●     The Trim Support option only works in the case of a planar support.

●     You cannot select Relimited and Trim Support at once. Indeed, lateral cuts in the sheet metal part are currently not 
supported when the support is trimmed (i.e. the tear drop must be created from one edge of the sheet metal part to 
the other). 

 
6.  Click the Reverse Direction button to reverse the direction of the tear drop.

7.  Click the More>> button to display the Bend Allowance tab allowing you to locally redefine the bend allowance 

settings. 

You may need to deactivate the formula using the contextual menu on the field and choosing Formula -> 

Deactivate before editing the value.



In this case, the new K Factor value overrides the value set in the Sheet Metal Parameters.

A preview of the tear drop to be created is displayed in the geometry area.

 

8.  When you are satisfied with the result, click OK to create the tear drop. The tear drop is created and the feature is 

added to the specification tree.
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Creating a User Flange 

This task explains how to generate a user flange from a spine and a user-defined profile.

Open the NEWSweptWall04.CATPart document from the samples directory. As a profile is already defined 
on the part, you will be able to skip step 2 of the scenario.

1.  Select the User Flange icon in the Swept Walls sub-toolbar.

 

The User Defined Flange Definition dialog box opens. 

 

 
2.  If you are using the NEWSweptWall01.CATPart document, click the Sketcher icon , and 

define a profile in the yz plane as shown below:

file:///E|/www/lgkr16/Doc/online/cfysm_C2/samples/NEWSweptWall04.CATPart
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Then quit the Sketcher, using the Exit icon .

If you are using the NEWSweptWall04.CATPart, go directly to step 3 as the profile is already 

defined.

3.  Select the edge and the profile, as shown in red.

4.  Click the More button to display the Bend Allowance tab allowing you to locally redefine the 

bend allowance settings. 

You may need to deactivate the formula using the contextual menu on the K Factor field and 

choosing Formula -> Deactivate before editing the value.
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In this case, the new K Factor value overrides the value set in the Sheet Metal Parameters.

5.  Click OK to create the user flange.

The feature is added in the specification tree.

●     Use the Remove All button to remove the selected edge(s).

●     Use the Propagate button to select all tangentially contiguous edges forming the spine.
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As far as the profile is concerned, remember that:
●     There must be a tangency continuity with the edge on which the flange is created,

●     The plane must be normal to the spine.

 



Aggregating Bodies
 

This task shows you, when creating a bend, to aggregate, under the current body containing a wall, the 
created bend as well as the body containing the second wall.

Open the NEWBendExtremities03.CATPart document.

This capability is not available with the Bend From Flat command.

1.  In the specification tree, define Wall.2 (in 

Body.1) as current: right-click and select 

Define In Work Object from the contextual 

menu.

 

 

2.  Select the Bend icon .

The Bend Definition dialog box opens.
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3.  Select Wall.2 and Wall.3 in the specification 

tree.

The Bend Definition dialog box is updated.

 

4.  Click Preview to visualize the bend.

5.  Click OK in the Bend Definition dialog box.

 

The Bend (identified as Cylindrical Bend.x) is created 

and added to the specification tree. 

You can see that it appears under the Body.1 node 

and aggregates Body.2 containing Wall.3.



You can perform the same operation by defining PartBody as the current object and selecting Wall.1 and 
Wall.2 as inputs. PartBody contains the cylindrical bend, that aggregates Body.1 (itself containing Wall.2).



    Creating a Hopper
This task illustrates how to create a surfacic and a canonic hopper between two sketched profiles, with an opening line 
(for unfolding operations) defined by an edge for surfacic hoppers or two points for canonic hoppers. 

Open the NEWHopper01.CATPart document. This document contains two sketches, as well as a point on each sketch.

 Surfacic hopper
  

Surfacic hoppers are defined by a ruled surface selected by the user or created thanks to the loft command. Defining a 
surfacic hopper via a loft is highly recommended since it allows detection of all canonical segments. 

The two sketches used to define the loft can be on parallel or non parallel planes. 

The reference wire and the invariant point, used to unfold the hopper, must lie on the surface, as well as the tear wire. 

1.  Click the Hopper icon . The Hopper dialog box is displayed. 

 

 
2.  Right-click on No selection field and select Create Multi-sections surface.
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The Multi-sections Surface Definition dialog box is displayed.

 

 
3.  Select Sketch.1 and Sketch.2 in the specification tree as surfaces.



 

 
4.  Click on the Coupling tab and start coupling sketches together.

You should end up with eight couplings.

 

 
5.  Click on Preview if you want to visualize the loft, then on OK.

6.  Select a reference wire lying on the surface of the hopper.

In our example, we select an edge.



 

 
7.  Select an invariant point lying both on the surface and on the reference wire.

 

 
A preview of the unfolded hopper is displayed, as well as its thickening in light blue.

 



 
8.  Select a tear wire. 

In our example, we select the same edge as the reference wire.

The unfolded view of the hopper starting from the tear wire is displayed.

 



●     The surface must be ruled otherwise you will not be able to create a hopper.

●     If you want to modify your selections in the Hopper dialog box, you can right-click in the field and select Clear 
selection in the contextual menu.

 
9.  Click OK to validate and exit the dialog box. The hopper is created.

 



 

10.  If you now click the Fold/Unfold icon , the hopper is unfolded as follows:

 



You can modify the hopper you are creating thanks to the options available in the Hopper dialog box.

●     Invert material side: the red arrow indicates the direction for thickening the hopper. You can change the 

thickening direction by clicking either this red arrow or the Invert material side button.

●     Neutral fiber: the selected input surface is considered to be the hopper neutral fiber. This option proves to be useful 

when the offset input surface is not ruled.

●     Reference wire: is an edge lying on the surface or a curve.

When you right-click on the Reference Wire field, you can select other types of reference wires.

❍     Create line

❍     Create Intersection

❍     Create Projection 

❍     Create Extract

●     Invariant point: point lying on the surface and the reference wire.

When you right-click on the Invariant point field, you can create you own invariant point.

●     Invert fixed side: the green arrow indicates the fixed side for unfolding: the hopper may be unfolded from the side 

opposite to the arrow. You can change the unfolding direction by clicking either this green arrow or the Invert fixed 

side button.

●     Tear wire: defines the opening line. It can be a curve going through the surface or several edges.

 

Canonic hopper
  

Canonic hoppers can be conical, cylindrical or planar. Their defining sketches can be on parallel planes when creating a 
canonical hopper. They may be open or closed; they should have similar shapes, and should be composed of arcs of 
circles and straight segments. For each segment or arc in a sketch, there should be a corresponding segment or arc in 
the other sketch. In the case of arcs, the projection of their centers onto the other sketch plane must match. 

To sum up, each edge in a sketch must be an offset from a corresponding edge in the other sketch so that the resulting 
hopper may be conical, cylindrical or planar. 

The two points defining the opening line (one point on each sketch) must have been created explicitly prior to creating 
the hopper. Each point should lie on a corresponding segment.



1.  Click the Hopper icon . Select Canonic hopper in the Hopper dialog box that is displayed. 

 

2.  Select Sketch.1 as the first profile, either from the geometry area or from the specification tree. 

3.  Select Sketch.2 as the second profile.

4.  Select Sketch.3 as the first point for the opening line. 

5.  Select Sketch.4 as the second point for the opening line. 

Note that the first point of the opening must be on the first profile, and the second point must be on the 
second profile. 

A preview of the hopper is displayed. You can notice two arrows starting from the first point.

 

 



❍     The green arrow indicates the fixed side for unfolding: the hopper may be unfolded from the side opposite to 
the arrow. You can change the unfolding direction by clicking either this green arrow or the Invert fixed 
side button.

❍     The red arrow indicates the direction for thickening the hopper. You can change the thickening direction by 
clicking either this red arrow or the Invert material side button.

  

6.  Click OK to validate and exit the dialog box. The hopper is created.

 

  

7.  If you now click the Fold/Unfold icon , the hopper is unfolded as follows:

 



  



Unfolding
Unfolded Sheet Metal parts can be displayed in two ways:

Folded/Unfolded View Access
Concurrent Access
Deactivating Views

 
Each Sheet Metal feature is created in a given view: folded, or unfolded. Editing a feature must be done in 
its definition view. If not, a message is automatically issued, prompting you to change views, before editing 
the feature.
 

 



Folded/Unfolded View Access  

This task shows how to unfold the part and fold it again.

To perform this scenario, you can open any sheet metal sample provided in this user's guide.

1.  Click the Fold/Unfold icon .

The part is unfolded according to the reference wall plane or web, as shown below. 

 

2.  Click the Fold/Unfold icon  again to refold the part.

●     In SheetMetal Design, bend limits and stamping are now displayed in the unfolded view. However, 

cutouts created on stamps are not.

●     When designing in context, if a CATProduct document contains several sheet metal parts, only one 
part can be visualized in the unfolded view at a time.



Concurrent Access  
This functionality is P2 for SheetMetal Design and Generative SheetMetal Design.
This task explains how to display the sheet metal part in two windows: one with the folded view, one with the unfolded 
view. Any modification in one window is displayed in the other window.

To perform this scenario, you can open any sheet metal sample provided in this user's guide.

1.  Click the Multi Viewer icon .

The part is unfolded in a second window.  

2.  Choose the Window -> Tile Horizontally menu item.

Both windows are tiled. Activate the window in which you want to work. 



●     Any modification in one view is taken into account in the other view enabling the user to make modifications in the 
best possible context.

●     In the multi-view mode as in the standard unfolded view, all constraints are displayed in the geometrical views.

●     Once in the Multi-view mode, the standard icon Unfold is not longer available.

●     The Multi-view function is not available from a standard unfolded view.



Deactivating Views   

This task shows how to deactivate views so that only the folded view or the flat view is computed.

To perform this scenario, you can open any sheet metal sample provided in this user's guide. Make sure 
the part is folded.

1.  In the specification tree, right-click the PartBody feature.

2.  From the contextual menu, select PartBody object > Views. 

or

3.  Click the Views Management icon .

 

The Views dialog box is displayed. You can see that 3D 
view (i.e. folded view) is the current view: this means 
that the part is currently folded. 

 
3.  Select flat view. 

4.  You have two options: 

❍     Click the Current button to make the flat view current: this unfolds the part.

❍     Click the Deactivate button to deactivate the flat view: this makes it impossible to unfold the 

part. Since only the folded view is computed, the part will take less time to load.

5.  If you then try to unfold the part, a message appears, indicating that the unfolded view is 

inactive. You can reactivate the flat view by repeating steps 1 to 3 and then clicking the Activate 

button. 



The scenario described above is also available with unfolded views: 

●     you can make the folded view current by selecting 3D view in the Views dialog box and clicking the 

Current button.

●     you can deactivate the folded view by selecting 3D view in the Views dialog box and clicking the 

Deactivate button.



Checking Overlapping

 

This task shows how check the overlapping of different areas of the part. This is usually done when the 
part has been designed, bends created and the part is unfolded.
Overlapping between areas of the part are highlighted.

 
Open the NewOverlap01.CATPart document from the samples directory.

 1.  Click the Fold/Unfold icon  to unfold the part.

2.  Click the Check Overlapping icon .

The area with the overlapping is highlighted in red. 

The Overlapping Detection dialog box is displayed indicating 
how many overlaps are present on the analyzed part.

3.  Click OK.

A curve is generated. This curve can then be used to solve the overlapping, by redesigning the 

involved feature's sketches or specifications.

4.  Click OK.
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Generated curve on unfolded view Generated curve on folded view
      

 
When no overlapping is detected, the Overlapping Detection 
dialog box indicates so:

In hybrid context, the curve generated after an overlapping detection is aggregated under the part body 
in the specification tree.

 

 Specification tree's behavior in 
hybrid context.

 Specification tree's behavior in pre-hybrid 
context.

 



Creating a Hole  

This task shows you how to create a hole, that consists in removing material from a body.

Open the NEWHole1.CATPart document.

1.  Click the Hole icon .

Click the surface where you want to place the hole.

A grid is displayed to help you position the hole.

The Hole definition dialog box is displayed, providing default values.
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2.  In the Extension tab, choose a bottom limit for the hole.

 

Blind Up to Next Up to Last

 

Up to Plane Up to Surface

3.  Use the up and down arrows to specify the values as needed.

In our example, we kept the Blind option with a diameter of 12mm and a depth of 8mm.

4.  Should you need to change the position of the hole on the surface, click the Positioning Sketch icon .

The Sketcher workbench opens and a point representing the hole's position is displayed on the surface.



 

 
5.  Move the hole on the surface according to your needs.

 

 
6.  Exit the Sketcher workbench.

The hole is positioned according to your settings.

 

7.  Keep the direction Normal to surface to create the hole normal to the sketch face.



 
If you want to create a hole not normal to the sketch face, click to clear Normal to surface and select a line, an 
edge or a plane in the contextual menu of the field.

Refer to the Hole description in Part Design User's Guide for more information.

 
8.  Choose a bottom type for the hole.

●     Flat;

●     V-Bottom;

●     Trimmed (available when selecting Up to Next, 'Up to Last', 'Up to Plane' or 'Up 

to Surface').

In our example, we selected a V-bottom of 120 degrees.

9.  In the type tab, select the type of hole you wish to create.

Simple Tapered Counterbored
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Countersunk Counterdrilled

10.  Use the up and down arrows to specify the values as needed.

In our example we chose a counterbored hole of 15mm diameter and 5mm depth.

11.  In the Thread Definition tab, click Threaded if you wish to create a threaded hole.

12.  Use the up and down arrows to specify the values as needed.

You cannot differentiate a threaded and a non-threaded hole on the wall. 

In the example below, the hole on the right is threaded when the hole on the left is not.

A threaded hole is visible only:
●     in the specification tree;

In the example below, Hole.1 is threaded when Hole.2 is not.



 

 
●     in the preview;

Threaded hole
Non-threaded hole

 
●     on a drawing.

In the example below, the hole on the right is threaded when the hole on the left is not.



To display threaded holes on a drawing, make sure Generate Threads is selected in the Drafting settings. 
To do so, go to Tools->Options, Mechanical Design, Drafting, View tab.

 

Refer to Creating Threaded Holes in Part Design User's Guide for more information.

13.  Click OK to create the hole.

 

You can constrain the hole's location when creating it.

1.  Select two edges on the wall and click the Hole icon .
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2.  Click the surface where you want to place the hole.

Constraints defining the distances between the hole's center and the edges are displayed.

3.  Click OK to create the Hole.

 

 Refer to Locating Holes in Part Design User's Guide for more information.
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●     The hole can be created only on a planar and single support surface (i.e. a wall or the planar face of a flange).

●     May you want to create a hole on an overlapping element or a bend with radius=0, either choose the top skin 
of the element, or unfold the part to create the hole.

●     You cannot create
❍     a hole on a bend or a surface flange. 

If you try to, a warning is displayed and the Circular Cutout definition dialog box opens so that you can 
create the hole on a bend or a flange.

❍     a feature built by thickening on a hole.

●     You can create 
❍     a hole on a hole;

 

❍     a hole on a half-height hole;
 

❍     a hole on a pocket.
 



Creating a Circular Cutout 

This task shows you how to create a circular cutout, that consists in thicknening the profile normal to the 
wall.

Open the Hole1.CATPart document.

1.  Click the Circular cutout icon  in the Holes toolbar.

The Circular cutout definition dialog box opens.

 

2.  Select the Point that will be the center of the circular cutout.

It can be either a sketch containing one or more points, or a point, or several points. The points 

must be on the same support.
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●     The point can be selected anywhere in the geometry, not necessarily on a surface. In that case, an 
orthogonal projection will be performed.

●     You can also directly click the surface: a point will be created under the pointer. 

●     To deselect a point, click it in the specification tree. 

3.  Select the Support object where the circular cutout will be positioned (Wall.1 in our example).

●     The support can be different from the support where the point lies. In that case, an orthogonal 
projection will be performed.

The cutout is previewed with default parameters.

 

4.  Define the value for the diameter of the circular cutout in the Diameter field.



If you change the Diameter value using the spinners, the preview of the circular cutout automatically 
updates. However, if you enter a value directly in the field, you need to click the Apply button to update 
the preview.

5.  Click OK to validate.

The circular cutout (identified as circular cutout.xxx) is created and the specification tree is updated 
accordingly.

Circular cutouts can be created on the unfolded parts and on bends.

For have further information on standard files, refer to the Editing the Sheet and Tool Parameters.



Creating a Cutout
This task explains how to create a cutout in a wall. You can create a standard or a pocket cutout. 
A standard cutout consists in thicknening the profile normal to the wall. A pocket cutout is built by extruding a profile and removing the material 
resulting from the extrusion.

Open the NEWCutout1.CATPart document.

Standard cutout

1.  Click the Cutout icon .

The Cutout Definition dialog box is displayed and the skin to be impacted by the cutout is displayed in a different color.

 

     

2.  Select a profile (sketch.3 in our example).

A preview of the projected cutout is displayed.

You are strongly advised to use a closed profile to create a cutout.

In case you create a cutout from a profile containing more than one open contour, you are warned that the cutout may fail.
 

 1.  Click Yes to select the profile anyway;
2.  Click OK to create the cutout;

If the Cutout fails, modify the profile in the Sketcher workbench.
or

1.  Click No.
The profile is not selected.
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Once the profile is selected, you can modify it by clicking the Sketcher icon .

●     The Reverse Side option lets you choose between removing the material defined within the profile, which is the application's default behavior, 

or the material surrounding the profile. 

●     The Reverse Direction option allows you to invert the direction of the extrusion pointed by the arrow.

3.  Click OK in the Cutout Definition dialog box.

The cutout is created. 

Several end limit types are available: 

●     Up to next: the limit is the first face the application detects while extruding the profile. This face must stops the whole extrusion, not only a 

portion of it, and the hole goes through material.

●     Up to last: the last face encountered by the extrusion is going to limit the cutout.

●     Dimension: the cutout depth is defined by the specified value.

4.  In the specification tree, double click on Cut Out.1 to display the Cutout Definition dialog box.

5.  Click More>> to display the maximum information.



Here the Cutout's impacted skin is set to Default, that is, the surface on which lies Sketch.3

6.  Click on  and select the support for the cutout.

The Support Selection dialog box is displayed.

7.  Select Wall.1 as your new support for the cutout.

Should you want to perform a cutout on the opening line (unfold reference) of a rolled wall or a hopper, you must select the rolled wall or the 
hopper feature as the support for the cutout.

8.  Close the Support Selection dialog box and click OK in the Cutout Definition dialog box.

The cutout is created on Wall.1. 

Specifying the support for the cutout avoid confusions in case of overlaps

For instance, if you try to create a cutout on the part below, the following message is displayed:

To avoid this, you have to select the exact support for the cutout.



●     When Lying on skin is checked, 
❍     The End limit and Start limit types are automatically disabled,

❍     The Depth field is disabled,

❍     The skin to be impacted is displayed on the part.

The cutout is not projected anymore on the skin. It is based on a sketch that inevitably lies on a surface.

This option is available only when creating a standard cutout.

In case the prism resulting from the cutout's profile and direction is tangent to the impacted skin, the projection is non-valid and the cutout cannot 
be created.

To avoid this, check Lying on skin or select a wall as support to be able to create your cutout.

 

Pocket cutout

Open the NEWCutout1.CATPart document again.

1.  Click the Cutout icon .

2.  Select Sheetmetal pocket as Cutout type in the combo 

box.

The skin to be impacted remains grey and the End limit type 

is disabled.

3.  Set the Depth to 1mm.

4.  Select Sketch.3 as profile.

A preview of the cutout is displayed. In our example, the 

cutout will impact only half the wall.
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5.  Click OK in the Cutout Definition dialog box.

The cutout is created. 

 

6.  In the specification tree, double click on Cut Out.1 to display the Cutout Definition dialog box.

7.  Click More>> to display the maximum information.

The Direction is already selected (Sketch.3). By default, it is set as 

normal to the profile.

 

8.  Uncheck Normal to profile.

9.  Click inside the Reference field to activate it. 

10.  Select Line.1 to perform a cutout normal to the line direction. 

 

Should you need to create a line, right-click on the Reference field and select Create Line.



Refer to Creating Lines for further information.

11.  Click OK to create the cutout normal to the line direction.

 

●     The pocket cutout can be created only on a planar and single support surface (i.e. a wall or the planar face of a flange). Therefore, if the 
profile of the cutout is to impact several supports, use the sheetmetal standard type instead.

●     May you want to create a cutout on an overlapping element or a bend with radius=0, either choose the top skin of the element (as shown in 
the picture above), or unfold the part to create the cutout.

●     You cannot create a pocket cutout on a surface flange.

●     You cannot create 
❍     a standard cutout on a pocket cutout 

❍     a standard cutout or any other feature built by thickening on a pocket cutout.

●     You can create
❍     a pocket cutout on a standard cutout;

 

❍     a pocket cutout on a stamp;
 



❍     a pocket cutout on a pocket cutout.

 

 

You can use the Catalog icon  to open the Catalog Browser.

●     Refer to the Component Catalog Editor User's Guide for further information on how to use catalogs.

●     Refer to the Create a Pocket task in the Part Design User's Guide for further details on how to create cutouts.
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Stamping
This section explains and illustrates how to create and use various kinds of stamps.

●     Stamps must be created on walls, or walls on edge, except for the stiffness rib that is to be created on 
a bend. 

●     If a stamp is created over the limit between several supports, such as walls, bends, and so forth, this 
stamp is not visible on the unfolded view.

●     When unfolding a part, only the largest imprint of the stamp is retained on the stamped wall.

●     Stamps cannot be created on an unfolded part.

Creating Standard Stamping Features
Recognizing Stamping Features

Creating User-Defined Stamping Features
 



Creating Standard Stamping Features
 

This section explains and illustrates how to create and use various kinds of stamps.
The table below lists the information you will find.

Create a flanged hole: select a point on a face, and set the stamping parameters. 

Create a bead: select a profile, and set the stamping parameters. 

Create a circular stamp: select a point on a face, and set the stamping parameters. 

Create a surface stamp: select a sketch, and set the stamping parameters. 

Create a bridge: select a point on a face, set the stamping parameters, and select an edge to give the 
bridge orientation. 
Create a flanged cutout: select a profile, and set the stamping parameters. 

Create a stiffening rib: select the external surface of a bend, and set the stamping parameters. 

Create a curve stamp: select a sketch, and set the stamping parameters. 

Create a louver: select a sketch, an opening line and set the stamping parameters. 

Create a dowel: select a point on a face, and set the stamping parameters.



Creating a Flanged Hole

This task shows you how to create a flanged hole by specifying the punch geometrical parameters.

For the Generative Sheetmetal Design workbench, open the NEWStamping.CATPart document.
For the Aerospace SheetMetal Design workbench, open the Aero_Stamping.CATPart document.

1.  Click the Flanged Hole icon .

2.  Click the surface where you want to place the hole.

A grid  is displayed to help you position the flanged hole.

The Flanged Hole Definition dialog box is displayed, providing default values. 
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Note that the image in the right-hand pane of the dialog box is updated as you choose your 

parameters and options, and provides a graphical explanation about the current selection.

Also note that the options available in the dialog box are updated according to the items selected 

in the Definition Type area.

3.  If you want to use a standard, click the Standard File button and browse to select a standard file. 

In this case, the standard parameters will be used, and you do not need to (and cannot) specify 

the definition type, flanged hole parameters and/or flat pattern diameter (depending on what 

exactly is specified in the standard file); go directly to step 8.

❍     The parameters that are driven by the standard table cannot be modified. 

❍     For more information on standard files, refer to Editing the Sheet and Tool Parameters, 
and to Customizing Standard Files to Define Design Tables in the Customizing chapter of 
this user's guide.

For the purpose of this scenario, do not select a standard file, and proceed with step 4.

4.  Choose the diameter that should be dimensioned from the Parameters choice list:

❍     Major Diameter



❍     Minor Diameter

❍     Two Diameters (major and minor diameters)

❍     Punch & Die

5.  Specify whether the flanged hole should be created without a cone (i.e. only with the filleted 

portion of the flanged hole) or with a cone (i.e. with the filleted portion of the flanged hole and 

with a cone). 

Note that selecting the Without cone option has the following consequences:

❍     The Height H field is disabled, the height being automatically computed in this case.

❍     Deactivating the Radius field is impossible, because the radius value for the flanged hole 

external curvature must be specified in this case.

6.  Choose the flanged hole parameters:

❍     In the Height H field, specify the height value for the flanged hole. Use the icon next to the 

field to specify the reference from which the height is defined:  or .

❍     In the Radius R field, specify the radius value for the flanged hole external curvature. Use the 

icon next to the field to disable this option.

❍     In the Angle A field, specify the angle value for the flanged hole. 

This option is not available for the Two Diameters or Punch & Die parameters, as the angle 

is automatically computed in these cases.

❍     In the Diameter D field, specify the major diameter value for the flanged hole. 

This option is not available for the Minor Diameter parameter, as the major diameter is 

automatically computed in this case.

❍     In the Diameter d field, specify the minor diameter value for the flanged hole.

This option is not available for the Major Diameter parameter, as the minor diameter is 

automatically computed in this case.



7.  Choose the flat pattern diameter:

❍     K factor: uses the K Factor to compute the flat pattern diameter.

❍     Flat diameter: lets you set your own flat pattern diameter. If you select this option, you must 

enter a value in the associated field.

❍     Make sure that the flat pattern diameter does not exceed the flanged hole external 
contour. Otherwise, it will be impossible to create the flanged hole.

❍     Flanged holes that were created prior to R16, without the flat pattern diameter specified, 
do not inherit from this functionality. In this case, to specify the flat pattern diameter, 
you need to delete and create the flanged hole again.

❍     If you want to be able to perform any operation (like a cutout) on a flanged hole, you 
need to use the K factor option.

8.  Click Preview to visualize the flanged hole.

9.  Click OK to validate. 

10.  The flanged hole (identified as Flanged Hole.xxx) is created and the specification tree is updated 

accordingly.



Flanged hole viewed from the front

Flanged hole viewed from the back



Creating a Bead

This task shows you how to create a bead, that is a local deformation in the web.

If you use the Generative Sheetmetal Design workbench, open the NEWStamping6.CATPart document.
If you use the Aerospace SheetMetal Design workbench, open the Aero_Stamping6.CATPart document.

1.  Click the Bead icon .

2.  Select the spine 

profile where you 

want to place the 

bead.

The Bead 

definition dialog 

box is displayed, 

providing default 

values.

3.  Change the value in the different fields, if needed:

●     Section Radius R1 (corresponding to the cross section value)

●     End Radius R2

●     Height H

●     Radius R

The Profile is automatically set to the sketch you chose.
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The vector for the direction 
of the bead is shown in the 
model and a preview of the 
bead appears and a vector 
shows its direction.

4.  Click Preview to visualize the bead.

5.  Click OK to validate.

The bead (identified as Bead.xxx) is created and the specification tree is updated accordingly.

The vector cannot be reverted until the bead spine is defined.

You can use 0 as the Radius value to deactivate the Radius R value, and to create the bead without a 
fillet.

●     You can also create a bead using a 3D curve such as shown here:



 

 
●     Refer to the Customizing Standard Files chapter for information on defining the Standards Files.

 



Creating a Circular Stamp 

This task shows you how to create a circular stamp by specifying the punch geometrical parameters.

Open the NEWStamping.CATPart document from the samples directory.
If you use the Aerospace SheetMetal Design workbench, open the Aero_Stamping.CATPart document.
 

1.  Click the Circular Stamp icon .

2.  Click the surface where you want to place the circular 

stamp. 

A grid is displayed to help you position the circular 
stamp.

The Circular Stamp Definition dialog box opens, providing default values.

3.  Choose the diameter that should be dimensioned from the 

Parameters choice list:

❍     Major Diameter

❍     Minor Diameter

❍     Two Diameters (major and minor diameters)

❍     Punch & Die

4.  Change the value in the different fields, if needed:

●     Height H: use the icon next to the field to 

specify the reference from which the height is 

defined:  or .

●     Radius R1

●     Radius R2

●     Angle A

●     Diameter D
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4.  Click Preview to visualize the circular stamp.

 
5.  Click OK to validate.

The circular stamp (identified as Circular Stamp.xxx) is created and the specification tree is updated accordingly.

 

To create the point stamp without a fillet, unselect the Radius 
R1 and Radius R2 checkbox in the Circular Stamp Definition 
dialog box.

Please refer to the Customizing Standard Files chapter to define the Standards Files.



Creating a Surface Stamp 

This task shows you how to create a surface stamp by specifying the various geometrical parameters of the punch:

 
●     Creating a Surface Stamp

❍     without fillets

❍     with a limiting plane

❍     with opening edges

❍     inserting a profile from a catalog

●     Creating a stamp based on a multi contour profile

❍     applying parameters to the top of the surface stamp

❍     applying parameters to the bottom of the surface stamp

●     Creating a stamp based on a punch and die profile

●     Creating a stamp based on a 3D curve

●     Creating a two profile stamp 

 

Creating a Surface Stamp
Open the NEWStamping4.CATPart document from the samples directory.

If you use the Aerospace SheetMetal Design workbench, open the Aero_Stamping4.CATPart document.

1.  Click the Surface Stamp icon .

The Surface Stamp Definition dialog box opens, providing default values. 
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2.  In the specification tree, select Sketch-for-Surface-Stamp, the profile previously defined. 

3.  Change the value in the different fields, if needed.

In our example, we chose the following values:

●     Angle A: 90deg

●     Height H: 15mm

●     Radius R1: 2mm

●     Radius R2: 2mm

The surface stamp is previewed.

 

4.  Click Preview to compute the surface stamp.

5.  Click OK to validate.

The surface stamp (identified as Surface Stamp.1) is created and the specification tree is updated accordingly.

Creating a Surface Stamp without Fillets
By default, Radius R1, Radius R2 and Rounded Die are activated.
This means that all edges of the surface stamp are filleted.



 

 
●     Rounded Die lets you create a surface stamp which die's edges are all filleted.

If you click to clear the Rounded Die check box, the surface stamp should look as shown below.

 

●     The Radius R2 lets you create fillets on the surface stamp's bottom.

If you click to clear the Radius R2 check box, the Rounded Die check box is automatically cleared as well and the surface stamp should look as shown 
below.

 

 
●     The Radius R1 lets you create fillets on the surface stamp's top.

If you click to clear the Radius R1 check box but keep Radius R2 and Rounded die selected, the surface stamp should look as shown below.



 

 You can also disable Radius R1 and Radius R2 if you want to create the surface stamp without a fillet.

 

 

Creating a Surface Stamp with a Limiting Plane

1.  Double-click Surface Stamp.1 in the specification tree to edit it.

2.  In the Surface Stamp Definition dialog box, right-click in the Limit field.

3.  In the contextual menu, select Create Plane.

The Plane Definition dialog box is displayed.

4.  Select the xy plane in the specification tree as reference.

The offset from the plane and its direction is previewed.

●     To be able to use a limiting plane for a stamp, the profile of the stamp must be based on a sketch.

●     The limiting plane has to be parallel to the sketch plane. If not, an error message is displayed.

5.  Use the up and down arrows to change the offset value.

In our scenario, we selected an offset of 25mm.

 



6.  If needed, click Reverse Direction to change the offset direction.

7.  Click OK to close the Plane Definition dialog box.

The stamp based on the limiting plane is previewed.

 

Should you need to delete or edit the plane you previously selected, right-click the Limit field and select the appropriate item in the contextual menu.

 

 
For more information on planes, refer to Creating Planes in Generative Shape Design User's Guide.

You will note that the Height field is deactivated. This is due to the fact that the height of the stamp is now based on the distance between the stamping 
point and the plane which is coincident with the external face of the stamp.



 
8.  Click Preview to compute the surface stamp.

9.  Click OK to close the Surface Stamp Definition dialog box.

The stamp is created.

 

 

Creating a Surface Stamp with Opening Edges
 

1.  Double-click Surface Stamp.1 in the specification tree to edit it.

2.  In the Surface Stamp Definition dialog box, click the Opening Edges field to activate it.

3.  On the geometry, select one opening edge as shown below.

 

 
●     You can select several opening edges.

●     If you want to delete your selection, right-click on the Opening Edges field and select Clear Selection in the contextual menu.

 



 Should you need to modify the opening edges:
●     right-click on the Opening Edges field and select Elements list in the contextual menu and use the Remove or Replace button to change your 

selection.
or

●     click the icon at the right of the field, then use the Remove or Replace button to change your selection.

 

 
4.  Click Preview to compute the surface stamp.

5.  Click OK to create the stamp with opening edges.

 

 

Inserting a Profile from a Catalog
 

1.  Click the Surface Stamp icon .

The Surface Stamp Definition dialog box opens, providing default values. 

2.  Change the value in the different fields, if needed.

In our example, we chose the following values:

●     Angle A: 90deg

●     Height H: 10mm

●     Radius R1: 1mm

●     Radius R2: 1mm



 

3.  Click the catalog icon  to select a stamp feature from the catalog.

The Catalog Browser dialog box is displayed.

 
4.  If needed, browse to the directory where the stamp catalog is filed.

In our example we selected Aero_Sheetmetal_Cutouts catalog.

 

 
5.  Double-click on UserFeature_family.

 

 
The features available in the catalog are displayed.  

 



 
6.  Select Slot_Contour and click OK to close the catalog browser.

 
7.  On the geometry, select the inputs needed to insert the feature:

●     Use Wall.1 or Web.1 as Reference plane;

●     Use Point.1 as Reference point;

●     Use an edge of Wall.1 or Web.1 as Reference axis.

 

 
8.  Click OK to insert the feature.



 

 
9.  Click Preview to compute the surface stamp.

10.  Click OK again to create the stamp.

 

Creating a Stamp Based on a Multi Contour Profile
 

Applying parameters to the top of the surface stamp

1.  Click the Surface Stamp icon .

2.  In the specification tree, select Sketch-multicontour-type1

The Surface Stamp Definition dialog box opens.

3.  Select Angle as Definition type and the first type of stamp .



4.  Change the value in the different fields, if needed.

In our example, we chose the following values:

●     Angle A: 90deg

●     Height H: 10mm

●     Radius R1: 2mm

●     Radius R2: 2mm

The surface stamp is previewed.

 

5.  Click Preview to compute the surface stamp.

6.  Click OK to validate.

The surface stamp with several inner contour (identified as Surface Stamp.2) is created and the specification tree is updated accordingly.

Applying parameters to the bottom of the surface stamp

1.  Click the Surface Stamp icon .

2.  In the specification tree, select Sketch-multicontour-type2

The Surface Stamp Definition dialog box opens. 

3.  Select Angle as Definition type and the second type of stamp 



4.  Change the value in the different fields, if needed.

In our example, we chose the following values:

●     Angle A: 60deg

●     Height H: 13mm

●     Radius R1: disabled

●     Radius R2: disabled

The surface stamp is previewed.

 

5.  Click Preview to compute the surface stamp.

6.  Click OK to validate.

The surface stamp with several inner contour (identified as Surface Stamp.3) is created and the specification tree is updated accordingly.

Creating a Stamp Based on a Punch and Die Profile

1.  Click the Surface Stamp icon .

2.  In the Surface Stamp Definition dialog box, select Punch and Die as Definition type.



 

 
2.  In the specification tree, select Sketch-punch&die

The Surface Stamp Definition dialog box opens. 

3.  Change the value in the different fields, if needed.

In our example, we chose the following values:

●     Height H: 13mm

●     Radius R1: disabled

●     Radius R2: disabled

A light preview is displayed.

 



5.  Click Preview to compute the surface stamp.

6.  Click OK to validate.

The surface stamp with two contours (identified as Surface Stamp.4) is created and the specification tree is updated accordingly.

 

Each punch edge must be parallel to the corresponding die edge.

 



 

Creating a Stamp Based on a 3D Curve
 

1.  Open the NewStamping12.CATPart document. If you use the Aerospace SheetMetal Design workbench, open the Aero_Stamping12.CATPart 

document.

The part contains a simple 3D curve profile and a 3D multicurve profile.

2.  Click the Surface Stamp icon .

3.  In the specification tree, select Folded curve.2.

The Surface Stamp Definition dialog box opens.

4.  Select Angle as Definition type and the first type of stamp .

5.  Change the value in the different fields, if needed.

In our example, we chose the following values:

●     Angle A: 90deg

●     Height H: 6mm

●     Radius R1: 2mm

●     Radius R2: 2mm

6.  Click Preview to compute the surface stamp, then click OK to validate.
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7.  Click the Surface Stamp icon .

8.  Select Angle as Definition type and the first type of stamp .

9.  Change the value in the different fields, if needed.

In our example, we chose the following values:

●     Angle A: 90deg

●     Height H: 6mm

●     Radius R1: 2mm

●     Radius R2: 2mm

10.  Click Preview to compute the surface stamp, then click OK to validate.

 

 

Creating a Two Profile Stamp
 

1.  Open the NewStamping9.CATPart document.

2.  Click the Surface Stamp icon .

3.  In the Surface Stamp Definition dialog box, select Two Profiles as Definition type.
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4.  Check to deactivate Rounded Die.

5.  In the specification tree, select Sketch.2 as first profile and Sketch.3 as second profile.

If you want to define the internal part of the stamp, use the Inner type .

If you want to define the external part of the stamp, user  the Outer type .

 
6.  Click Preview to compute the stamp.

You are warned that the stamp cannot be built.

 
 

7.  Start coupling sketches together selecting points.

You should end up with six couplings.



 

 Once the coupling is done, the stamp can be computed and is previewed.

 

 
7.  Click OK to create the stamp.

 



Avoid as much as possible a coincidence between the edge of the sketch profile and the edge of the base feature. Instead, let the sketch profile exceed 
the edge of the wall.

●     Should you need to create Half pierce stamps, refer to the Creating a Half Pierce Stamp section.

●     Refer to the Customizing Standard Files chapter for more information about defining the Standards Files.

 



Creating a Bridge

This task shows you how to create a bridge by specifying the punch geometrical parameters.

Open the NEWStamping5.CATPart document from the samples directory.

1.  Click the Bridge icon .

2.  Select a point on the top face where you want to place the bridge.

The Bridge Definition dialog box opens, providing default values. 

3.  Change the value in the different fields, if 

needed:

●     Height H

●     Radius R1

●     Radius R2

●     Angle A

●     Length L1

●     Length L2

4.  Select an edge to give the direction of the bridge.
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5.  Click Preview to visualize the bridge.

 
6.  Click OK to validate.

The bridge (identified as Bridge.xxx) is created and the specification tree is updated accordingly.

 

You can use 0 as the Radius value to deactivate the 
Radius R value, and to create the bridge without a fillet.

Please refer to the Customizing Standard Files chapter to define the Standards Files.



Creating a Flanged Cutout 

This task shows you how to create a flanged cutout by specifying the punch geometrical parameters.

Open the NEWStamping8.CATPart document.
If you use the Aerospace SheetMetal Design workbench, open the Aero_Stamping8.CATPart document.

1.  Click the Flanged Cutout icon . 

2.  Select a profile. 

The Flanged Cutout Definition dialog box is displayed, providing default values.

 

3.  Change the value in the different fields, if needed:

●     Height H

●     Angle A

●     Radius R

file:///E|/www/lgkr16/Doc/online/cfysm_C2/samples/NEWStamping8.CATPart
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4.  Click Preview to visualize the flanged cutout. 

 

 
5.  Click OK to validate. 

The flanged cutout (identified as Flanged Cutout.xxx) is created and the specification tree is updated 

accordingly.

 



 

You can use 0 as the Radius value to deactivate the Radius R value, and to create the flanged cutout 
without a fillet.

 

 Note that if you create a flanged cutout from a sketch that is not tangent continuous, you cannot design 
any other feature on it (such as bend, cutout, hole).

Please refer to the Customizing Standard Files chapter to define the Standards Files.



Creating a Stiffening Rib 

This task shows you how to create a stiffness rib by specifying the punch geometrical parameters.

Open the NEWStamping7.CATPart document from the samples directory.

 If you use the Aerospace SheetMetal Design workbench, open the Aero_Stamping7.CATPart document.

1.  Click the Stiffening Rib icon .

2.  Select the external surface of Flange.1, where you want to place a stiffener.

Note that the stiffener will always be centered on the bend radius, wherever the point may be along the curve.

A grid is displayed.

The Stiffening Rib Definition dialog box opens, providing default  values.

3.  Change the value in the different fields, if 

needed:

●     Length L

●     Radius R1

●     Radius R2

●     Angle A

4.  Click Preview to visualize the stiffness rib.

5.  Click OK to validate.

The stiffening rib (identified as Stiffnening Rib.xxx) is created and the specification tree is updated accordingly.
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You can use 0 as the Radius value to deactivate the 
Radius R1 value, and to create the stiffening rib 
without a fillet.

Please refer to the Customizing Standard Files chapter to define the Standards Files.



Creating a Curve Stamp 

This task shows you how to create a curve stamp by specifying the punch geometrical parameters.

Open the NEWStamping3.CATPart document.
If you use the Aerospace SheetMetal Design workbench, open the Aero_Stamping3.CATPart document.

1.  Click the Curve Stamp icon .

2.  Select Sketch-for-Curve-Stamp, the curve previously defined. 

The Curve Stamp Definition dialog box opens, providing default values.

3.  Change the value in the different 

fields, if needed:

●     Height H: the total height

●     Radius R1: the outer bend 

radius

●     Radius R2: the inner bend 

radius

●     Angle A: the stamping draft 

angle 

●     Length L: the stamps' 

maximum width

4.  Click Preview to visualize the 

curve stamp.

5.  Click OK to validate.

The curve stamp (identified as Curve Stamp.xxx) is created and the specification tree is updated accordingly.
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●     You can use 0 as the Radius value to 
deactivate the Radius R and Radius R2 
values, and to create the curve stamp 
without a fillet.

●     Check the Obround option to round off the edges of the curve stamp.

 

Obround option checked Obround option unchecked

Please refer to the Customizing Standard Files chapter to define the Standards Files.

 



Creating a Louver 

This task shows you how to create a louver by specifying the punch geometrical parameters.

Open the NEWStamping11.CATPart document.

1.  Click the Louver icon .

2.  Select Sketch-for-Louver, a profile previously defined on Wall.2. The Louver Definition dialog box opens, providing default values.

The louver opening face is represented in the sketch by the element that does not present any tangency continuity with the other lines/curve 
segments of the sketch. In case there are several non-continuous elements, the first one is used as the opening face.

3.  Change the value in the different fields, if needed:

●     Height H

●     Radius R1

●     Radius R2

●     Angle A1

●     Angle A2

4.  Select an edge of the sketch as the Opening Line: it indicates the position of the opening face of the louver.

5.  Click Preview to visualize the louver.

6.  Click OK to validate.

The louver (identified as Louver.xxx) is created and the specification tree is updated accordingly.

file:///E|/www/lgkr16/Doc/online/cfysm_C2/samples/NEWStamping11.CATPart


 



Creating a Half Pierce Stamp

This task shows you how to create a half pierce stamp by specifying the punch geometrical parameters.

Open the NEWStamping4.CATPart document from the samples directory.

If you use the Aerospace SheetMetal Design workbench, open the Aero_Stamping4.CATPart document.

1.  Click the Circular Stamp icon .

The Circular Stamp Definition dialog box is displayed.

2.  Select a point on the top face.

3.  A grid is displayed to help you position the circular stamp.

4.  Check the Half-pierce box

5.  Change the value in the different fields, if needed:

file:///E|/www/lgkr16/Doc/online/cfysm_C2/samples/NEWStamping4.CATPart
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❍     In the Height H field, specify the height value for the half-pierce circular stamp. Use the icon 

next to the field to specify the reference from which the height is defined:  or .

❍     In the Diameter D field, specify the major diameter value for the half-pierce circular stamp. 

By default, the angle is of 90 degrees.

 6.  Click on Preview to display the Half 

Pierce Circular Stamp.

 

 7.  Click OK to validate.

In the Specification tree Half Pierce (Circular).1 is created.

The Half-pierce check box is also available on the Surface Stamp Definition and the Curve Stamp 
Definition dialog boxes.

 

You cannot create a cutout that is to overlap the half pierce stamp. Yet, you can create a cutout on the 
bottom of a half pierce stamp. 



 

 



Creating a Dowel  

This task shows you how to create a dowel by specifying the punch geometrical parameters.

Open the NEWStamping.CATPart document from the samples directory.

 

1.  Click the Dowel icon .

2.  Click the surface where you want to place the dowel.

A grid is displayed to help you position the dowel.

 

 

 
The Dowel definition dialog box is displayed, providing default values.

 

 
3.  Use the up and down arrows to change the diameter value.

In our example we chose a value of 20mm.

The dowel's diameter is updated accordingly.
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4.  Should you need to change the position of the dowel on the surface, click the Positioning Sketch icon .

The Sketcher workbench opens and a point representing the dowel's position is displayed on the surface.

 

 
5.  Move the dowel on the surface according to your needs.

 

 
6.  Exit the Sketcher workbench.

The dowel is positioned according to your settings. 

 



 
6.  If needed, you can change the dowel's direction by clicking the red arrow. 

 

 
7.  Click Preview to compute the dowel.

8.  Click OK to create the dowel.

The specification tree is updated accordingly.

 

You cannot perform operations on a dowel such as creating a cutout or a stamp.

Refer to the Customizing Standard Files chapter for more information about defining the Standards Files.

 



Recognizing Stamping Features
This task illustrates how to recognize a stamp geometry in order to create a Generative Sheetmetal 
Design stamping feature provided it is on a planar and single support. 

Consequently, the following types of stamps can be recognized:

●     Circular stamp

●     Curve stamp

●     Surface stamp

●     Bead

●     Bridge

●     Louver

The recognize feature enables to create a Generative Sheetmetal Design stamping feature from a V4 
model or parts created with Sheetmetal Design.

 
The Part Feature Recognition license is required to activate this feature in the Generative Sheetmetal 
Design Workbench. 

Open the NEWRecognize03.CATPart document. This document contains a part created from a V4 model.

1.  Click the Recognize icon . The Recognize Definition dialog box is displayed. 
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Note that the With Wall recognition option is already selected, and grayed out. This is because at least 

walls will be recognized, regardless of the other options you may choose.

2.  Select a reference face. It will be the reference face for unfolding and for the definition of the 

sheet metal parameters (i.e. all default parameters will be based on this face).

 

3.  Select With stamps recognition and manually select all the faces to be recognized as stamps.



4.  Select the reference face as a face to be recognized as wall.

5.  Click OK to validate. 

The stamps are generated from the geometry. 

The Recognize.1 feature is added to the tree view. 
At the same time, the sheet metal parameters are created, deduced from the Part geometry.



6.  Select the Sheet Metal Parameters icon  to display the sheet metal parameters.

On the Parameters tab:

●     the Thickness is equal to 1.5mm,

●     the Default Bend Radius value amounts to twice that of the thickness.

On the Bend Extremities tab:

●     the bend extremities are set to Minimum with no relief.

You can modify a few of these parameters. The Thickness parameter cannot be modified because it is 

based, like the bend extremities and radius, on the initial solid geometry. However, you can modify other 

parameters (default bend radius and bend extremities) in order for them to be taken into account for 

sheet metal features other than the "recognized" ones.

The bend allowance, being used to unfold the part, and the bend corner relief affect all features, and 

therefore can be edited even for "recognized" features.

 



You can also define the sheet metal parameters prior to recognizing the part. In this case, you need to 
make sure that the Thickness parameter value corresponds to the part thickness.

7.  When all parameters have been redefined as needed, click OK in the Sheet Metal Parameters 

dialog box.

The solid is now a Generative Sheetmetal Design part. You can now deal with it as with any other 

Generative Sheetmetal Design part, adding Generative Sheetmetal Design features to complete 

the design, or unfolding it.

●     There is no stiffening rib recognition, since the support feature for the stamp must be planar.

●     Stamps containing inner contours such as flanged hole, flanged cutout cannot be recognized.

●     Sharp stamps are not recognized.



Creating User-Defined Stamping Features
Two user-defined stamping features are available: 

 Create a punch with a die:  define the punch and die features, select a wall, choose the punch and die as stamping elements, select 
an edge on the wall and give an angle for orientation purposes.

 Create a punch with opening faces:  define the punch, select a wall, define the opening faces of the punch, select an edge on the wall 
and give an angle for orientation purposes.

 Edit a user-defined stamp: double-click the existing stamp and change its type, or select, or remove cutting and opening faces

What You Should Know 

In both tasks illustrating either a stamp based on a punch and a die, or a punch with cutting and opening faces, the punch positioning is 
defined as below: 

Defining the Punch in Relation to the Wall to be Stamped

The punch is defined within the absolute (default) axis-
system of the .CATPart document. (o, x, y, z) is the 
axis associated with the punch. The punching direction 
on the punch (Dp) must be equal to z.

The punching direction on the wall (Dw) is normal to 
the selected wall face, and is oriented from the selected 
wall face towards the opposite face.

The punch is applied matching Dp on Dw and matching the punch's (x, y) plane onto the selected wall face:



Defining the Die in Relation to the Wall to be Stamped

This is useful only when defining a punch a die, and does not apply to punches with cutting and opening faces.

The die is also defined within the absolute (default) axis-
system of the .CATPart document. (o, x, y, z) is the 
axis associated with the punch. The punching direction 
on the die (Dd) must be equal to z. 

The illustration is a section view of the die.

The die is applied matching Dd on Dw and matching the die's (x, y) plane onto the selected wall face:

 



Creating a Punch with a Die
This task explains how to create a stamp from punch and die features. 

First, you will define a punch and a die in Part Design, in the absolute axis-system.
Then, in a Sheet Metal part, you will bring the punch and the die features (and their axis system) to a point you have 
selected. If necessary, you will define a rotation of the axis system from a reference line.

This user-defined stamping cannot be combined with the Opening and Cutting Faces approach.

All .CATParts are available from the samples directory (PunchDie1.CATPart, Punch1.CATPart and Die1.CATPart or 
NEWPunchDie1.CATPart, NEWPunch1.CATPart and NEWDie1.CATPart for Generative Sheetmetal Design or 
Aero_PunchDie1.CATPart, Aero_Punch1.CATPart and Aero_Die1.CATPart for Aerospace Sheetmetal Design).

 

Creating Stamps
1.  Start the Part Design workbench.

2.  Insert a body (menu Insert -> Body) to define the punch.

3.  Enter the sketcher  select the yz plane, 

and draw the profile of the punch, and a 

rotation shaft.

 

The punch must be oriented as described 
in Defining the Punch in Relation to the 
base feature to be Stamped in the Creating 
User-Defined Stamping Features chapter.

4.  Return to the 3D space and create the punch 

using the Shaft icon .
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5.  Repeat from step 2 to step 4 to define the die, making sure that it is oriented as described in Defining the Die in 

Relation to the base feature to be Stamped in the Creating User-Defined Stamping Features chapter.

6.  Return to the Sheet Metal application, and if needed, use the Define In Work Object on the PartBody containing 

the wall or the base feature to be stamped.

7.  Click the User Stamping icon  from the Stamping tool bar and select a base feature, or a face where the 

stamping is to be created. 

This base feature or face is used to define the stamping location and direction, by matching the punch's origin to 

the selected point on the base feature.

The User Defined Stamp Definition dialog box is displayed:



8.  Make sure the With die  icon is pressed down and select the Punch feature from the specification tree.

The punch's positioning is previewed in the geometry.



9.  Select the Die feature. 

The die's positioning is previewed in the geometry as well.

10.  Check the No Fillet button is you do not wish the stamp to be filleted, or set the radius value if you wish the stamp 

to be filleted. 

Stamp without fillet Stamp with fillet



11.  If needed, define the stamp's positioning on the selected base feature by choosing:

●     a Reference for rotation: by default, it is the sketch axis, but you can also select any line or edge on base 

feature.

●     a Rotation angle value: you can either enter a value in the dialog box, or use the manipulator in the 

geometry to define this value.

●     a new Origin point on the base feature to coincide with the punch's point of origin.

This is especially useful for non-circular stamps, but you can very well create the stamp as is, without further 
positioning.

12.  If needed, select the On Context check box (in the Generative Sheetmetal Design workbench only).

The punch and die's positioning is previewed on the geometry.

 

When selecting the On Context check box, the stamp's positioning and direction are not defined in relation to the base 
feature anymore.

Only the punch and die's axis system is taken into account and the stamp is created according to their positioning and 
direction. 
Once On Context is selected, the position on wall cannot be modified nor the direction of the stamp: the fields available in 
Position on wall section and the Reverse direction button are disabled.

13.  Click OK to validate and create the stamping.

By default the Punch and Die parts are set in No Show mode when clicking OK to create the stamp on the base 

feature. 



●     Radius is the radius of the bend between the stamping and the base feature.

●     Punch and Die are the bodies you have defined previously. If the punch and the die are in another CATPart document, 
activate this document before clicking the punch or the die.

●     If you select two reference lines in addition to the plane, this will create two editable constraints to position the 
stamping. These constraints are editable.

 
●     A user-defined stamping can be edited (punch, die, position, constraints).

●     As the punch and die are not symmetrical, you cannot create such features as a cutout, a hole, a corner, etc., on this 
kind of stamping.



●     If you enter a punch and a die, the stamping is the difference of the shape of both features.

 

●     The punch height cannot be superior to the base feature height, otherwise it is considered as a cutout.

●     You may create a user-defined stamping from a 
punch only but you cannot create a fillet.  

 

●     Only the stamping sketch is displayed in unfolded 
views.

 

●     The punch and die bodies can be defined in the Sheet Metal part where the stamping is to be created (see 
PunchDie1.CATPart or NEWPunchDie1.CATPart in the samples directory).

In this case, make sure you select the Define In Work Object on the PartBody containing the base feature to 
be stamped, prior to actually creating the stamp.

or as two separate Part Design parts (Punch1.CATPart and Die1.CATPart from the samples directory)
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In this case, when selecting the punch or die feature, the system automatically copies this feature into the .CATPart 
document into which the base feature to be stamped is located.
A link is retained between the initial punch or die feature and its copy.

 

Inserting Punch and Die features From The Catalog
Open the NEWstamping_catalog.CATPart document.

All .CATParts and catalog are available from the sample directory (Die.CATPart, Punch.CATPart, 
UserStamp_Catalog.catalog).

1.  Select the face of the part where the stamping is to be created.

2.  Click the User Stamping icon  from the Stamping toolbar to open the User-Defined Stamp Definition dialog 

box.

3.  Click on the With die  icon.
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4.  Click on the catalog icon  to select a Punch feature from the catalog.

The Catalog Browser dialog box is displayed.

5.  Browse to the directory where UserStamp_Catalog.catalog is filed.

file:///E|/www/lgkr16/Doc/online/cfysm_C2/samples/UserStamp_Catalog.catalog


6.  Double click on chapter UserStamp.

The parts saved in the catalog are displayed.

 

7.  Select the Punch, then click on OK.



The body of this punch is aggregated under the part in the specification tree. It is referenced in the User-defined 

Stamp Definition dialog box as Result of Punch.



 

8.  Select the Die field to activate it.

9.  Click on the catalog icon  to select a Die feature from the catalog.

The Catalog Browser dialog box is displayed.

10.  Browse to the directory where UserStamp_Catalog.catalog is filed.

11.  Double click on chapter UserStamp.

12.  Select the Die to select it then click on OK.
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The body of this die is aggregated under the part in the specification tree. It is referenced in the User-defined 

Stamp Definition dialog box as Result of Die.



A punch and a die are now available for you to create a user-stamp.

13.  Click on OK to create your stamp.

 

●     To insert a feature from the catalog, the appropriate field has to be selected first in the User-defined Stamp Definition 
dialog box. 

●     When creating a stamp from a catalog's feature, the Position on context option is deactivated. This is due to the fact 
that the stamping feature of the catalog was previously defined in its own axis-system. The part's canonic axis-system 
and the catalog's being different, there is no reason to use the option.
Yet, when editing a user-stamp created from a catalog's features or using a body imported from another user-stamp, 
the option is activated.

You cannot instantiate a Power Copy from a catalog, only parts. 

 



Creating a Punch with Opening Faces
This task explains how to create a stamp from a punch feature with opening faces. 

First, you will define a punch in Part Design, in the absolute axis system.
Then, in a Sheet Metal part, you will bring the punch feature (and its axis system) to a point you have selected. If necessary, you will define 
a rotation of the axis system from a reference line.

This user-defined stamping cannot be combined with the Punch with a Die approach.

The CATPart documents are available from the samples directory, NEWOpenFaces1.CATPart for is Generative Sheetmetal Design or 
Aero_OpenFaces1.CATPart for Aerospace Sheetmetal Design.

 

Creating Stamps
1.  Start the Part Design application.

2.  Insert a PartBody (menu Insert -> Body) to define the punch.

3.  Enter the Sketcher workbench , select the yz plane, and draw the profile of the punch.

4.  Return to the 3D space and create the punch using the pad icon  and the fillet icon .

 

The punch must be oriented as described in Defining the Punch in Relation to the base feature to be Stamped in the Creating User-Defined 
Stamping Features chapter.

●     The punch can be defined in the Sheet Metal part where the stamping is to be created or in another part.
In this case, when selecting the punch feature, the system automatically copies it into the .CATPart document into which the base 
feature to be stamped is located.
A link is retained between the initial punch feature and its copy.

5.  Return to the Sheet Metal application, and if needed, use the Define In Work Object on the PartBody containing the base feature 

to be stamped.

6.  Click the User Stamp icon  from the Stamping toolbar and select a base feature where the stamping is to be created. 

This base feature is used to define the stamping location and direction, by matching the punch's origin to the selected point on 

the base feature.

The User Defined Stamp Definition dialog box is displayed.

7.  Click the With opening  icon.
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8.  Select the punch (Body.2). The punch is previewed on the base feature.

 

 
9.  Click the Faces for opening field and select the lateral faces of the punch (Pad.1).

 

 
10.  Click Preview. The stamp is previewed with the opening faces:



 
11.  Select the On Context check box if you wish to position the stamp according to the positioning and direction of the punch and die 

features.

12.  Click Preview. The stamp is previewed with the opening faces at the point where the punch and die were created on the part:

 

For more information about the On context check box, refer to the Creating a Punch with a Die section.

13.  Check No Fillet is you do not wish the stamp to be filleted, or set the radius value if you wish the stamp to be filleted. 

14.  If needed, define the stamp's positioning on the selected base feature by choosing:

●     a Reference for rotation: by default, it is the sketch axis, but you can also select any line or edge on the base feature.

●     a Rotation angle value: you can either enter a value in the dialog box, or use the manipulator in the geometry to define this 

value.

●     a new Origin point on the base feature to coincide with the punch's point of origin.

This is especially useful for non-circular stamps, but you can very well create the stamp as is, without further positioning.

15.  Click OK to validate and create the stamping. 

The punch is automatically set in No Show mode. 



●     Radius is the radius of the bend between the stamping and the base feature.

●     Punch is the body you have defined previously. If the punch is in another .CATPart document, activate this document before clicking the 
punch.

●     The Faces for opening must be picked on the punch, not on the base feature. 
If the punch is located into another .CATPart document, these faces must be picked on the copy of the punch where the base feature to 
be stamped is located.

●     If you modify the selected punch, the user-defined stamp with the opening faces will not be updated accordingly, nor will it be 
updateable. If you want to update the user-defined stamp, you will need to edit it; in the User Defined Stamp Definition dialog box, 
clear the Faces for opening field and re-select the lateral faces of the modified punch.

●     Avoid using stamps with faces merging with the face of the base feature to be stamped, as it would be difficult to remove afterwards, 
especially on a curved part.
If you do use such a stamp, select the stamp face tangent to the base feature and define it as an open face.

●     If you select two reference lines in addition to the plane, this will create two editable constraints to position the stamping. These 
constraints are editable.



 
●     A user-defined stamping can be edited (punch, die, position, constraints).

●     Check the No fillet option to deactivate the Radius R1 value, and to create the stamp without a fillet.

 

Inserting Punch with Opening Faces Feature From The Catalog
Open the NEWstamping_catalog.CATPart document.

The CATPart and the catalog are available from the sample directory (Punch_Open.CATPart, UserStamp_Catalog.catalog).

1.  Click the User Stamping icon  from the Stamping toolbar and select the face of the part where the stamping is to be created.

The User-Defined Stamp Definition dialog box is displayed:

 

2.  Click on the catalog icon  to select a Punch feature from the catalog.

The Catalog Browser dialog box is displayed.

3.  Browse to the directory where UserStamp_Catalog.catalog is filed.
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4.  Double click on chapter UserStamp.

The parts saved in the catalog are displayed.

 

5.  Select the Punch_Open part, then click on OK.



The body of this punch is aggregated under the part in the specification tree. 

 

6.  Select the Faces for opening field to activate it.

7.  Select a face of the punch.

8.  Click on OK to create the stamp.



●     To insert a feature from the catalog, the appropriate field has to be selected first in the User-defined Stamp Definition dialog box. 

●     When creating a stamp from a catalog's feature, the Position on context option is deactivated. This is due to the fact that the 
stamping feature of the catalog was previously defined in its own axis-system. The part's canonic axis-sytem and the catalog's being 
different, there is no reason to use the option.
Yet, when editing a user-stamp created from a catalog's features or using a body imported from another user-stamp, the option is 
activated.

You cannot instantiate a Power Copy from a catalog, only parts. 



Editing User-Defined Stamps

This task explains how to edit a user-defined stamp, that is: 

●     to change its type

●     add or remove cutting and opening faces 

To perform this scenario, you can open any .CATPart document containing a user-defined stamp.

1.  Double-click the existing user-defined stamp from the specification tree.

The User Defined Stamp Definition dialog box is displayed. 



2.  Change stamp type using the icons:

●     If you change from With die to With opening, the Die feature no longer is selected, and you need 

to select Faces for opening.

●     If you change from With opening to With die, the punch faces no longer are selected and you may 

select a die feature if you wish (it is not compulsory).

Basically, only the punch remains selected.
If you are working with a punch with opening faces (With opening option) you may want to add or 
remove some opening faces:

3.  Click in the Faces for opening field then:

●     select a face in the geometry to add it to the already selected opening faces

●     select an already selected face to remove it from the opening faces

●     use the Clear selection contextual menu to remove all opening faces that have been previously 

selected. 

4.  Modify any other parameter as needed.

5.  Click OK in the User Defined Stamp Definition dialog box to take these modifications into account.

The stamp is updated accordingly.

 



Patterning
This section explains and illustrates how to create various kinds of patterns on Sheet Metal parts.

Create rectangular patterns: select the element to be duplicated, set the patterning type, and its 
parameters, and the reference direction
Create circular patterns: select the element to be duplicated, set the axial reference  parameters, the 
reference direction, and possibly the crown definition
Create user-defined patterns: select the element to be duplicated, and the positioning sketch and 
anchor point 

To know more about patterns, refer to the Part Design User's Guide.



Creating Rectangular Patterns
In this task, you are going to create rectangular cutouts according to a pattern.
These features make the creation process easier.

 

 

In the Generative Sheetmetal Design workbench, you can only duplicate flanges, cutouts, holes, mirrors, 
stamps (except stiffening ribs), stamps without fillet (radius=0) and Generative Sheetmetal Design 
patterns.

 These features must lie on a unique and planar wall.
     

For the SheetMetal Design workbench, open the 
RectangularPattern1.CATPart document.
For the Generative Sheetmetal Design workbench, 
open the NEWRectangularPattern1.CATPart 
document.

The Sheet Metal part looks like this:

1.  Select the rectangular cutout you want to 

duplicate.

2.  Click the Rectangular Pattern icon .

The Rectangular Pattern Definition dialog box is displayed. Each tab is dedicated to a 
direction to define the location of the duplicated feature. 
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3.  Set the specification for the First Direction 

by selecting the first edge (Edge.1) as 

shown, to specify the first direction of 

creation.

An arrow is displayed on the wall. 

The Reverse button enables to modify 

the direction.

You can also click the arrow in the 3D 

geometry.

4.  Keep the Instances & Spacing options to 

define the parameters.

Choosing these parameters types dims the 

Length field because the application no 

longer needs this specification to space the 

instances.

You can set the duplication parameters by choosing the number of instances, the spacing between 
instances, or the total length of the zone filled with instances.
Three options are available: 

●     Instances & Length: the spacing between instances is automatically computed based on 

the number of instances and the specified total length

●     Instances & Spacing: the total length is automatically computed based on the number of 

instances and the specified spacing value

●     Spacing & Length: the number of instances is automatically computed to fit the other two 

parameters.

For each of these cases only two fields are active, allowing you to define the correct value.

If you set Instances & Length or Spacing & Length parameters, note that you cannot define 

the length by using formulas.



Patterns should not go beyond the model.

5.  Enter 2 as the number of instances you wish to obtain in the first direction.

6.  Define the spacing along the grid: enter 30mm.

Defining the spacing along the grid and the length of your choice, would make the application compute 
the number of possible instances and space them at equal distances.

7.  Now, click the Second Direction tab to 

define the other parameters.

Note that defining a second direction is not 
compulsory. Creating a rectangular pattern defining 
only one direction is possible.

8.  Select the second edge (Edge.2), as shown, 

to define the second direction.

9.  Keep the Instances & Spacing option: 

enter 8 and 10 mm in the appropriate fields.

Additional cutouts have been aligned along 

this second direction.

10.  Click OK to repeat the cutouts.



After the update, the Sheet Metal part looks like 
this:

11.  Select this icon  to unfold the part:

The pattern is updated on the unfolded view.



 
12.  Click the More>> button to display further options.

 

The Simplified representation option lets you lighten the pattern geometry, when more than 10 
instances are generated in one direction. What you need to do is just check the option, and click Preview. 
The system automatically simplifies the geometry:

You can also specify the instances you do not want 
to see by double-clicking the dots. These instances 
are then represented in dashed lines during the 
pattern definition and then are no longer visible 
after validating the pattern creation. The 
specifications remain unchanged, whatever the 
number of instances you view. This option is 
particularly useful for patterns including a large 
number of instances.

(Reference information specific to the Generative Sheetmetal Design workbench)
●     When you duplicate a pattern of flange, the edge of the flange spine and its instances have to be 

tangent to the wall edge: you cannot choose a direction of patterning not parallel to the flange spine.

●     All instances of the flange pattern must lie on the same face as the flange pattern.

 



Creating Circular Patterns
In this task, you are going to create circular cutouts according to a pattern.
These features make the creation process easier.

 

 

In the Generative Sheetmetal Design workbench, you can only duplicate flanges, cutouts, holes, mirrors, stamps (except stiffening 
ribs), stamps without fillet (radius=0) and Generative Sheetmetal Design patterns.

 These features must lie on a unique and planar wall.
     

For the SheetMetal Design workbench, open the 
CircularPattern1.CATPart document.
For the Generative Sheetmetal Design workbench, open the 
NEWCircularPattern1.CATPart document.

The Sheet Metal part looks like this:

1.  Select the circular cutout you want to duplicate.

2.  Click the Circular Pattern icon .

The Circular Pattern Definition dialog box is 

displayed.

3.  Define the Axial Reference by choosing the Parameters 

type, and reference direction.
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●     Instance(s) & total angle: the number of patterns as 

specified in the instances field are created, in the specified 

direction, and evenly spread out over the total angle.

●     Instance(s) & angular spacing: the number of patterns as 

specified in the instances field are created in the specified 

direction, each separated from the previous/next one of the 

angular angle value.



●     Angular spacing & total angle: as many patterns as 

possible are created over the total angle, each separated from 

the previous/next one of the angular angle value.

●     Complete crown: the number of patterns as specified in the 
instances field are created over the complete circle (360deg). 

 

If you set Instance(s) & total angle or Angular spacing & total angle parameters, note that you cannot define the length by 
using formulas.

4.  Click the Reference element and select the element defining the rotation axis.

Here select the face on which lies the circular cutout.



●     To define a direction, you can select an edge or a planar face.
Should you select the face of a wall, the rotation axis would be normal to that face.

●     Click the Reverse button to inverse the rotation direction.

Now you are going to add a crown to this pattern.

5.   Click the Crown Definition tab, and choose which 

parameters you wish to define the crown.

This figure may help you define these parameters:

 
●     Circle(s) and crown thickness: you define the number of circles and they are spaced out evenly over the specified crown 

thickness

●     Circle(s) and circle spacing: you define the number of circles and the distance between each circle, the crown thickness being 
computed automatically

●     Circle(s) spacing and crown thickness: you define the distance between each circle and the crown thickness, and the number of 
circles is automatically computed.

For example, using the values described above for the 
Angular spacing & total angle option, you could 
define the crown as: 



Note that one of the pattern is created beyond the wall.  

You can delete instances of your choice when creating or editing a 
pattern. To do so, just select the points materializing instances in 
the pattern preview.

The instance is deleted, but the point remains, as you may wish 
to click it again to add the instance to the pattern definition again.

6.  Click the More>> button to display further options:

Using these options, you can change the position of the selected 

cutout within the crown. For example, if you set the Row in 

angular direction parameter to 4, this is what you obtain: the 

initially selected cutout is the fourth instance, based on the 

rotation direction, of the pattern.

Typically, in this case, you might want to edit the pattern and 

click again the instance that you removed above, to get a full 

pattern.

●     The Simplified representation option lets you lighten the pattern geometry, when more than 10 instances are generated in 
one direction. What you need to do is just check the option, and click Preview. The system automatically simplifies the 
geometry:
You can also specify the instances you do not want to see by double-clicking them . These instances are then represented in 
dashed lines during the pattern definition and then are no longer visible after validating the pattern creation. The specifications 
remain unchanged, whatever the number of instances you view. This option is particularly useful for patterns including a large 
number of instances.

●     When checking the Radial alignment of instances, all instances have the same orientation as the original feature. When 
unchecked, all instances are normal to the lines tangent to the circle.

In case you use the circular cutout as a reference element, it means the axial reference of the pattern will be the same as the 
rotation axis of the circular cutout. As a result, when the cutout is duplicated, the first crown instances will be superimposed on one 
another. 

To avoid this, uncheck Radial alignment of instances, so that the instances are properly positioned around the cutout.



7.  Click OK to create the pattern.

(Reference information specific to the Generative Sheetmetal Design workbench)
●     When you duplicate a pattern of flange, the edge of the flange spine and its instances have to be tangent to the wall edge: you 

cannot choose a direction of patterning not parallel to the flange spine.

●     All instances of the flange pattern must lie on the same face as the flange pattern.

 



Creating User-Defined Patterns
The User Pattern command lets you duplicate a cutout, a stamp, or any other feature as many times as 
you wish at the locations of your choice.
Locating instances consists in specifying anchor points. These points are sketches.

 

 

In the Generative Sheetmetal Design workbench, you can only duplicate flanges, cutouts, holes, mirrors, 
stamps (except stiffening ribs), stamps without fillet (radius=0) and Generative Sheetmetal Design 
patterns.

 These features must lie on a unique and planar wall.
    

For the SheetMetal Design workbench, open the UserPatterns1.CATPart document.
For the Generative Sheetmetal Design workbench, open the NEWUserPatterns1.CATPart document.

1.  Select the feature to be duplicated.

Here we selected the cutout. 

2.  Click the User Pattern icon 

.

The User Pattern Definition 

dialog box is displayed.

3.  Select 'Sketch 3' in the 

specification tree and click 

Preview.

The sketch contains the points 

you need to locate the 

duplicated cutouts. 

By default, the application positions each instance with respect to the center of gravity of the element to 
be duplicated. To change this position, use the anchor field: click the anchor field and select a vertex or a 
point.
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4.  Click inside the Anchor field and 

select the point (Point.1) to 

indicate a new reference 

location.

5.  You can then click the points 

corresponding to the pattern 

instances to be removed.

6.  Click OK in the User Pattern 

Definition dialog box.

Cutouts are created at the 

points of the sketch.

Would you need to unfold the part using the Fold/Unfold  icon, you would notice that the pattern is 
updated.

 (Reference information specific to the Generative Sheetmetal Design workbench)
●     When you duplicate a pattern of flange, the edge of the flange spine and its instances have to be 

tangent to the wall edge: you cannot choose a direction of patterning not parallel to the flange spine.

●     All instances of the flange pattern must lie on the same face as the flange pattern.

 



Mirroring

In this task, you are going to mirror a given feature, that is, to duplicate it symmetrically with respect to 

a plane.

 

●     You can mirror a hole, a cutout, a flange, a stamp (except stiffening ribs), a pattern or another 
mirror.

●     Whatever feature you choose to mirror, it must lie on a unique, planar wall.

●     It is mandatory that the result of the mirroring should lie on the part, otherwise it cannot be 
mirrored.

Open the NEWMirror01.CATPart document.

A cutout and a relimited flange are displayed on the wall.

1.  Click on the Mirror icon .

The Mirror definition dialog box is displayed.

 

2.  Select the feature to mirror, that is, Cut Out.1 in our example.

 

3.  Select the zx plane in the 3D window as shown below.

The selected plane and a preview of the cutout to be mirrored is displayed.
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4.  Click on Preview to visualize the mirrored cutout.

 

There is three different ways to select a mirroring plane :

●     In the 3D window, as in our example.

●     with a right click on the Mirroring field in the Mirror definition dialog box.



 

 
●     with a right click in the workbench background.

 

5.  Click on Ok to create the mirrored cutout.

 



The mirror feature is displayed in the specification tree.

If you selected the mirroring plane with a right click, the plane feature is also displayed in the 
specification tree, allowing you to double click on it should you need to edit it.

If you selected the mirroring plane with a right click, an icon is displayed in the Mirror definition 

dialogue box so that you can modify it if needed.

6.  Select Flange.3.

7.  Click on the Mirror icon  and select the zx plane.

The flange to be mirrored is displayed.

 

8.  Click on Preview if you want to visualize the mirrored flange, then on OK to create it.

 

When mirroring a flange, it is mandatory that the result of the mirror should lie on an edge.



Creating a Local Corner Relief

This task explains how to define a corner relief locally on a set of supports.

Open the NEWCornerRelief01.CATPart document.

The part needs to be unfolded prior to creating the corner relief.

1.  Click the Corner Relief icon .

The Corner Relief Definition dialog box is displayed.

2.  Select the supports on which a corner relief should be created (here we chose Flange.1 and 

Cylindrical Bend.1).
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3.  Click OK to create the Corner Relief.

 



4.  Fold the part to check the Corner Relief in 3D.



 
1.  Open the NEWCornerRelief01.CATPart document again.

2.  Click the Corner Relief icon .

The Corner Relief Definition dialog box is displayed. 

3.  Select the User Profile  using the down arrow.

4.  Select the supports on which a corner relief should be created (here we chose Flange.1 and 

Wall.2).
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5.  Click the Catalog icon .

The Catalog Browser dialog box is displayed.



6.  If needed, browse to the directory where the stamp catalog is filed.

In our example we selected Aero_Sheetmetal_Cutouts catalog.

7.  Double-click on UserFeature_family.

The features available in the catalog are displayed.



8.  Select Slot_Contour and click OK to close the catalog browser.

9.  On the geometry, select the inputs needed to insert the feature:

Use Wall.1 as Reference plane;

Use the Flange vertex as Reference point;

Use an edge of Flange.1 as Reference axis.





10.  Click OK to insert the feature.

11.  Click OK again to create the corner relief.



●     The radius is equal to the default bend radius of the part + the thickness.

●     By default the corner relief center is located at the intersection of the bend axes. You can also select 
a point as the circle's center. 
To do this, click Bend Axis Intersection to deselect it and select a point as the circle's center.

 



Creating Corners
This task shows how to create one or more corner(s) on a Sheet Metal part, that is to round off sharp edges, much like a fillet between two 
faces of a Part Design body.
This corner creation operation can be performed indifferently on the folded or unfolded view, and only one support (i.e. the corner when 
previewed should not lie over two supports).

 

Open the Corner1.CATPart document.
If you use Aerospace SheetMetal Design, open the Corner_Aero1.CATPart document.

1.  Click the Corner icon . The Corner dialog box is displayed. 

 

 
2.  Set the radius value.

3.  Choose the type of edge you wish to round off: Convex Edge(s) and/or Concave Edge(s). For the purpose of this scenario, leave 

both options selected.

Once you have selected an edge, you can no longer modify the chosen options (they are grayed out), unless you cancel the selection.
 

4.  Click to select a convex edge on a part.

As soon as you selected one edge, the dialog box is updated and the Select All button changes to Cancel Selection.

 

The corner is previewed on the edge, with the current radius value.
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5.  Click to select a concave edge on a part.

 

 The corner is previewed on the edge, with the current radius value.
 

6.  Click Cancel Selection then click the Select All button. All edges of the part are selected and the corners previewed.

7.  Click OK in the dialog box.

All sharp edges of the part are rounded off to create smooth corners.



    
To deselect an edge, simply click it again. For quick selection in a complex part, you can select all edges with the Select All check button, 
then deselect one or two edges.

    
●     When you select an edge that is not sharp, such as the edge between a wall and a bend for example, a warning is issued.

●     As you select more edges, the Edge(s) field of the dialog box is updated.

●     When using the Select All button, you select all edges present at the time. If when modifying the part, new edges are created, these will 
not be automatically rounded off.

 



Creating Chamfers
This task shows how to create one or more chamfer(s)  on a Sheet Metal part, that is to cut off, or fill in sharp edges of Sheet Metal parts.
This chamfer creation operation can be performed indifferently on the folded or unfolded view, and only one support (i.e. the chamfer when previewed 
should not lie over two supports).

 

Open the Corner1.CATPart document.
If you use Aerospace SheetMetal Design, open the Corner_Aero1.CATPart document.

1.  Click the Chamfer icon .

The Chamfer Definition dialog box is displayed. 

You can choose the type of edge you wish to chamfer: 
●     using the Select All button, you can select all convex edges on the part

●     any edge you select manually.

 
2.  Leave the Convex Edge(s) option selected.

3.  Select a sharp edge on a part. 

 
If you want to create a longitudinal chamfer, you can select a single long edge. This allows you to create a welding chamfer, for example.

The chamfer is previewed on the edge.

Remember that when you create a chamfer on one edge it is automatically propagated on the tangent edge.

As soon as you selected one edge, the dialog box is updated and the Select All button changes to Cancel Selection.

3.  Choose a chamfer mode. You can either enter:

●     two lengths: these lengths are computed from the selected edge on both sides.
Here, we chose two lengths of 10mm.

●     a length value and an angle: the length is computed on one side of the edge and the 
angle from the chamfer's limit on the same side.
Here, we chose a length of 10mm and an angle of 60deg.

You can use the Reverse button to inverse all edges' side, on which the values are taken into account.
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 Once you chose the chamfer mode, you can specify whether the propagation should be:

●     minimal

 
●     on tangency

4.  Click Cancel Selection then click the Select All button.

All sharp edges of the part are selected, the Select All button taking into account the chosen type and the chamfers previewed.

5.  Click OK in the dialog box.

All sharp edges of the part are cut off or filled in. 



    

To deselect an edge, simply click it again. For quick selection in a complex part, you can select all edges with the Select All button, then deselect one or 
two edges.

    

●     When you select an edge that is not sharp, such as the edge between a wall and a bend for example, a warning is issued.

●     As you select more edges, the Edge(s) field of the dialog box is updated.

●     When using the Select All button, you select all edges present at the time. If when modifying the part, new edges are created, these will not be 
automatically chamfered.

●     When the sharp edge is selected in the thickness of the wall, its length has to be equivalent to the wall's thickness.

●     If the sharp edge is not selected in the thickness of the wall, it has to limit the faces of the wall.

You cannot chamfer the edges of a stamp. 

 



Mapping Elements 

 

This task shows how to create curves or points from a sketch (as designed using the Sketcher) or from 
existing curves or points,  onto a Sheet Metal part; and to fold/unfold it, just as other Sheet Metal 
elements. 
This is especially useful when: 

●     you want to generate a logotype

●     you want to define an area for chemical milling

●     you want to create a cutout (pocket) to solve the overlapping of walls for example (the overlapping 
can be checked with the Check Overlapping functionnality).

 

If you use Generative Sheetmetal Design, open the NEWMapping1.CATPart document.

This sample already contain a pre-defined sketch that will be mapped onto the part. 

Otherwise, you would need to defined a sketch by entering the Sketcher workbench , selecting the 
wall onto which the curve should lie, and drawing the sketch you wish.
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1.  Make sure the sketch is selected, and click the Point or Curve Mapping icon  .

The Unfold object definition dialog box is displayed, indicating which elements have been 
selected for mapping.

 

To add elements in the object(s) list, click on Add Mode and select an element in the geometry or the 
specification tree.

To remove elements in the object(s) list, click on Remove Mode and select an element in the geometry 
or the specification tree.

 The curve mapping is previewed as if the supporting walls were unfolded. 

 



 You can manage the list of objects if several are available:

●     to remove an object, select it from the list and use the Clear selection contextual menu

●     to add an object, select it directly in the geometry.
Order in the list does not matter. 

The Support is not necessarily the support element on which the element to be mapped has been drawn. 
Indeed, by default, the Support  is the last Sheet Metal feature that has been created or modified, that is 
the current feature in the specification tree.

2.  Select Wall.4 as the Support, that is the element of the part on which the curve should be 

generated when folding or unfolding. 

The curve mapping is previewed as if Wall.4 was unfolded.



 

 
3.  Click OK. 

The curve mapping is created and added in the specification tree.



Folded view of the curve mapping

 

 Unfolded view of the curve mapping

You can select several support elements.
To remove or replace them, click the Multiselection icon and select the appropriate support element.



 

●     You can select several sketches/curves/points to be mapped at a time.

●     Mapped curves can be created across several walls and bends.

 



Interoperability with Wireframe
Creating Points
Creating Lines
Creating Planes



Creating Points

 

This task shows the various methods for creating points: 
●     by coordinates

●     on a curve

●     on a plane

●     on a surface

●     at a circle/sphere center

●     tangent point on a curve

●     between

 
Open the Points3D1.CATPart document.

 1.  Click the Point icon  .

The Point Definition dialog box appears.

2.  Use the combo to choose the desired point type.

A new lock button  is available besides the Point type to prevent an automatic change of the type 

while selecting the geometry. Simply click it so that the lock turns red . 
For instance, if you choose the Coordinates type, you are not able to select a curve. May you want to 
select a curve, choose another type in the combo list.

 

Coordinates 
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●     Enter the X, Y, Z coordinates in the current axis-system.

●     Optionally, select a Reference Point.

The corresponding point is displayed.

 
●     When the command is launched at creation, the initial value in the Axis System field is the current 

local axis system. If no local axis system is current, the field is set to Default. 
Whenever you select a local axis system, the point's coordinates are changed with respect to the 
selected axis system so that the location of the point is not changed. This is not the case with points 
valuated by formulas: if you select an axis system, the defined formula remains unchanged.
This option replaces the Coordinates in absolute axis-system option.
 

If you create a point using the coordinates method and an axis system is already defined and 
set as current, the point's coordinates are defined according to current the axis system. 

The current local axis system must be different from the absolute axis.

 

On curve 
 



●     Select a curve.

●     Optionally, select a reference point.
If this point is not on the curve, it is projected onto the curve.
If no point is selected, the curve's extremity is used as reference.

●     Select an option point to determine whether the new point is to be created: 
❍     at a given distance along the curve from the reference point

❍     a given ratio between the reference point and the curve's extremity.

●     Enter the distance or ratio value.
If a distance is specified, it can be: 

❍     a geodesic distance: the distance is measured along the curve

❍     an Euclidean distance: the distance is measured in relation to the reference point (absolute value).
The corresponding point is displayed.

It is not possible to create a point with an euclidean distance if the distance or the ratio 
value is defined outside the curve.

You can also: 
■     click the Nearest extremity button to display the point at the nearest extremity of the curve.

■     click the Middle Point button to display the mid-point of the curve.

Be careful that the arrow is orientated towards the inside of the curve (providing the curve is 
not closed) when using the Middle Point option.

●     use the Reverse Direction button to display: 
❍     the point on the other side of the reference point (if a point was selected originally)

❍     the point from the other extremity  (if no point was selected originally).

●     click the Repeat object after OK if you wish to create equidistant points on the curve, using the 
currently created point as the reference, as described in Creating Multiple Points and Planes in the 



Wireframe and Surface User's Guide. 
You will also be able to create planes normal to the curve at these points, by checking the Create 
normal planes also option, and to create all instances in a new geometrical set by checking the 
Create in a Body option. If the latter option is not checked, instances are created in the current 
geometrical set.

❍     If the curve is infinite and no reference point is explicitly given, by default, the reference 
point is the projection of the model's origin

❍     If the curve is a closed curve, either the system detects a vertex on the curve that can be 
used as a reference point, or it creates an extremum point, and highlights it (you can then 
select another one if you wish) or the system prompts you to manually select a reference 
point.

Extremum points created on a closed curve are aggregated under their parent command and put in no 
show in the specification tree.

 

On plane 
 



 
●     Select a plane.

❍     If you select one of the planes of any local axis system as the plane, the origin of this axis system 
is set as the reference point and featurized. If you modify the origin of the axis system, the 
reference point is modified accordingly.

●     Optionally, select a point to define a reference for computing coordinates in the plane.
❍     If no point is selected, the projection of the model's origin on the plane is taken as reference.

●     Optionally, select a surface on which the point is projected normally to the plane.
❍     If no surface is selected, the behavior is the same.

Furthermore, the reference direction (H and V vectors) is computed as follows: 
With N the normal to the selected plane (reference plane), H results from the vectorial product of 
Z and N (H = Z^N). 
If the norm of H is strictly positive then V results from the vectorial product of N and H (V = N^H).
Otherwise, V = N^X and H = V^N.
Would the plane move, during an update for example, the reference direction would then be 
projected on the plane. 

●     Click in the plane to display a point.



 

On surface 
 

●     Select the surface where the point is to be created.

●     Optionally, select a reference point. By default, the surface's middle point is taken as reference. 

●     You can select an element to take its orientation as reference direction or a plane to take its normal as 
reference direction.
You can also use the contextual menu to specify the X, Y, Z components of the reference direction.

●     Enter a distance along the reference direction to display a point.

 
●     Choose the dynamic positioning of the point:

❍     Coarse (default behavior): the distance computed between the reference point and the mouse 

click is an euclidean distance. Therefore the created point may not be located at the location of the 

mouse click (see picture below).

The manipulator (symbolized by a red cross) is continually updated as you move the mouse over 

the surface.



❍     Fine: the distance computed between the reference point and the mouse click is a geodesic 

distance. Therefore the created point is located precisely at the location of the mouse click.

The manipulator is not updated as you move the mouse over the surface, only when you click on 

the surface.

 Sometimes, the geodesic distance computation fails. In this case, an euclidean distance might be used 
and the created point might not be located at the location of the mouse click. This is the case with closed 
surfaces or surfaces with holes. We advise you to split these surfaces before creating the point.

 

Circle/Sphere center 



 

●     Select a circle, circular arc, or ellipse, or

●     Select a sphere or a portion of sphere.

A point is displayed at the center of the selected element.

 

Tangent on curve 

 



●     Select a planar curve and a direction line.
A point is displayed at each tangent. 
The Multi-Result Management dialog box is displayed because several points are generated. Refer to 
the Managing Multi-Result Operations chapter.

 

Between
 

●     Select any two points.

●     Enter the ratio, that is the percentage of the distance from the first selected point, at which the new 
point is to be.
You can also click Middle Point button to create a point at the exact midpoint (ratio = 0.5).

Be careful that the arrow is orientated towards the inside of the curve (providing the curve is not 
closed) when using the Middle Point option.

●     Use the Reverse direction button to measure the ratio from the second selected point.
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If the ratio value is greater than 1, the point is located on the virtual line beyond the selected 
points.

3.  Click OK to create the point.

The point (identified as Point.xxx) is added to the specification tree.

 
●     Parameters can be edited in the 3D geometry. For more information, refer 

to the Editing Parameters chapter.

●     You can isolate a point in order to cut the links it has with the geometry 
used to create it. To do so, use the Isolate contextual menu. For more 
information, refer to the Isolating Geometric Elements chapter.
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Creating Lines
This task shows the various methods for creating lines: 

●     point to point

●     point and direction

●     angle or normal to curve

●     tangent to curve

●     normal to surface

●     bisecting

 
It also shows you how to create a line up to an element, define the length type and automatically reselect 
the second point.

 
Open the Lines1.CATPart document.

1.  Click the Line icon  .

The Line Definition dialog box is displayed. 

2.  Use the drop-down list to choose the desired line type.

A line type will be proposed automatically in some cases depending on your first element selection.

A new lock button  is available besides the Line type to prevent an automatic change of the type 

while selecting the geometry. Simply click it so that the lock turns red . 
For instance, if you choose the Point-Point type, you are not able to select a line. May you want to select a 
line, choose another type in the combo list.

 

Defining the line type

Point - Point 
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●     Select two points.
A line is displayed between the two points.
Proposed Start and End points of the new line are shown.

●     If needed, select a support surface.
In this case a geodesic line is created, i.e. going from one point to the other according to the shortest 
distance along the surface geometry (blue line in the illustration below).
If no surface is selected, the line is created between the two points based on the shortest distance.



 If you select two points on closed surface (a cylinder for example), the result may be unstable. 
Therefore, it is advised to split the surface and only keep the part on which the geodesic line will 
lie. 

●     Specify the Start and End points of the new line, that is the line endpoint location in relation to the 
points initially selected.
These Start and End points are necessarily beyond the selected points, meaning the line cannot be 
shorter than the distance between the initial points.

●      Check the Mirrored extent option to create a line symmetrically in relation to the selected Start and 
End points.

The projections of the 3D point(s) must already exist on the selected support. 

 

Point - Direction 
 



●     Select a reference Point and a Direction line.
A vector parallel to the direction line is displayed at the reference point. 
Proposed Start and End points of the new line are shown.

●     Specify the Start and End points of the new line.
The corresponding line is displayed.



 

Angle or Normal to curve 
 



 

●     Select a reference Curve and a Support surface containing that curve.
❍     If the selected curve is planar, then the Support is set to Default (Plane).

❍     If an explicit Support has been defined, a contextual menu is available to clear the selection.

●     Select a Point on the curve.

●     Enter an Angle value.

A line is displayed at the given angle with respect to the tangent to the reference curve at the selected 
point. These elements are displayed in the plane tangent to the surface at the selected point. 
You can click on the Normal to Curve button to specify an angle of 90 degrees. 
Proposed Start and End points of the line are shown. 

●     Specify the Start and End points of the new line.
The corresponding line is displayed.

●     Click the Repeat object after OK if you wish to create more lines with the same definition as the 
currently created line. 
In this case, the Object Repetition dialog box is displayed, and you key in the number of instances to 
be created before pressing OK.

As many lines as indicated in the dialog box are created, each separated from the initial line by a 
multiple of the angle value.



You can select the Geometry on Support check box if you want to create a geodesic line onto a 
support surface. 
The figure below illustrates this case.
Geometry on support option not checked: Geometry on support option checked:

This line type enables to edit the line's parameters. Refer to Editing Parameters to find out more.

 

Tangent to curve 
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●     Select a reference Curve and a point or another Curve to define the tangency. 
❍     if a point is selected (mono-tangent mode): a vector tangent to the curve is displayed at 

the selected point.

❍     If a second curve is selected (or a point in bi-tangent mode), you need to select a support plane. 
The line will be tangent to both curves.

■     If the selected curve is a line, then the Support is set to Default (Plane).

■     If an explicit Support has been defined, a contextual menu is available to clear the selection.



 

When several solutions are possible, you can choose one (displayed in red) directly in the 
geometry, or using the Next Solution button.
Line tangent to curve at a given point: Line tangent to two curves:

●     Specify Start and End points to define the new line.
The corresponding line is displayed.

 
Normal to surface 

 



 
●     Select a reference Surface and a Point.

A vector normal to the surface is displayed at the reference point. 
Proposed Start and End points of the new line are shown.

If the point does not lie on the support surface, the minimum distance between the point and the 
surface is computed, and the vector normal to the surface is displayed at the resulted reference point.

●     Specify Start and End points to define the new line.
The corresponding line is displayed.



 

Bisecting 
 



●     Select two lines. Their bisecting line is the line splitting in two equals parts the angle between these 
two lines. 

●     Select a point as the starting point for the line. By default it is the intersection of the bisecting line and 
the first selected line.

●     Select the support surface onto which the bisecting line is to be projected, if needed.

●     Specify the line's length by defining Start and End values (these values are based onto the default 
start and end points of the line).
The corresponding bisecting line, is displayed.

●     You can choose between two solutions, using the Next Solution button, or directly clicking the 
numbered arrows in the geometry.

3.  Click OK to create the line.

The line (identified as Line.xxx) is added to the specification tree.

 
●     Regardless of the line type, Start and End values are specified by entering 

distance values or by using the graphic manipulators.

●     Start and End values should not be the same.

●     Check the Mirrored extent option to create a line symmetrically in relation 
to the selected Start point. 
It is only available with the Length Length type.

●     In most cases, you can select a support on which the line is to be created. 
In this case, the selected point(s) is projected onto this support.

●     You can reverse the direction of the line by either clicking the displayed 
vector or selecting the Reverse Direction button (not available with the 
point-point line type).

●     Parameters can be edited in the 3D geometry. For more information, refer 
to the Editing Parameters chapter.
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●     You can isolate a line in order to cut the links it has with the geometry used 
to create it. To do so, use the Isolate contextual menu. For more 
information, refer to the Isolating Geometric Elements chapter.

You cannot create a line of which points have a distance lower than the 
resolution.

 

Creating a line up to an element 
 This capability allows you to create a line up to a point, a curve, or a surface.
 

It is available with all line types, but the Tangent to curve type.

 

Up to a point
 

●     Select a point in the Up-to 1 and/or Up-to 2 fields.
Here is an example with the Bisecting line type, the Length Length type, and a point as Up-to 2 
element.

 

Up to a curve
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●     Select a curve in the Up-to 1 and/or Up-to 2 fields.

Here is an example with the Point-Point line type, the Infinite End Length type, and a curve as the 
Up-to 1 element.

 

Up to a surface
 

●     Select a surface in the Up-to 1 and/or Up-to 2 fields.
Here is an example with the Point-Direction line type, the Length Length type, and the surface as the 
Up-to 2 element.

 
●     If the selected Up-to element does not intersect with the line being created, then an 

extrapolation is performed. It is only possible if the element is linear and lies on the 
same plane as the line being created.
However, no extrapolation is performed if the Up-to element is a curve or a surface.

●     The Up-to 1 and Up-to 2 fields are grayed out with the Infinite Length type, the Up-
to 1 field is grayed out with the Infinite Start Length type, the Up-to 2 field is 
grayed out with the Infinite End Length type.

●     The Up-to 1 field is grayed out if the Mirrored extent option is checked.

●     In the case of the Point-Point line type, Start and End values cannot be negative.



 Defining the length type
 

●     Select the Length Type: 
❍     Length: the line will be defined according to the Start and End points values

❍     Infinite: the line will be infinite

❍     Infinite Start Point: the line will be infinite from the Start point

❍     Infinite End Point: the line will be infinite from the End point

 By default, the Length type is selected.
The Start and/or the End points values will be grayed out when one of the Infinite 
options is chosen.

 

Reselecting automatically a second point
 

This capability is only available with the Point-Point line method.

1.  Double-click the Line icon .

The Line dialog box is displayed.

2.  Create the first point.

The Reselect Second Point at next start option appears in the Line dialog box.

3.  Check it to be able to later reuse the second point.

4.  Create the second point.

5.  Click OK to create the first line.



The Line dialog box opens again with the first point initialized with the second point of the first 
line.

6.  Click OK to create the second line.

To stop the repeat action, simply uncheck the option or click Cancel in the Line Definition 
dialog box.



Creating Planes

 
This task shows the various methods for creating planes:

 

●     offset from a plane

●     parallel through point

●     angle/normal to a plane

●     through three points

●     through two lines

●     through a point and a line

●     through a planar curve

●     normal to a curve

●     tangent to a surface

●     equation

●     mean through points

 

 
Open the Planes1.CATPart document.

 1.  Click the Plane icon  .

The Plane Definition dialog box appears.

2.  Use the combo to choose the desired Plane type.

Once you have defined the plane, it is represented by a green square symbol, which you can 
move using the graphic manipulator.

A new lock button  is available besides the Plane type to prevent an automatic change of the type 

while selecting the geometry. Simply click it so that the lock turns red . 
For instance, if you choose the Through two lines type, you are not able to select a plane. May you want 
to select a plane, choose another type in the combo list.

 

Offset from plane
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●     Select a reference Plane then enter an Offset value.
A plane is displayed offset from the reference plane.

●     Use the Reverse Direction button to reverse the change the offset direction, or simply 
click on the arrow in the geometry.

●     Click the Repeat object after OK if you wish to create more offset planes. 
In this case, the Object Repetition dialog box is displayed, and you key in the number of 
instances to be created before pressing OK.

As many planes as indicated in the dialog box are created (including the one you were 
currently creating), each separated from the initial plane by a multiple of the Offset value. 

 
Parallel through point 



 

●     Select a reference Plane and a Point.

A plane is displayed parallel to the reference plane and passing through the selected point.

 
Angle or normal to plane 



 

 

●     Select a reference Plane and a Rotation axis.
This axis can be any line or an implicit element, such as a cylinder axis for example. To 
select the latter press and hold the Shift key while moving the pointer over the element, 
then click it.

●     Enter an Angle value.

The plane is displayed such as its center corresponds to the projection of the center of the 
reference plane on the rotation axis. It is oriented at the specified angle to the reference 
plane. 

●     Check the Project rotation axis on reference plane option if you wish to project the 
rotation axis onto the reference plane. If the reference plane is not parallel to the rotation 
axis, the created plane is rotated around the axis to have the appropriate angle with regard 
to reference plane.

●     Check the Repeat object after OK option if you wish to create more planes at an angle 
from the initial plane. 
In this case, the Object Repetition dialog box is displayed, and you key in the number of 
instances to be created before pressing OK.



As many planes as indicated in the dialog box are created (including the one you were 
currently creating), each separated from the initial plane by a multiple of the Angle value.
Here we created five planes at an angle of 20 degrees.

This plane type enables to edit the plane's parameters. Refer to Editing Parameters to find 
out how to display these parameters in the 3D geometry.

 

Through three points 
 

●     Select three points.

The plane passing through the three points is displayed. You can move it simply by dragging 
it to the desired location.
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Through two lines 

 

●     Select two lines.
The plane passing through the two line directions is displayed.
When these two lines are not coplanar, the vector of the second line is moved to the first line location 
to define the plane's second direction. 

●     Check the Forbid non coplanar lines option to specify that both lines be in the same plane.



 

Through point and line 
 

●     Select a Point and a Line.

The plane passing through the point and the line is displayed. 



 

Through planar curve 
 

●     Select a planar Curve.

The plane containing the curve is displayed.

 
Normal to curve 



 

●     Select a reference Curve.

●     You can select a Point. By default, the curve's middle point is selected.

It can be selected outside the curve.

A plane is displayed normal to the curve with its origin at the specified point. The normal is 
computed at the point on the curve that is the nearest to the selected point.

 

Tangent to surface 



 

 
●     Select a reference Surface and a Point.

A plane is displayed tangent to the surface at the specified point.



 
Equation 

 

●     Enter the A, B, C, D components of the Ax + By + Cz = D plane equation.

●     Select a point to position the plane through this point, you are able to modify A, B, and C 
components, the D component becomes grayed.

 
●     When the command is launched at creation, the initial value in the Axis System field is the 

current local axis system. If no local axis system is current, the field is set to Default. 
Whenever you select a local axis system, A, B, C, and D values are changed with respect to 
the selected axis system so that the location of the plane is not changed. This is not the 
case with values valuated by formulas: if you select an axis system, the defined formula 
remains unchanged.
This option replaces the Coordinates in absolute axis-system option.



 

●     Use the Normal to compass button to position the plane perpendicular to the compass 
direction.

 

●     Use the Parallel to screen button to parallel to the screen current view.

 

Mean through points 
 



●     Select three or more points to display the mean plane through these points.

It is possible to edit the plane by first selecting a point in the dialog box list then choosing 
an option to either:

❍     Remove the selected point

❍     Replace the selected point by another point.

3.  Click OK to create the plane.

The plane (identified as Plane.xxx) is added to the specification tree.

 
●     Parameters can be edited in the 3D geometry. For more information, refer to the 

Editing Parameters chapter.

●     You can isolate a plane in order to cut the links it has with the geometry used to 
create it. To do so, use the Isolate contextual menu. For more information, refer to 
the Isolating Geometric Elements chapter.
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Interoperability with Knowledge Expert
This section provides essential information on the types that you can access when working with the browser. 
See also the Using the Object Browser and Using the Object Library sections in the Knowledge Expert User's 
Guide.

Sheet Metal Shared Package



Sheet Metal Shared Package 

CATSHM_CircPattern CATSHM_RecPattern CATSHM_UserPattern

CATSmBeadPunch CATSmBridgePunch CATSmCornerRelief

CATSmCurvePunch CATSmExtendedExtrudedHolePunch CATSmExtrudedHolePunch

CATSmFlange CATSmLouverPunch CATSmPointPunch

CATSmStamp CATSmStiffeningRibPunch CATSmSurfacePunch

CATSmUserPunch CATSmChamfer CATSmCorner

CATSmCutOut CATSmHole  

 

CATSHM_CircPattern  

Description

Describes a circular pattern.

Inheritance path

Standard - Feature -> Standard - Visualizable -> MechanicalModeler -> GeometricFeature ->MechanicalModeler - 
MechanicalFeature

CATSHM_RecPattern  

Description

Describes a rectangular pattern.

Inheritance path

 Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler -> MechanicalFeature 



CATSHM_UserPattern  

Description

Describes a user pattern.

Inheritance path

 Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler -> MechanicalFeature 

CATSmBeadPunch  

Description

Describes a Bead feature.

Attributes

BeadCrossRadius
Defines the cross section radius of the bead.

BeadEndRadius
Defines the ending radius of the bead.

StampRadius
Defines the fillet radius of the bead.

Inheritance path 

Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature 

CATSmBridgePunch  

Description

Describes the bridge feature.



Attributes

BeadEndRadius
Defines the radius of the bridge.

StampRadius
Defines the fillet radius of the bridge.

Inheritance path 

Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature 

CATSmCornerRelief  

Description

Describes the Corner relief feature.

Inheritance path 

Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature 

CATSmCurvePunch  

Description

Describes the Curve stamp feature.

Attributes

CurvePunchAngle
Defines the angle of the curve stamp.

StampRadius
Defines the fillet radius of the curve stamp.

Inheritance path 



Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature 

CATSmExtendedExtrudedHolePunch  

Description

Describes the flanged cutout feature.

Attributes

FlangedCutOutAngle
Defines the angle of the flanged cutout.

StampRadius
Defines the fillet radius of the flanged cutout.

Inheritance path 

Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature 

CATSmExtrudedHolePunch  

Description

Describes the flanged hole feature.

Attributes

ExtrudedHoleAngle
Defines the angle of the flanged hole.

ExtrudedHoleDiameter
Defines the diameter of the flanged hole.

StampRadius
Defines the fillet radius of the flanged hole.

Inheritance path 



Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature 

CATSmFlange  

Description

Describes the flange feature.

Inheritance path 

Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature 

CATSmLouverPunch  

Description

Describes the louver feature.

Attribute

StampRadius
Defines the fillet radius of the Louver.

Inheritance path 

Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature 

CATSmPointPunch  

Description

Describes the circular stamp feature.



Attributes

PointPunchAngle
Defines the angle of the circular stamp.

PointPunchDiameter
Defines the diameter of the circular stamp.

StampRadius
Defines the fillet radius of the circular stamp.

Inheritance path 

Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature 

CATSmStamp  

Description

Describes the Stamp feature.

Inheritance path 

Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature 

CATSmStiffeningRibPunch  

Description

Describes the Stiffening rib feature.

Attributes

StiffeningRibAngle
Defines the angle of  the stiffening rib.

StampRadius
Defines the fillet radius of  the stiffening rib.



Inheritance path 

Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature 

CATSmSurfacePunch  

Description

Describes the Surface stamp feature.

Attributes

StampRadius
Defines the radius of the surface stamp.

SurfacePunchAngle
Defines the angle of the surface stamp.

Inheritance path 

Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature 

CATSmUserPunch  

Description

Describes the User defined stamp feature.

Attributes

StampRadius
Defines the fillet radius of the user defined stamp.

Inheritance path 

Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature 



CATSmChamfer  

Description

Describes the Chamfer feature.

Inheritance path 

Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature 

CATSmCorner  

Description

Describes the Corner feature.

Attributes

CornerRadius
Defines the corner radius.

Inheritance path 

Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature 

CATSmCutOut  

Description

Describes the Cutout feature.

Inheritance path 



Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature 

CATSmHole  

Description

Describes the Hole feature.

Attributes

HoleRadius
Defines the diameter of the hole.

HoleTypeClearance
Defines whether the hole is from type "Clearance".

HoleTypeFasten
Defines whether the hole is from type "Fasten".

HoleTypeIndex
Defines whether the hole is from type "Index".

HoleTypeManuf
Defines whether the hole is from type "Manufacturing".

Inheritance path 

Standard - Feature -> Standard - Visualizable -> MechanicalModeler - GeometricFeature -> MechanicaModeler - 
Body -> MechanicalModeler - MechanicalFeature



Integration With Part Design
For the Sheet Metal Design workbench, open the Stiffener1.CATPart document.
For the Generative Sheetmetal Design workbench, open the NEWStiffener1.CATPart document.

  
This scenario, which is valid for both the Sheet Metal Design workbench and the Generative Sheet Metal 
Design workbench, is illustrated using screen captures from the Sheet Metal Design workbench. Results 
will slightly differ in the Generative Sheetmetal Design workbench, for which Automatic bends are not 
available. 

  
In a CATPart document, you may have Part Design features and Sheet Metal features according to the 
following rules:

●     Part Design features can be created before Sheet Metal features.

●     a Part Design feature can also be created after Sheet Metal features as long as the part is in 
folded view.

●     in the unfolded view, the Part Design feature will not be displayed.

●     it is no longer possible to create Sheet Metal features after this last Part Design feature in 
folded view.

1.  Create two walls with an Automatic or Conical Bend for the Sheet Metal Design workbench or two 

walls with a Cylindrical or Conical Bend for the Generative Sheetmetal Design workbench.

2.  Switch to the Part Design workbench.

3.  Launch the Sketcher and draw an oblique line in the yz plane.

4.  Click the icon  to create a Stiffener.
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5.  Switch to the Sheet Metal Design workbench or to the Generative Sheet Metal Design workbench.

6.  Click the Fold/Unfold icon .

The stiffener is not displayed on the unfolded view.
 

To add a Generative Sheetmetal Design feature and switch to the Sheet Metal Design workbench or to the 
Generative Sheetmetal Design Design workbench, select the Bend for example and right-click the Define 
In Work Object item. The Generative Sheetmetal Design feature will be added after the Bend but before 
the Stiffener.



Integration With Weld Design
You can open the Integration.CATProduct document from the samples directory to replay the scenario.
If you use the Generative Sheetmetal Design workbench, open the NEWIntegration.CATProduct document.

In a CATProduct document, you may have Weld Design features and Sheet Metal features according to the following rules:

●     Weld Design features are created after Sheet Metal features.

●     in the unfolded view, the Weld Design feature will not be displayed.

●     it is no longer possible to create Sheet Metal features after this last Weld Design feature.

1.  Create two walls.

2.  Switch to Weld Design workbench.

 
3.  Create a weld (in our scenario, we create a Single-V Butt weld)

To add a Generative Sheetmetal Design feature and switch to the Sheet Metal Design workbench, select any of the two walls and 
make it current.

 
The Generative Sheetmetal Design feature will be added after the Bend but before the Stiffener.

file:///E|/www/lgkr16/Doc/online/cfysm_C2/samples/SheetMetal/Integration.CATProduct
file:///E|/www/lgkr16/Doc/online/cfysm_C2/samples/SheetMetal/NEWIntegration.CATProduct


Integration with Generative Drafting
This section deals with how Generative SheetMetal Design integrates with the Generative Drafting workbench.

Producing Drawings
Producing Drawings with Generative View Styles

SheetMetal Parameters



Producing Drawings
This task explains how to generate an unfolded view of a part with bends (bends, walls on edge, flat bends and swept 
walls) and stamps in a drawing sheet. The BTLs and axes of bends and swept walls, as well as the lines stamp are 
displayed within the drawing.

  
For the SheetMetal Design workbench, open the SweptWall01.CATPart document.
For the Generative Sheetmetal Design workbench, open the SheetMetalDrafting1.CATPart document.

Make sure you have an appropriate Generative Drafting license. For more information about this workbench, refer to 
Generative Drafting User's Guide.

Make sure that the Generate axis lines option is checked in the Tools -> Options -> Mechanical Design -> Drafting -
> View tab, prior to generating a view in a .CATDrawing document.

1.  Click  or select File -> New...

2.  Select the Drawing type and click OK. The New Drawing dialog box is displayed.

 

3.  Click OK.

4.  The drawing sheet appears.

5.  Tile the windows horizontally using the Window -> Tile Horizontally menu item.

6.  Select the Unfolded View icon  in the Projections toolbar from the Generative Drafting workbench.

 

This icon is active in the Projections toolbar provided you have a Generative Sheetmetal Design licence.

7.  Choose the xy plane in the Sheet Metal specification tree. A preview of the view is displayed in the drawing.

8.  Click in the drawing to validate the view creation. The unfolded view is displayed with the planar axes and BTLs of 

bends and the stamps representation.
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You will note that the hem is not represented in the drawing. This is due to the fact that non-canonical 
flanges are not represented since they do not generate planar and cylindrical faces only.



Producing Drawings with Generative View Styles 
This task deals with the following topics: 

●     Producing a drawing with the default generative view styles file

●     Producing a drawing with a customized generative view styles file

  
Generative view styles make it possible to customize the appearance of drawings via a set of parameters defined in an XML file, 
DefaultGenerativeStyle.xml. Some generative view style parameters are specifically available to produce customized drawings from parts designed 
in the Generative Sheetmetal Design workbench. It is the administrator's job to provide suitable styles. 

  
For additional information on how to customize parameters, or more generally on generative view styles, see the Generative Drafting User's Guide. 
The Administration Tasks chapter deals with the administration of generative view styles. The Basic Tasks > Generative View Styles chapter explains 
how to use generative view styles. The SheetMetal Parameters task explains how to customize generative view styles for Generative SheetMetal 
Design.

  
Open the SheetMetalDrafting1.CATPart document.
Make sure you have an appropriate Generative Drafting license.

 

Producing a drawing with the default generative view styles file 
1.  Specify your settings before you start: select Tools  -> Options  -> Mechanical Design -> Drafting -> Administration tab, and uncheck 

Prevent generative view style creation.

This activates generative view style functionalities.

2.  Select Start -> Mechanical Design -> Drafting.

The New Drawing Creation dialog box appears. The empty sheet layout is pre-selected.

 

3.  Simply click OK. You switch to the Drafting workbench and an empty drafting sheet is created.

4.  For ease of use, tile the windows horizontally using the Window -> Tile Horizontally menu item.

5.  Select the Unfolded View icon  in the Projections toolbar from the Generative Drafting workbench. The Generative View Style toolbar is 

automatically displayed.

 

6.  Select one of the available styles from the list, DefaultGenerativeStyle in this case.

7.  Return to the 3D document and select a plane surface on the sheet metal part. The sheet metal reference wall plane will be used 

automatically. 
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The reference plane is defined by the first SheetMetal feature inserted in the part body. It can be:
❍     a wall: the reference plane corresponds to the sketch's plane used as the wall's profile;

❍     a rolled wall or a hopper: the reference plane corresponds to the flatten sketch's plane used as a profile;

❍     a recognized feature: the reference plane corresponds to the reference face selected when defining the recognized feature.

A preview of the view is displayed in the drawing.

8.  Click in the drawing to validate the view creation. The unfolded view is created, using the sheet metal-specific styles defined by the chosen 

generative view style. Here, the BTLs (Bend Tangent Lines) and the stamps are projected in the view, as specified in the 

DefaultGenerativeStyle.xml file.

 

You will note that the axis of upward and downward bends are represented in a different color, as well as upward and downward stamps.

Annotations containing the bend's direction, radius and angle value, as well as the standard name of the stamp, if any, can also be displayed 

on the drawing, provided your administrator has activated the corresponding parameters contained in the DefaultGenerativeStyle.xml file.

 

Producing a drawing with a customized generative view styles file
For the purpose of this scenario, save the DefaultGenerativeStyle_customized.xml file and place it in 
install_root/resources/standard/generativeparameters. 
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1.  Select Start -> Mechanical Design -> Drafting to open an empty drafting sheet.

2.  Click OK and tile the windows horizontally using the Window -> Tile Horizontally menu item.

3.  Select the Unfolded View icon  in the Projections toolbar from the Generative Drafting workbench. 

4.  In the Generative View Style toolbar that is automatically displayed select the DefaultGenerativeStyle_customized style.

5.  Return to the 3D document and select the surface on the sheet metal part. 

 

6.  Click in the drawing to validate the view creation. 

The unfolded view is created with annotations specifying the parameters of bends and stamps.

 

You will note that:
❍     the hem is not represented in the drawing. This is due to the fact that non-canonical flanges are not represented since they do not 

generate planar and cylindrical faces only,

❍     annotations are displayed only for surface stamps and not for the user stamp. This is due to the fact that the Standard name field 
available in the Surface stamp dialog box has been populated.



 

Since this field is not available in the User Stamp dialog box, you should use the Formulas dialog box instead:
a.  Select the User Stamp.1 in the specification tree.

b.  Click the Formula icon  in the Knowledge toolbar.
c.  In the Formulas dialog box, select the Standard name parameter.
d.  Enter a value for the Standard name. 

 

e.  Click OK to validate.
f.  Return to the drawing document and update Drawing1.

The User stamp's annotation is displayed.
 

Annotations can be freely positioned on the drawing. You can also modify them if needed. Yet, each time you update the drawing, they 
come back to their original place.

For more information on annotations, refer to Creating a Text With a Leader in the Generative Drafting User's Guide.



SheetMetal Parameters
SheetMetal parameters are located in the SheetMetal -> SheetMetalDesign -> Bend or SheetMetal -> SheetMetalDesign -> 
Stamp node of the generative view style XML file (available via Tools -> Standard -> generativeparameters category -> 
DefaultGenerative Style.xml file).

The parameters specify how bends and stamps should be projected in a Generative Drafting view. They are detailed in the table below.
 

Bend
 Parameter Parameter Name Value Description

Axis>Upward

Visible Yes/No Specifies whether axis of upward bends should be projected.
Color Color Determines the color of the axis of upward bends.

Linetype Integer Determines the linetype used for the axis of upward bends.
Thickness Integer Determines the thickness used for the axis of upward bends.

Axis>Downward

Visible Yes/No Specifies whether the axis of downward bends should be 
projected.

Color Color Determines the color of the axis of downward bends.

Linetype Integer Determines the linetype used for the axis of downward 
bends.

Thickness Integer Determines the thickness used for the axis of downward 
bends.

Axis>Annotations>Angle

Visible Yes/No Specifies whether the angle annotation of the bend axis 
should be projected.

Prefix String Specifies the prefix used for the angle annotation of the bend 
axis. Angle is used as default value.

Type Internal/External Specifies whether the annotation of the internal or external 
angle should be projected.

Axis>Annotations>Radius
Visible Yes/No Specifies whether the radius annotation of the bend axis 

should be projected.

Prefix String Specifies the prefix used for the radius annotation of the 
bend axis. Radius is used as default value.

Axis>Annotations>UpDownStatus
Visible Yes/No Specifies whether the annotation specifying the direction of 

the bend should be projected.
UpString String Specifies the upward direction for the axis annotation.

DownString String Specifies the downward direction for the axis annotation.

BTLs

Visible Yes/No Specifies whether BTLs (Bend Tangent Lines) should be 
projected. 

Color Color Determines the color of BTLs.
Linetype Integer Determines the linetype used for BTLs.
Thickness Integer Determines the thickness used for BTLs.

Stamp
 

Parameter Parameter Name Value Description

AppropriateLines>Upward

Visible Yes/No Specifies whether upward stamps should be projected.

Color Color Determines the color of upward stamps.

Linetype Integer Determines the linetype used for upward stamps.

Thickness Integer Determines the thickness used for upward stamps.

AppropriateLines>Downward

Visible Yes/No Specifies whether downward stamps should be 
projected.

Color Color Determines the color of downward stamps.

Linetype Integer Determines the linetype used for downward stamps.

Thickness Integer Determines the thickness used for downward stamps.

Annotations>StandardName

Visible Yes/No Specifies whether the annotation specifying the 
standard name for stamps should be projected.

Prefix String
Specifies the prefix used for the annotation specifying 
the standard name for stamps. Standard name is used 
as default value.



Designing in Context
This section explains and illustrates how to create and use various kinds of features.
The table below lists the information you will find.

Design in context: from a CATProduct document, create a new CATPart document, and create a complete 
SheetMetal Part.
Modify the design: modify another part from another document and update the SheetMetal Part.



Designing in Context

This task explains how to create a Sheet Metal part in an Assembly context.

For the Sheet Metal Design workbench, open the Scenario2.CATProduct document.
For the Generative Sheetmetal Design workbench, open the NEWScenario2.CATProduct document.

  
This scenario, which is valid for both the Sheet Metal Design workbench and the Generative Sheet Metal Design 
workbench, is illustrated using screen captures from the Sheet Metal Design workbench. Results will slightly differ 
in the Generative Sheetmetal Design workbench, for which Automatic bends are not available. 

  

You are in Assembly Design workbench.

The document contains two parts.

1.  Right-click Product1 in the 

specification tree and select 

Components -> New Part...

Provided the Manual Input 
option is checked in Tools -> 
Options -> Infrastructure -
> Product Structure, 
Product Structure tab, the 
Part Number dialog box is 
displayed:
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2.  Enter Part3 in the New part 

Number field and click OK.

A New Part dialog box proposes 

two locations to define the origin 

point.

For more information, refer to 

Inserting a New Part, in the 

Product Structure User's Guide.

 

3.  Click No to locate the part origin according to the Product1 origin point.

Make sure you are in Design Mode:

●     Select Product1

●     Choose Edit -> Representations ->Design Mode

4.  Expand the tree and activate the Part3 Part body by double-clicking. 



5.  Switch to the Sheet Metal Design workbench or to the Generative Sheetmetal Design workbench.

6.  Select the Sheet Metal parameters icon  to create the Sheet Metal characteristics for the part: 

●     1mm for the Thickness

●     3mm for the Bend radius

●     Linear for the Bend extremities

and click OK.

7.  Choose the Tools -> Options -> Infrastructure -> Part Infrastructure, General tab and check the 

Keep link with selected object option, then click OK.

8.  Click the Sketcher icon  and select the zx plane.

9.  Select the Profile icon .

 
10.  Sketch the profile and set the constraints as shown below:

 

●     5mm between the Sheet Metal 
vertical walls and each pad

●     0mm between the Sheet Metal 
horizontal walls and each pad top

●     0mm between the last point of the 
Sheet Metal sketch and the right 
pad side.

11.  Click the Exit icon  to return to the 3D world.

12.  Select the Extrusion icon .



13.  Select the Sheet Metal profile.

The Extrusion Definition dialog 

box appears.

14.  Enter 70mm for Length1 then 

click OK.

The Material Side should be set to the 
outside.

15.  Perform this step only if you are using the Sheet Metal Design workbench: select the Automatic Bends 

icon .

The bends are created.

The new features are shown 
in the specification tree: 

●     Extrusion.1 with five 
walls

●     Automatic Bends.1 with 
four bends (for the Sheet 
Metal Design workbench 
only).

The Sheet Metal part looks like this:

 



Modifying the Design

In this task, you are going to modify the height and the sketch of Pad.1.

For the Sheet Metal Design workbench, the Scenario2.CATProduct document is open from the previous 
task. If not, open the Scenario2_2.CATProduct document from the samples directory.

For the Generative Sheetmetal Design workbench, open the NEWScenario2.CATProduct document.
  

This scenario, which is valid for both the Sheet Metal Design workbench and the Generative Sheet Metal 
Design workbench, is illustrated using screen captures from the Sheet Metal Design workbench. Results 
will slightly differ in the Generative Sheetmetal Design workbench, for which Automatic bends are not 
available. 

   

1.  Double-click Part1\PartBody\Pad.1 in the 

specification tree.

The dialog box is displayed. 

2.  Enter 40mm for the Length and click OK.

The pad is updated.

3.  Double-click Part3 and Update the Sheet Metal part using the Update   icon.

4.  Double-click Part1\Pad.1\Sketch.1.
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5.  Modify the sketch:

6.  Click the Exit icon  to return to the 3D world.

The constraints are respected. 

After the Part3 update, the document looks like this:

 



Managing PowerCopies

 
Create PowerCopies: Select the Insert ->Knowledge Templates -> PowerCopy Creation command, 
select the elements making up the PowerCopy from the specification tree, define a name for the 
PowerCopy and its reference elements then choose an icon for identifying it.

 
Instantiate PowerCopies: Select the Insert -> Instantiate From Document command, select the 
document or catalog containing the  powercopy, complete the Inputs within the dialog box selecting 
adequate elements in the geometric area.

 
Save PowerCopies into a Catalog: Select the PowerCopy from the specification tree, select the Insert -> 
Knowledge Templates -> PowerCopy Save In Catalog... command, enter the catalog name and click 
Open.

 



Creating PowerCopy Features
This task shows how to use create PowerCopy elements, to be reused later.
A PowerCopy is a set of features (geometric elements, formulas, constraints and so forth) that are grouped in order 
to be used in a different context, and presenting the ability to be re-specified according to the context when pasted.
This PowerCopy captures the design intent and know-how of the designer thus enabling greater reusability and 
efficiency.

Open the PowerCopyStart.CATPart document.

1.  Select the Insert ->Advanced Replication Tools -> PowerCopy Creation menu item.

The PowerCopy Definition dialog box is displayed. 

2.  Select, from the specification tree, the elements to be included in the PowerCopy. 

The 
PowerCopy 
Definition 
dialog box is 
automatically 
filled with 
information 
about the 
selected 
elements. 

3.  Define the PowerCopy as you wish to create it:

The Definition tab lets you assign a name to the PowerCopy and presents its components in the 3D 
viewer.
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The Inputs tab lets 
you rename the 
reference elements 
making up the 
PowerCopy.

You can do that for clarification purposes as to their roles,  by selecting the elements in the viewer and entering a 

new name in the Name field.

In this example, we renamed all three elements and in brackets you still can read the elements' default name based 

on their type.

The Parameters tab 
lets you define which of 
the parameter values 
used in the PowerCopy 
you will be able to 
modify at instantiation 
time.

Simply check the Published button.

Use the Name field to give a more explicit name to the element.

The 
Documents 
tab shows 
the complete 
path and role 
of Design 
tables that 
are 
referenced 
by an 
element 
included in 
the Power 
Copy.



The Icon tab lets you 
modify the icon 
identifying the 
PowerCopy in the 
specifications tree. 

A subset of icons is available from the Icon choice button.
If you click ... the Icon Browser opens, giving you access to all the graphic icons installed with the CATIA software.

Use the Grab screen 
button to  capture an 
image of the 
PowerCopy to be 
stored with its 
definition in the catalog 
(see Saving PowerCopy 
Features).

Use the Remove preview button to delete the image captured with the Grab screen button.

4.  Click OK to create the PowerCopy.

The PowerCopy is displayed close to the top of the specification tree.
●     Double-click the PowerCopy in the specification tree to display the PowerCopy Definition dialog box and edit 

its contents.

●     A formula is automatically included in a Power Copy definition when all its parameters are included.
Otherwise, i.e. if at least one parameter is not selected as part of the Power Copy, you have to manually select 
the formula to make it part of the definition. If you do so, all the formula's parameters that have not been 
explicitly selected, are considered as inputs of the Power Copy.

●     Once your PowerCopy is created, do not delete the referenced elements used to make up the PowerCopy.

 



Instantiating PowerCopy Features

This task shows how to instantiate PowerCopies once they have been created as described in Creating PowerCopy Features.
There are three ways to do this: 

1.  using the contextual menu
2.  using the Insert -> Instantiate From Document menu item
3.  using a catalog

The PowerCopyStart.CATPart document is still open from the previous task, otherwise, 0pen the 
PowerCopyStartResults1.CATPart document.

Using the Contextual Menu Item: 

1.  Select the PowerCopy feature from the specification tree.

2.  Right-click to display the contextual menu, and choose the PowerCopy.1 object -> instantiate menu item. 

The Insert Object dialog box is displayed. 

3.  Complete the Inputs within the dialog box by selecting 

the adequate element in the geometric area.

You need to click the arrow to invert the First Edge 
orientation.
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Check the Repeat option to be able to repeat the instantiation.
In this case, once you have clicked OK in  the Insert Object dialog box, the latter remains open, the PowerCopy's Inputs are 
listed and ready to be replaced by new inputs, as described above.
Modified parameters using Parameters button are retained as well for the next instantiation.
To exit the command, you then need to uncheck the Repeat button or click Cancel.

5.  You can also click on the Parameters button to display 

the Parameters dialog box and modify values, if 

needed.

6.  Use the Create formulas button to automatically create 

a formula on every parameters with the same name 

provided there are any.

7.  Click OK in the Parameters dialog box.

 

The Documents button lets you access the list of documents (such as design tables) pointed by one of the elements making 
up the Power copy. 
If there are documents, the Documents dialog box opens and you can click the Replace button to display the File Selection 
dialog box and navigate to a new design table to replace the initial one.
When no document is referenced, the Documents button is grayed within the Insert Object dialog box.

8.  Click OK to create the PowerCopy instance.

The PowerCopy is instantiated in context, meaning 
its limits are automatically re-defined taking into 
account the elements on which it is instantiated.

Using the Insert Menu: 

1.  Select the Insert -> Instantiate From Document menu item.

The Select PowerCopy dialog box is displayed allowing you to navigate to the document or catalog where the  power 

copy is stored.



 

2.  Select the document containing the Powercopy.

The Insert Object dialog box is displayed.

Use the Reference list to choose the correct PowerCopy when several have been defined in the document.

3.  Continue the instantiation as described in Using the Contextual Menu item, step 3.

Using the catalog: 

You need to have a catalog available, created either:
●     using the Catalog capability, see the Infrastructure User's Guide.

●     using the Insert -> Advanced Replication Tools -> PowerCopy Save In Catalog... menu item.

1.  Click the  icon.

If accessing a catalog for the first time, you need to navigate to the catalog location. This location is stored in the 

settings for faster access later on.

2.  Select the catalog containing the PowerCopy you wish to instantiate.



3.  Select the PowerCopy to be instantiated, then you can:

●     drag and drop it onto the reference element

●     double-click the PowerCopy 

●     or right-click on the PowerCopy in the dialog box and use the Instantiate contextual menu.

From then on, you instantiate the PowerCopy as described Using the Contextual Menu item, step 3.

●     You can only instantiate a PowerCopy if the PowerCopy itself and the features making it up have been created in the 
current view mode: i.e. you will be able to instantiate a PowerCopy created in 3D mode, only on a feature in 3D mode, 
not on an unfolded feature.

●     The  icon is always grayed when instantiating Power Copies. It is available with User Features and allows you to 
create and modify URLs.

 



Saving PowerCopy Features

This task shows how to use store Power Copy elements into a catalog, for later use as described in 
Instantiating PowerCopy Features.

Open the PowerCopyStartResults1.CATPart document.

1.  Select the PowerCopy from the specification tree for example.

2.  Choose the 

Insert -> 

Advanced 

Replication 

Tools -> 

(PowerCopy) 

Save In 

Catalog... menu 

item.

The Catalog 

Save dialog box 

is displayed: 

●     When creating a 
catalog for the first 
time, click the ... 
button to display the 
Open dialog box, and 
navigate to the 
location where you 
wish to create a 
catalog.
Then simply key in 
the catalog name and 
click Open.
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●     If you wish to add a PowerCopy to an existing catalog, simply activate the Update an existing 
catalog option in the Catalog Save dialog box

By default, the Catalog Save dialog box recalls the catalog accessed last.

3.  Click OK.

The PowerCopy has been stored in the catalog.

 



Browsing the Sheet Metal Catalog

This task explains how to browse the SheetMetal catalog. The catalog lets you store the available profiles, 
therefore providing a method to position the profile in the part. 

In the Generative Sheetmetal Design workbench, this command is available for the following 
functionalities:

●     cutout

●     bead

●     surface stamp

●     flanged cutout

●     curve stamp

●     louver

●     user stamp

●     corner relief. 

Let's take an example with the Corner Relief functionality.
For more information on catalogs, refer to the Component Catalog Editor User's Guide.

For the Sheet Metal Design workbench, open the CornerRelief03.CATPart document from the samples 
directory.

For the Generative Sheetmetal Design workbench, open the NEWCornerRelief03.CATPart document from 
the samples directory.

 

1.  Once in the Corner Relief Definition dialog box, click the Catalog icon . The Catalog Browser 

opens, and lets you choose from a number of sketches.

file:///E|/www/lgkr16/Doc/online/cfysm_C2/samples/SheetMetal/CornerRelief03.CATPart
file:///E|/www/lgkr16/Doc/online/cfysm_C2/samples/SheetMetal/NEWCornerRelief03.CATPart


2.  Select a sketch and click OK in the Catalog Browser.

You return to the Corner Relief Definition dialog box, that has been updated with the Sketcher 

icon.

3.  Click the sketcher icon, and move the sketch to position it properly in relation to the part. 



4.  Click OK, and check the part in a folded view.ert



Looking For Sheet Metal Features

This task shows how to use the Search capabilities on Sheet Metal Features, in order to detect any 
specific kind of feature.

If you use SheetMetal Design, open the PowerCopyStart.CATPart document.

If you use Generative Sheetmetal Design, open the NEWFoldUnfoldBends.CATPart document.

Note that the samples provided are different for each workbench and that results will vary depending on 
which sample and workbench you are using. Also note that this task is illustrated using the Generative 
Sheetmetal Design sample and workbench. The user interface or results will slightly differ in the Sheet 
Metal Design workbench.

1.  Select the Edit ->  Search menu item.

The Search dialog box is displayed. 

2.  From the Workbench > Type list, choose Generative Sheetmetal Design.

You can then display the list of Sheet Metal features from the Type list: 
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3.  Select the type of feature you wish to find within the open .CATPart document, and click the 

Search icon.

The list of all elements of the selected type is displayed in the Objects found field:



You can select an element from the list, it will be highlighted in the geometry area.

To find out more on the search capabilities, refer to Selecting Using the Search... Command (General 
Mode) and Selecting Using the Search... Command (Favorites and Advanced Modes) from the 
Infrastructure User's Guide.



Saving As DXF  

 
This task shows how save the generated geometry as a DXF document.

To perform this scenario, you can open any sheet metal sample provided in this user's guide.

 1.  Click the Save As DXF icon .

The Select a DXF file dialog box is displayed allowing you to navigate to the correct location. 

2.  Indicate the correct path and file name (we saved it as PartSavedAsDXF.dxf).

3.  If needed, modify the Tolerance with the up and down arrows.

The Tolerance is used to compute circles and lines. The thinner the Tolerance is, the better circles and lines are 
represented in the drawing.



 

DXF file saved with a 0,001mm tolerance DXF file saved with a 10mm tolerance
 

2.  Click Save.

The geometry has been saved, and can be imported as a DXF file in any system supporting this type.

 

4.  Close the CATPart Document.

5.  Click File -> Open.

6.  From the File Selection dialog box, choose the .dxf file type, then select the saved part 

(PartSavedAsDXF.dxf).



 

7.  Click Open.

The unfolded view of the part is opened within the Drafting workbench, because the .dxf type is recognized as being 
a drafting type of document.



Note that the axes of  bends and planar hems, tear drops, or flanges are automatically displayed on the drawing.

 
Refer also to DXF/DWG Settings from the Infrastructure User's Guide.

 



Workbench Description
The Generative Sheetmetal Design application window looks like this. Click the hotspots to display the related 
documentation. 

 

Menu Bar
Walls Toolbar

Rolled Walls Toolbar
Bending Toolbar
Views Toolbar

Cutting/Stamping Toolbar
Transformations Toolbar

Manufacturing preparation Toolbar
Constraints Toolbar

Reference Elements Toolbar

Annotations Toolbar
Specification Tree



Menu Bar

The various menus and menu commands that are specific to Sheet Metal Design are described below.

 

Start File Edit View Insert Tools Windows Help

Tasks corresponding to general menu commands are described in the Infrastructure User's Guide. Refer to the Menu Bar section. 

Insert 
For... See...
Annotations Refer to Creating Annotations in the 3D Functional Tolerancing & 

Annotation User's Guide.

Sketcher Refer to Sketching in the Sketcher User's Guide.

Constraints Setting Constraints in the Part Design User's Guide

Axis System... Refer to Axis System in the Part Design User's Guide.

Sheet Metal Parameters... Managing the Default Parameters

Recognize... Recognizing Stamping Features

Views Insert -> Views

Walls Insert -> Walls

Rolled Walls Insert -> Rolled Walls

Bending Insert -> Bending

Cutting Insert -> Cutting

Stamping Insert -> Stamping

Transformations Insert -> Transformations

Manufacturing preparation Insert -> Manufaturing preparation

Knowledge Templates Insert -> Knowledge Templates

Instantiate From Document... Instantiating PowerCopy Features

Instantiate From Selection... Refer to Instantiating a Power Copy from a selection in the Product 
Knowledge Template User's Guide.

Insert -> Views
For... See... 
Unfold... Folded/Unfolded View Access

Multi Viewer... Concurrent Access

Views Management... Deactivating Views

Insert -> Walls

file:///E|/www/lgkr16/Doc/online/basug_C2/basugwd0100.htm
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For... See... 
Wall... Creating Walls from a Sketch

Wall on Edge... Creating Walls From An Edge

Extrusion... Extruding

Swept Walls Insert -> Swept Walls

Insert -> Swept Walls
Flange... Creating a Flange

Hem... Creating a Hem

Tear Drop... Creating a Tear Drop

User Flange... Creating a User Flange

Insert -> Rolled Walls
 For... See...

Hopper... Creating a Hopper

Rolled Wall... Creating Rolled Walls

Insert -> Bending
 For... See...

Bend... Manually Creating Bends on Walls

Conical Bend... Creating Conical Bends

Bend From Flat... Creating Bends From a Line

Unfolding... Creating Local Fold and Unfold of Bends

Folding... Creating Local Fold and Unfold of Bends

Shape Mapping... Mapping Elements

Insert -> Cutting
 For... See...

Cutout... Creating a Cutout

Hole... Creating a Circular Cutout

Hole... Creating a Hole

Corner Relief... Creating a Local Corner Relief

Corner... Creating Corners

Chamfer... Creating Chamfers

Insert -> Stampings
For... See... 

Surface Stamp... Creating a Surface Stamp

Bead... Creating a Bead

Curve Stamp... Creating a Curve Stamp

Flanged Cut Out... Creating a Flanged Cutout

Louver... Creating a Louver

Bridge... Creating a Bridge

Flanged Hole... Creating a Flanged Hole
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Circular Stamp... Creating a Circular Stamp

Stiffening Rib... Creating a Stiffening Rib

Dowel... Creating a Dowel

User Stamp... Creating User-defined Stamping Features

Insert -> Transformations
For... See... 
Mirror... Mirroring

Rectangular Pattern... Creating Rectangular Patterns

Circular Pattern... Creating Circular Patterns

User-Defined Pattern... Creating User-Defined Patterns

Insert -> Manufacturing preparation
For... See... 
Check Overlapping... Checking Overlapping

Save as DXF... Saving As DXF

Insert -> Knowledge Templates
For... See... 
PowerCopy... Create PowerCopies

User Feature... Refer to Managing User Features (UDFs) in the Product Knowledge 
Template User's Guide.

Document Template... Refer to Managing Part and Assembly Templates in the Product 
Knowledge Template User's Guide.

Save in Catalog... Saving PowerCopies



Walls Toolbar

  

See Managing the Default Parameters

See Recognizing Walls From an Existing Part  

See Creating Walls from a Sketch

See Creating Walls From An Edge

See Extruding  

   

See Create a flange

See Create a hem

See Create a tear drop

See Create a swept flange



Rolled Walls Toolbar

  

See Creating Hoppers

See Creating Rolled Walls



Bending Toolbar

  

See Creating Bends from Walls

See Creating Conical Bends

   

See Creating Bends from a Line

   

See Local fold and unfold of bends

See Local fold and unfold of bends

  

See Mapping Elements



Views Toolbar

  

See Folded/Unfolded View Access

See Multi Viewer

  

See Deactivating Views



Cutting/Stamping Toolbar

  

See Creating a Cutout  

See Creating a Hole

See Creating a Circular Cutout

See Creating a Local Corner Relief  

See Creating Corners  

See Creating Chamfers  

See Create a surface stamp

See Create a bead

See Create a curve stamp

See Create a flanged cutout

See Create a louver

See Create a bridge

See Create a flanged hole

See Create a circular stamp

See Create a stiffening rib

See Create a dowel

See Creating User-Defined Stamping Features
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Transformations Toolbar

  

See Mirroring  

   

See Create rectangular patterns

See Create circular patterns

See Create user-defined patterns



Manufacturing preparation Toolbar

  

See Checking Overlapping

 See Saving As DXF 



Constraints Toolbar

  

See Setting Constraints from the Part Design User's Guide
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Reference Elements Toolbar

   

See Creating Points

See Creating Lines

See Creating Planes

 



Annotations Toolbar

  

Text with leader See Creating Texts from the 3D Functional Tolerancing & Annotation User's Guide.

Flag note with leader See Creating Flag Notes from the 3D Functional Tolerancing & Annotation User's Guide.



Specification Tree
Within the Generative Sheet Metal Design workbench, you can generate a number of features that are identified 
in the specification tree by the following icons.

Further information on general symbols in the specification tree are available in Symbols Used in the 
Specification Tree.

 

Sheet Metal Parameters  Bridge

Recognize Flanged Cutout

Wall Stiffening Rib

Wall On Edge Curve Stamp

Extrusion User-defined Stamp

Rolled Wall Louver

Cylindrical Bend Dowel

Conical Bend Rectangular Pattern

Flat Bend Circular Pattern

Unfolding User-Defined Pattern

Folding Corner Relief

Flange Corner

Hem Chamfer

Tear Drop Mirror

User Flange Mapping

Hopper Point

Cut Out  Line

Hole  Plane

Threaded Hole    
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Hole Circular Cutout    

Flanged Hole    

Bead    

Circular Stamp    

Surface Stamp    



Customizing
This section describes how to customize standards files and settings specific to the Generative Sheetmetal 
Design workbench. 

Generative Sheetmetal Design 



Generative Sheetmetal Design 
 

 
This page deals with the following category of options in the Aerospace Sheet Metal Design tab: 
Standard Profiles Catalog File.

Standard Profiles Catalog File

Enter the default path in this field. You may click the Browse icon .

  By default, this field is empty.

If no catalog path has been defined prior to entering the Catalog Browser command, the default catalog is 

selected and its path is automatically added to the Standard Profiles Catalog File field.



Glossary 

       

B

bend A feature joining two walls

bend extremity Axial relimitation for a straight bend

C

corner relief A feature created at the intersection of several bends or of a bend and a wall allowing to 
remove matter so that the part can fold/unfold without overlapping.

cutout A feature corresponding to an opening through a feature.
The shape of the opening corresponds to the extrusion of a profile.

E

extrusion A feature created by extruding a profile and adding thickness

F

flange A feature created by sweeping a profile along a spine.
The different flanges or swept walls available are: simple and swept flange, hem and tear 
drop.

P

pattern A set of similar features repeated in the same feature or part

profile An open or closed profile including arcs and lines created by the Profile command in the 
Sketcher workbench

R



reference wall The first created wall; when unfolding the part, it is the fixed wall.

S

stamping A feature created by embossing sheet metal.
The different stampings available are:
point/circular, extruded/flanged hole, flanged cutout, curve, surface, bridge, louver and 
stiffening rib.

W

wall A feature created by adding thickness to a profile

 



Index 

                    

A
activating views  
analyzing 

parts  
Assembly Design workbench 

interoperability  
Automatic Bends 

command  

B
bead  
Bend 

command   
bend allowance 

defining  

bend extremities  

defining  
Bend From Flat 

command  
bend radius 

defining   
bends 

creating     

bridge  
browsing 

Sheet Metal catalog  

C



canonic hoppers, creating  

catalog  

CATSHM_CircPattern  

CATSHM_RecPattern  

CATSHM_UserPattern  

CATSmBeadPunch  

CATSmBridgePunch  

CATSmChamfer  

CATSmCorner  

CATSmCornerRelief  

CATSmCurvePunch  

CATSmCutHole  

CATSmCutOut  

CATSmExtendedExtrudedHolePunch  

CATSmExtrudedHolePunch  

CATSmFlange  

CATSmLouverPunch  

CATSmPointPunch  

CATSmStamp  

CATSmStiffeningRibPunch  

CATSmSurfacePunch  

CATSmUserPunch  
chamfer 

command  
chamfers 

creating  
Check Overlapping 

command  
checking 

overlapping  
Circular Pattern 

command  

circular stamp  



clearance  
command 

Automatic Bends  

Bead  

Bend   

Bend From Flat  

Bridge  

chamfer  

Check Overlapping  

Circular Cutout  

Circular Pattern  

Circular Stamp  

Conical Bend  

corner  

Corner relief  

Curve Stamp  

Cutout   

Dowel  

Extrusion    

Flange  

Flanged Cutout  

Flanged Hole  

Fold/Unfold Curves  

Half Pierce Stamp  

Hem  

Hole  

Hopper  

Line  

Louver  

Multi Viewer  

Plane  

Point  



PowerCopy Creation  

PowerCopy Instantiation  

PowerCopy Save In Catalog  

Recognize   

Rectangular Pattern  

Save As DXF  

Sheet Metal Parameters    

Stiffening Rib  

Surface Stamp  

Tear Drop  

Unfold  

Unfolded View   

User Flange  

User Pattern  

User Stamping   

Views  

Wall   

Wall on Edge  
Commands 

Search  
Conical Bend 

command  

conical bends  
corner 

command  
corners 

creating  

create  

bead  

bridges  

circular cutout  

circular stamp  

Corner relief  



curve stamp  

extruded hole  

flange  

flanged cutout  

half pierce stamp  

hem  

Hole  

stiffness rib  

surface stamp  

tear drop  

user flange  

creating  

bends     

canonic hoppers  

chamfers  

circles  

conical bends  

corners  

curves  

cutouts  

extrudes  

hoppers  

line  

lines  

louvers  

patterns    

plane  

planes  

points  

Power Copy  

stamps   

surfacic hoppers  



swept walls  

user-defined stamps  

walls      

creating point  
crown 

defining  

Curve Stamp  
curves 

creating  
customizing 

Generative Sheetmetal Design settings  
Cutout 

command   

cutout  
cutouts 

creating  

cutting faces  

D
deactivating views  
defining 

bend allowance  

bend extremities  

bend radius   

crown  

thickness   

die stamps  

Dowel  

drawing  
drawings 

producing  

producing with generative view styles  



DXF format  

E
editing 

user-defined stamps  
elements 

Generative Sheet Metal Design  

extruded hole  

create  
extrudes 

creating  
Extrusion 

command    

F
Flange  

Flanged Cutout  
Flanged Hole 

command  

flat bends  
Fold/Unfold Curves 

command  

Folding  

folding   

G
Generative Drafting 

workbench   
Generative Sheet Metal Design 

elements  



Generative Sheetmetal Design settings  
generative view styles 

producing drawings with  

SheetMetal parameters  

H
Half Pierce Stamp  
half pierce stamp 

create  

Hem  
Hopper 

command  

hoppers, creating  

I
instantiating 

Power Copy  
interoperability 

Assembly Design workbench  

Knowledge Expert  

Part Design workbench   

Weld Design workbench  

Wireframe  

K
Knowledge Expert 

interoperability  



L
line  

bisecting  

normal to surface  

point-direction  

point-point  

tangent to curve  

up to a curve  

up to a point  

up to a surface  

local fold of bends  

local unfold of bends  
Louver 

command  
louvers 

creating  

M
managing 

Power Copy  

Sheet Metal parameters  

manual bends  

material side     
Multi Viewer 

command  

multi-viewing  

O
object browser 

CATSHM_CircPattern  



CATSHM_RecPattern  

CATSHM_UserPattern  

CATSmBeadPunch  

CATSmBridgePunch  

CATSmChamfer  

CATSmCorner  

CATSmCornerRelief  

CATSmCurvePunch  

CATSmCutHole  

CATSmCutOut  

CATSmExtendedExtrudedHolePunch  

CATSmExtrudedHolePunch  

CATSmFlange  

CATSmLouverPunch  

CATSmPointPunch  

CATSmStamp  

CATSmStiffeningRibPunch  

CATSmSurfacePunch  

CATSmUserPunch  

open faces  
overlapping 

checking  

P
parameters  
Part Design workbench 

interoperability   
parts 

analyzing  

patterns  

creating    



user-defined  
plane 

angle-normal to plane  

equation  

from equation  

mean through points  

normal to curve  

offset from plane  

parallel through point  

tangent to surface  

through planar curve  

through point and line  

through three points  

through two lines  
point 

creating  
Power Copy 

creating  

instantiating  

managing  

saving  
PowerCopy Creation 

command  
PowerCopy Instantiation 

command  
PowerCopy Save In Catalog 

command  

punch   

R
Recognize 

command   



recognizing stamps  

recognizing walls  
Rectangular Pattern 

command  

reference wall      

relief  
rolled walls 

walls  

S
Save As DXF 

command  
saving 

Power Copy  

saving data  
Search 

Commands  
searching 

sheet metal features  
settings 

Generative Sheetmetal Design  

Sheet Metal catalog  
Sheet Metal Design 

workbench  
sheet metal features 

searching  
Sheet Metal Parameters 

command    
Sheet Metal parameters 

managing  
stamps 

creating   

user-defined   

stamps, recognizing  



Standard Profiles Catalog File (settings)  

stiffness rib  

Surface Stamp  
surface stamp 

create  

surfacic hoppers, creating  
swept walls 

creating  

T
tangent walls  

Tear Drop  
thickness 

defining   

U
Unfolded View 

command   

unfolded view    

Unfolding  

unfolding   

User Flange  
User Pattern 

command  
User Stamping 

command   
user-defined 

patterns  

stamps   
user-defined stamps 

creating  



editing  

V
views 

activating  

deactivating  

W
Wall 

command   

wall clearance  
Wall on Edge 

command  

wall on edge  
walls 

creating      

rolled walls  

walls by extrusion  

walls from sketch  

walls on edge  

walls, recognizing  
Weld Design workbench 

interoperability  
Wireframe 

interoperability  
workbench 

Generative Drafting   

Sheet Metal Design  
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